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Chapter 1: Getting Started

Introduction to HP Application Portfolio Management
HP Application Portfolio Management (HP APM) enables your organization to assess and prioritize its
current application portfolio and determine which applications need to bemodernized. Organizations
use HP APM as the first step towards application transformation as they:

l Document the size of their application portfolio and the applications that support their business
processes.

l Compare and analyze application information such as health, effectiveness, ownership, cost of
ownership, business value, and risk.

l Identify improvement opportunities andmodernize their application portfolio by making strategic
decisions about the future of each application in the portfolio, including whether the applications
should be kept, changed, or retired.

HP APM is amodule of Project and Portfolio Management Center (PPM Center). It adds functionality
to the standard PPM Center interface.

This guide is intended for HP APM analysts. It describes the tasks typically performed by analysts and
provides instructions for performing the tasks—or it refers the reader to the documents that provide the
necessary information.

Note: This guide describes the default interface for HP APM. Customizations made by the HP
APM administrator to meet your organization's business needs and requirements are not
documented in this guide.

HP APM Roles
The primary HP APM roles—user, analyst, and administrator—are described in this section.

Note: Besides being one of the HP APM roles, the term "user" is also used generically in this book
to refer to HP APM users of any role.

l User. Themost basic user of HP APM. Users perform tasks such as creating application entities,
managing the applications they own, and responding to surveys and supplying information for
applications when requested to do so by the analyst and other users (as a proxy). Authorized users
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can view and edit some or all of the financial summary for an application entity or transformation
proposal. For more information about the HP APM user role, see theHP Application Portfolio
Management User's Guide.

l Analyst. Themost active user of HP APM. The analyst performs many tasks, including collecting
and analyzing data about the organization and its application portfolio. For more information about
the role of the analyst, see "The Role of the Analyst" below.

l Administrator. Themost advanced user of HP APM. The administrator has all the abilities of an
analyst and user but is typically involved with supporting the analyst in achieving the analyst's
goals. The administrator installs, sets up, andmaintains HP APM, defines users, customizes fields
and validations for entities, and can create customized entities, data sources, portlet definitions,
workflows, validations, report types, and security groups. For more information about the HP APM
administrator, see theHP Application Portfolio Management Administrator's Guide.

The Role of the Analyst
As an analyst, your goal is to collect and consolidate data about applications used by your organization
and to turn it into information consumable by you and other users. You can conduct surveys, create
entities, import and export entity data using the PPMDataMigrator for Microsoft Excel (DataMigrator),
create portlet definitions, and analyze applications using application sets, portlets, reports, graphing,
and entity groupings. You can also typically perform all the duties of a user.

You can view and edit all sections of entities that you create and entities for which you are the owner.
You can also view information in the header, Business Environment, Technical Environment, and
Usage & Scale sections of application entities. If you are assigned additional roles or permissions
within HP APM, you are able to perform additional tasks.

If you are designated as a contact for an HP APM entity, you are able to perform additional tasks such
as viewing or editing data in sections of an entity that are not typically available to an HP APM analyst.
Contact roles—such as business owner, technical owner, ITO contact, and SME (subject matter
expert)—are assigned in the Contacts section of an application entity. Other contact roles are assigned
in the Summary or details sections of many of the entities. The respondent role is assigned when a user
is requested to provide additional information for an entity.

Note: Youmight already be able to view or edit data in an entity if, for example, you created the
entity.

For information about the contact roles that can be assigned in an application entity and descriptions
of the additional functions they provide, see "Contacts" on page 105. For descriptions of other roles that
can be assigned to an analyst in an entity, see "Entities" on page 101 and theHP Application Portfolio
Management Administrator's Guide. If you are an application owner or a survey respondent, see theHP
Application Portfolio Management User's Guide for information about responding to surveys and
requests for additional information.
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Guidelines for Building Your Application Portfolio
Your application portfolio consists of applications and their relationships to the business objectives and
processes used by your organization.

Follow these guidelines to build an application portfolio:

1. Learn about the relationships in—and collect basic information about—your organization and its
business objectives and processes. This information assists you with understanding and
determining the necessity and value of the applications in your application portfolio.

2. Ask the HP APM administrator to create the users who are to serve as points of reference for the
entities that you create. These users could be business owners, technical owners, IT contacts,
budget or benefits managers, subject matter experts, reviewers, respondents, resources, and
sponsors of an entity.

3. Start building the application portfolio inventory, including related entities such as the location and
process entities.

4. If organization units and business objectives have not been provided for you, create them as
necessary. You create business objectives and organization units in PPM Center.

Note: Before you can create andmanage organization units and business objectives, the HP
APM administrator must create a security group that allows you to do this and assign it to
you. For more information, see the HP APM for PPM Release Notes. For instructions for
creating andmanaging business objectives, see the HP ProgramManagement User’s Guide .
For instructions for creating andmanaging organization units, see theHP Resource
Management User’s Guide .

5. Create workstreams tomonitor the progress of your analysis.

6. Collect information about your applications, and then create application entities and add them to
your application portfolio inventory.

Note: You can create entities one at a time or you can import multiple entities at one time into
HP APM from aMicrosoft Excel spreadsheet using the PPMDataMigrator for Microsoft
Excel. For instructions, see "Using the PPMDataMigrator for Microsoft Excel" on page 20.

Information that you collect about applications includes system information, names used,
versions, and contact information. It should also includes details about the business and technical
environments, budget and resources, service and support, usage and scale, and relationships with
processes, organizations, and other applications.
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To fill gaps in your knowledge about an application, you can use the "NeedMore Info" workflow
step to invite another user to access an application entity and update the information about it.

7. Determine the type of data you want to analyze (business-related, technical, or general) and send
out surveys to application owners and users to have them rate the applications.

8. Create application sets and use shared or configurable portlets to represent the data in a
meaningful manner.

9. Use dynamic graphing to graphically view application sets, applications, and process
relationships and to develop application sets for analysis.

10. Generate reports to analyze the completeness of data and, when you are satisfied with the amount
of data you have collected, start your analysis. Use portlets to analyze themost important
qualities about each application or application set and share this data with other users.

11. Create an improvement transformation proposal based on your findings.

HP APM Features and Components
The standard user interface for HP APM is a collection of specializedWeb pages in PPM Center that
offer you a customized view into HP APM. You use theseWeb pages to perform the tasks that you are
responsible for as an analyst.

Note: If you have a pop-up blocker or download blocker active on yourWeb browser, youmight
have difficulties using theWeb pages.

HP APM features available for analysts include the following:

l HP APM-specific entities. See "Managing HP APM Entities" on page 15 and "Entities" on
page 101.

l HP APM reports. See "Reports" on page 76 and "Reports" on page 187.

l The PPMDataMigrator for Microsoft Excel (for importing, exporting, and updating entity data and
for exporting and updating validation values in HP APM). See "Using the PPMDataMigrator for
Microsoft Excel" on page 20.

l Dynamic graphing (for viewing graphical relationships between applications and between
processes). See "Dynamic Graphing" on page 76.

l Surveys (for collecting rating information from application users) and other options for requesting
additional information. See "Surveys and Additional Application Data Collection" on page 62.

HP APM components available for analysts include the following:
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l HP APM-specific pages that the analyst accesses from the following    PPM Center menu bar
options:

n Open > Application Portfolio. Used to access the options the analyst selects to create
entities of all types, search for and open entities, access saved searches, analyze data from
grouped entities and with dynamic graphing, view reports, and download the add-in for the PPM
DataMigrator for Microsoft Excel.

n Create > Application. A shortcut to the page the analyst uses to create application entities.

n Create > Survey Request. A shortcut to the page the analyst uses to create survey
registrations.

n Create > Transformation Proposal. A shortcut to the page the analyst uses to create
transformation proposal entities.

n Search > Entities. A shortcut to the page the analyst uses to search for and open HP APM
entities of all types.

For more information, see "Managing Entities" on page 16; "Using the PPMDataMigrator for
Microsoft Excel" on page 20; and "Application Analysis" on page 73.

l PPMDashboard pages and portlets that contain information of value to an analyst. For information
about PPM Dashboard pages and portlets, see "PPM Dashboard and PPMDashboard Pages" on
page 73, "Portlets" on page 75, and "PPM Dashboard Pages and Portlets" on page 160.

l The Browse Entities page—the preliminary page in the Request Browser from which you can group
entities for data analysis. For more information, see "Request Browser" on page 96.

For descriptions of the components and features of the standard PPM Center interface, and
instructions for changing your password, resetting the display of warningmessages, and configuring
other interface settings, see the PPMCenterGetting Started guide.

Guidelines for Using the PPM Center Documentation
This guide describes features and components of HP APM available to you as an HP APM analyst. It
also provides instructions about how to perform tasks specific to HP APM.

Note the following:

l This guide documents the default user interface for HP APM. Your HP APM administrator might
have customized the HP APM fields, pages and entities to best suit your business needs and
requirements. These customizations are not documented in this guide.

l Entities are a type of PPM Center request. They are unique to HP APM.

l On some PPMCenter and HP APM pages, you will see the HP APM entities divided into three
categories: Entities, Activities, andGrouping. In this guide, the term entity applies to all types of HP
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APM entities, regardless of the categories in which they are located. For example, if the instructions
tell you to select an entity from the Entities area of the Search Entities page, youmight instead find
the entity in the Activities or Grouping area.

Throughout this guide, you are referred to PPM Center documents for instructions or additional
information becausemany HP APM tasks can also be performed from PPMCenter menu bar options.
Because of this, youmight need tomakeminor adjustments to the instructions given in the PPM
Center documents.

Be aware of the following:

l Since an entity is a type of PPM Center request, in many cases you will need to use thePPM
Center request instructions in the PPMCenter documents for performing the necessary task. For
example, to perform a basic entity search, you follow the instructions for performing a basic request
search. These terms are usually interchangeable.

l When the instructions tell you to select an option from theOpenmenu on themenu bar, youmight
need to substituteApplication Portfolio for the name of the submenu. For example, in the PPM
CenterGetting Started guide, the instructions for running a saved search tell you to select Open >
DemandManagement > Saved Searches > Manage Saved Searches. To run a saved search in
HP APM, youmust substituteApplication Portfolio forDemand Management—this means you
select Open > Application Portfolio > Saved Searches > Manage Saved Searches to run a saved
search.

l When you are following the PPMCenter instructions, an additional pagemight open. For example,
when you create an application entity from theOpen > Application Portfolio > Create Entities
option, the Create New Entity page opens. This is an HP APM–specific page, so it is not mentioned
in the PPMCenter instructions. In this case, you should select Application from the Entities area
and then continue following the instructions as written in the PPMCenter document. If the Create
New Request page opens, select Application from theRequest Type drop-down list, and then
continue following the instructions as written.

l You do not have access to all themenus and options described in the referenced PPMCenter
documents. Your view of PPM Center and HP APM is determined by the implementation of your
PPM Center, your HP APM role, and the level of access to features and data you are given by the
HP APM administrator.

Getting Help Online
You can easily access descriptions of many of the fields you see in HP APM portlets andWeb pages.
When a help icon is displayed on a portlet orWeb page, click the icon to display descriptions of the
fields in the area in which the icon is located.
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Related Documents
The following HP APM and PPMCenter documents are referenced in this guide. They provide
additional information related to tasks performed by HP APM analysts:

l Creating Portlets andModules

l Getting Started

l Application Portfolio Management Analyst's Guide

l Application Portfolio Management User's Guide

l HP DemandManagement User’s Guide

l HP ProgramManagement User’s Guide

l HP ResourceManagement User’s Guide

l Reports Guide and Reference

For important information about this release of HP APM, see the HP APM for PPM Release Notes.

These documents are available from the HP Software Product Manuals Web site at
h20230.www2.hp.com/selfsolve/manuals.
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Chapter 2: Managing HP APM Entities

Entity Overview
In HP Application Portfolio Management (HP APM), entities are themeans by which actions and
processes are initiated and tracked. They are the building blocks of your application portfolio. Entities
contain all of the information necessary to take a series of actions andmove through a workflow. They
are used to identify objects and designate the relationships and interactions within an organization. An
HP APM entity is a type of Project and Portfolio Management Center (PPM Center) request.

The following entities can be part of the application portfolio:

l Application. A software application or program that implements a business process or function in
your organization. An application entity can bemade up of one or more distinct services.

l Application set. A user-defined grouping of application entities.

l Location. A distinct and unambiguous location of an application, server, or a grouping of locations.

l Process. A standard set of actions or operations performed by the business.

l Roadmap. A roadmap for an individual application/service, or a group of applications/services,
including lifecycle statuses (roadmap phases) andmilestones.

l Server. A physical or virtual machine.

l Survey registration. A query sent to users that requests data about applications to help with their
analysis.

l Transformation proposal. A consolidation of information used tomake a decision about a
proposed project.

l Workstream. A collection of resources working towards a common goal on a portion of the
application or process portfolio.

Additionally, business objectives and organization units, created in PPM Center, can be part of your
application portfolio.

l Business objective. The result that the organization intends to achieve. For more information
about business objectives, see theHP ProgramManagement User’s Guide.

l Organization unit. A business unit, department, or group within an organization. For more
information about organization units, see the HP ResourceManagement User’s Guide.

For detailed descriptions of each of the HP APM entities, see "Entities" on page 101.
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To interact with an entity, you use the associated detail page. The detail page for an entity contains all
of the information about the entity. Also, the detail page is where decisions and actions that pertain to
the entity are executed. For information about the application entity detail page, see theHP Application
Portfolio Management User's Guide. The entity detail page for an application entity is similar to the
detail page for a request. For descriptions of themain sections on a request detail page, see theHP
DemandManagement User’s Guide.

Entity Relationships
"Figure 2-1. Entity Relationships" below shows the relationships that can exist between entities in an
application portfolio.

Figure 2-1. Entity Relationships

Managing Entities
Because an HP APM entity is a type of PPM Center request, managing an entity is typically the same
as managing a request.

For instructions for viewing, processing, andmanaging entities, see theHP DemandManagement
User’s Guide. For additional information about entities, see theHP Application Portfolio Management

HP Application Portfolio Management Analyst’s Guide
Chapter 2: Managing HP APM Entities

HP Project and Portfolio Management Center (9.30) Page 16 of 194



User's Guide. For guidelines for using the instructions in the PPMCenter documentation for performing
HP APM tasks, see "Guidelines for Using the PPMCenter Documentation" on page 12.

Creating Entities
The first step in building your application portfolio is to create the entities that make up the portfolio.
While it is possible to build your portfolio from just applications, designating relationships with
organization units, processes, workstreams, locations, and servers provides you with the ability to
conduct amore detailed and quantifiable analysis of an application or application set.

You can create a new entity from one of the following locations:

l TheOpen > Application Portfolio > Create Entities option on themenu bar

l TheCreate > <Application, Survey Request, or Transformation Proposal> option on themenu
bar (a shortcut for creating three of the entity types)

l The References section on an entity detail page

l TheMake a Copy button on an entity detail page

You can also create entities by importing them into HP APMwith the PPMDataMigrator for Microsoft
Excel (DataMigrator). For instructions, see "Using the PPMDataMigrator for Microsoft Excel" on
page 20.

When you create an entity, the entity is automatically assigned a unique number and tracked from start
to finish. This ensures completion and accountability for all steps within the entity's workflow.

For instructions for creating an entity, see the instructions for creating a request in theHP Demand
Management User’s Guide.

For descriptions of the fields in the HP APM entities, see "Entities" on page 101 of this guide and the
online help available from each section of the entity page.

Opening Entities
You can open an entity from the result of a search, from a portlet, from an email notification, or from the
search box. For more information, see and theHP DemandManagement User’s Guide.

Searching Entities
There are several ways you can search for entities. You can perform a basic entity search or use the
query builder to create a custom search query that uses comparison and logical operators. You can use
the results of a search you perform with the Request Browser to create entity groups that you can use
to display and track information.

Tip: You can also perform a simple search using the search box that is located in the upper-right
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corner of the PPMCenter interface. Use the search box to quickly access an entity (by typing the
entity—or request—number) or amenu item (by typing any part of themenu name to display a list
of correspondingmenu items).

After you have performed a search, you can save it and run it again.

For instructions for searching entities and using the query builder, see the  PPM CenterGetting Started
guide and theHP DemandManagement User’s Guide. For information about using a Request Browser
search to create entity groups, see "Request Browser" on page 96 and theHP DemandManagement
User’s Guide.

Tip: You can also search for entities from the Search > Entities andOpen > Application
Portfolio > Search Entities options on themenu bar.

Editing Entities
You canmake changes to an entity if you created the entity or if you are assigned a role that allows you
to do so.

There are several ways you can update an entity. You can perform a basic edit, perform a quick edit to
edit multiple entities at the same time, or perform amass update tomake the same edit to multiple
entities at the same time. For instructions, see theHP DemandManagement User’s Guide.

If two users edit the same entity at the same time and both click Save, HP APM attempts to save the
changes made by both users. If a change cannot be saved, HP APM advises the user whomade the
change tomake the change again, and then attempt to save it again. For examples that demonstrate
how HP APM handles simultaneous users, see theHP Application Portfolio Management User's
Guide.

Monitoring Entities
Use the following HP APM features tomonitor and locate entities that require attention:

l Searches. If you want to locate a specific entity or group of entities (based on filters you define),
you can search for the entity. For information about searches, see "Searching Entities" on the
previous page and theHP DemandManagement User’s Guide.

l Reports. HP APM provides a predefined set of reports that allow you to view the current status of
your data. For information about reports, see "Reports" on page 76, "Reports" on page 187, and
PPMCenterGetting Started guide.

l Portlets. Portlets provide you with real-time views into your HP APM–based activities. They
provide information such as a list of workstreams assigned to you or the health of applications by
business owner. You can customize portlets to track and assess the data that is meaningful to you.
For information about portlets, see "Portlets" on page 75, "PPM Dashboard Pages and Portlets" on
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page 160, and theCreating Portlets andModules guide.

l Notifications. Someworkflow steps are configured to send email notifications upon activation. As
an entity proceeds through its workflow steps, email notifications might be sent to notify you of
pending actions. The notificationmight include a link that you can click to open the referenced
entity. For more information, see theHP DemandManagement User’s Guide.
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Chapter 3: Using the PPM Data Migrator for
Microsoft Excel

Data Migrator Overview
If you have large amounts of entity data to enter in HP Application Portfolio Management (HP APM),
you can import it using the PPMDataMigrator for Microsoft Excel (DataMigrator). The DataMigrator is
an add-in for Microsoft Excel that HP provides with HP APM. HP also provides a spreadsheet template
for the DataMigrator that you can download.

The HP APM analyst and administrator can use the DataMigrator to create new entities in HP APM,
update entity data and validation values in HP APM, and download entity and validation data from HP
APM to aMicrosoft Excel spreadsheet as described in the following topics:

l "Before You Start" on the next page

l "Installing the DataMigrator" on the next page

l "Configuring the Connection to a PPM Server" on page 22

l "Creating an Import Spreadsheet" on page 24

l "Connecting to the PPM Server using the DataMigratorWizard (for Entity-Related Tasks)" on
page 29

l "Creating, Updating, and Downloading Entity Data" on page 31

l "Cancelling a Download, Create, or Update Process" on page 46

l "Creating New Entities with theMigrate Option" on page 47

l "Viewing the Detail Log and Fixing Logged Errors" on page 48

l "Downloading and Updating Validation Values" on page 50

l "Connecting to the PPM Center Server using the DataMigratorWizard (for Validation-Related
Tasks)" on page 50

l "Viewing, Exporting, and ImportingMapping Relationships" on page 57

l "Reinstalling the DataMigrator" on page 60
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Before You Start
Before you start using the DataMigrator, be aware of the following:

l Youmust install the DataMigrator add-in and other components required for its use. See the HP
APM for PPM Release Notes for the latest software requirements. For the installation instructions,
see "Installing the DataMigrator" below.

l You shouldmake note of the full URL for the PPM Server on which you will use the DataMigrator to
create new entities and to update and download entity and validation data. The URLmust start with
http:// or https://. You will need this information when you configure the connection to the
PPM Server. (For instructions, see "Configuring the Connection to a PPM Server" on the next
page.)

l If you will be creating or updating entities or updating validation values, youmust prepare the
spreadsheets that contain the data you want to import. You can add data to an entity-specific or
validation-specific spreadsheet template that you download from the DataMigrator or use an
existing spreadsheet. See "Creating an Import Spreadsheet" on page 24.

l If you will be creating new entities, make sure all of the data used by the entities has been first
created in Project and Portfolio Management Center (PPM Center). For example, all users listed as
contacts in application entities must be created before the application entities can be created.

Installing the Data Migrator
You install the DataMigrator from PPMCenter. If the required software for the DataMigrator is not
already installed on the computer you are using, the software is installed automatically when you start
the installation. For a list of the software requirements, see the client-side requirements in the HP APM
for PPM Release Notes.

Note: Depending on the software that is installed, youmight be asked to restart your computer
during the installation process.

To install the DataMigrator:

1. Connect to PPM Center as an analyst or administrator.

2. From themenu bar, select Open > Application Portfolio > Download Data Migrator Add-In.

The installation begins.

Note: If theMicrosoft Office Customization Installer dialog box displays themessage
Publisher cannot be verified during the installation of the DataMigrator add-in, ignore
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themessage and click Install.

3. Follow the prompts in the dialog boxes that open to complete the installation.

4. If you are asked to reboot your computer, click Yes to restart it now.

The installation continues automatically after you restart your computer.

Configuring the Connection to a PPM Server
Follow the instructions in this section to configure the connection to the PPM Server on which you will
use the DataMigrator to create new entities and to update and download entity and validation data.

To configure the connection to a PPM Server:

1. Start Microsoft Excel.

2. On theAdd-Ins tab, select Entities > Request orEntities > Validation Value from thePPM
Data Migrator group.

The DataMigrator wizard opens.

3. From theSelect Server drop-down list, select [New Connection] if it is not already selected.

4. Click Connect to create a new connection.

The Logon to PPM Server dialog box opens.

5. Complete the fields in the Logon to PPM Server dialog box.
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Field Description

Server URL Type the full URL for the PPM Server. The URLmust start with http://
or https://.

User Name Type your PPM Center logon name.

Password Type your PPM Center password.

Save the Connection Select this checkbox to save this information so you do not need to
enter it again.

If you do not save the connection, you will need to configure the
PPM Server every time you want to access it.

Name Type a name that describes the PPM Server you are configuring. This
is the name that is displayed in the Select Server drop-down list.

6. Click Logon.

You are connected to the PPM Server.

n If you chose to save the connection, the name you assigned to the PPM Server is displayed in
the Select Server drop-down
list.

Note: Up to ten of themost recent connections to the PPM Server are saved and appear in
the Select Server drop-down list. After ten connections, the oldest connection is deleted
when a new connection is made.

n If you did not choose to save the connection, the name of the PPM Server is not displayed in
the Select Server drop-down list. You will need to configure the PPM Server the next time you
want to access it.

7. Do one of the following:

n If you are creating entities or updating entity data and you have not prepared the spreadsheet,
go to "Creating an Import Spreadsheet" on the next page.

n If you are creating entities or updating entity data and you have prepared the spreadsheet
containing the entity data, go to "Connecting to the PPM Server using the DataMigratorWizard
(for Entity-Related Tasks)" on page 29.

n If you are downloading entity data from HP APM, go to "Connecting to the PPM Server using
the DataMigratorWizard (for Entity-Related Tasks)" on page 29.

n If you are downloading or updating validation values, go to "Downloading and Updating
Validation Values" on page 50.
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Creating an Import Spreadsheet
You can use the DataMigrator to prepare a specially configuredMicrosoft Excel spreadsheet that you
can use to create new entities or update entity data. Before importing new entities or updated entity
data into HP APMwith the DataMigrator, youmust have prepared the special spreadsheet that
contains the data you want to import.

The easiest way to prepare the import spreadsheet is to paste or type the entity data into aMicrosoft
Excel spreadsheet template that you download using the DataMigrator. For instructions, see "Creating
an Import Spreadsheet from a Template" below.

Alternatively, you can use an existingMicrosoft Excel spreadsheet or you can create a new
spreadsheet. For instructions, see "Creating Your Own Spreadsheet" on page 28.

Creating an Import Spreadsheet from a Template
When you download a spreadsheet template from the DataMigrator, the template includes all the
necessary columns and rows for the type of entity you are creating. After you download the template,
youmanually type the entity data into the template or copy and paste the data into the template from
another file. You then customize the template and import the data into HP APMwith the DataMigrator.

"Figure 3-1. Default rows and first four columns of the workstream entity template" below shows the
first four columns and the five default rows included in the spreadsheet template for a workstream
entity.

Figure 3-1. Default rows and first four columns of the workstream entity template

"Table 3-1. Description of default template rows" below describes the default rows included in an entity
template. You can provide or update entity values for fields in which rows 4 and 5 are colored blue.
Values found in the columns in which rows 4 and 5 are colored gray are read-only. You can only provide
values in the first column (where rows 4 and 5 are colored red) when you are adding an entity or entities.
This column is read-only when you download and update entities.

Row Description

1 Type of entity. For example, Application, Location, andWorkstream.

2 Sections of the entity in which the entity fields are located. For example, Summary, Identity,
and Contacts.

Table 3-1. Description of default template rows
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Row Description

3 Column headings (the entity field names). For example, Name, Version, and Business
Owner.

4 Data types. For example, Text, Currency, and Numeric.

5 Tokens used by the DataMigrator to map the columns in the template to the entity fields. For
example, REQ.DESCRIPTION, REQ.REQUEST_ID, and REQ.STATUS_NAME.

6+ Empty rows into which you type or paste entity data. Typically, a row represents a single
entity. Entities with one or more table components might span than one row. For example, the
List of Applications & Respondents table in the Survey Registration entity is a table
component, as shown in the following image.

The spreadsheet entry for this entity spans two rows, one row for each row in the List of
Applications & Respondents table, as shown in the following images. The first image shows
the segment of the spreadsheet with the first three columns for the entity. The second image
shows the segment of the spreadsheet that includes the entries for each of the two rows in
the List of Applications & Respondents table component.

For more information about the List of Applications & Respondents table, see "Survey
Registration" on page 143.

Table 3-1. Description of default template rows, continued
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Creating the Spreadsheet Template

To create a spreadsheet template with the DataMigrator:

1. Start Microsoft Excel.

2. Open a blank spreadsheet.

3. On theAdd-Ins tab, select Entities > Request from thePPM Data Migrator group.

4. From theSelect Server drop-down list, select the name of the PPM Server to which you want to
connect. If the drop-down list does not contain the PPM Server to which you want to connect or if
the list is empty, see "Configuring the Connection to a PPM Server" on page 22.

5. Click Connect.

The Select Entity Type drop-down list becomes available.

6. From theSelect Entity Type drop-down list, select the type of entity for which you want to create
a template and click Next.

The Select an Action to Perform dialog box opens.

7. Click theDownload Records icon.

The DownloadOptions dialog box opens.

8. In theDownload Options dialog box, select or clear the checkboxes as necessary so only the
fields you want to include in the template are selected. To select all of the fields, click Check All.
To clear the checkboxes for all of the fields, click Uncheck All.

9. If necessary, click Advanced Options to configure additional settings.

Note: Typically, you do not need to configure the AdvancedOptions settings when you create
a spreadsheet template. For instructions for configuring the AdvancedOptions settings, see
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step 12.

10. Click Next to create the template.

Caution: If you click Cancel while the template is being created, only some of the datamight
be downloaded. For more information, see "Cancelling a Download, Create, or Update
Process" on page 46.

One of the following occurs:

n If there are no existing entities of the type for which you are creating the template, amessage
tells you there are no requests to download. A template containing only the default rows
described in "Table 3-1. Description of default template rows" on page 24 is created.

n If there are existing entities of the type for which you are creating the template, several status
messages are displayed. The final message says Downloading Requests... Done! and
shows the number of downloaded entities. A template containing the default rows described in
"Table 3-1. Description of default template rows" on page 24 is created. The template also
contains one or more additional rows for each existing entity.

11. Click Finish to close the DataMigrator wizard

12. If the template is populated with data for existing entities and you want to use this spreadsheet as
a template, remove data from all the rows except rows 1–5.

13. Save the template.

14. Go to "Preparing the Spreadsheet Template for Importing" below.

Preparing the Spreadsheet Template for Importing

After you create the template, you use it to prepare the spreadsheet that contains the entity data you
want to import into HP APMwith the DataMigrator.

To prepare a downloaded spreadsheet for importing:

1. Start Microsoft Excel.

2. Open a spreadsheet template. (See "Creating the Spreadsheet Template" on the previous page.)

3. If necessary, customize the entity field names in row 3.

Do notmake any changes to row 5. This row is used by the DataMigrator to map the spreadsheet
columns to the fields in the entity.

4. Remove any columns you do not need.
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Although the column containing the REQ.REQUEST_ID token is optional, consider leaving it in
your spreadsheet. This column is populated by the DataMigrator with a unique request number for
each entity it creates when you import new entities. Request numbers are required if you update
the entity data later using the DataMigrator.

Note: The column containing the REQ.REQUEST_ID tokenmust be left blank when you are
importing entities.

5. Copy and paste the entity data into the spreadsheet from another file or manually type it into the
spreadsheet.

Note: Your spreadsheet must include a column that contains a unique identifier for each
entity you are importing. You can enter the identifier in the Identifier column (column A) in the
template or, when you configure the DataMigrator to import the data from the spreadsheet,
you can designate a columnwith a different title as the column that contains the unique ID or
name. For example, if all of your entities have unique names, you can designate the column
that contains the entity names as the identifier column.

6. Save the spreadsheet.

7. To create entities using this spreadsheet, go to "Creating New Entities" on page 32.

Creating Your Own Spreadsheet
You can create your own spreadsheet in Microsoft Excel or use an existing spreadsheet that you have
modified tomeet the DataMigrator requirements. Create the spreadsheet following these guidelines.
The spreadsheet must contain:

l Information about a single entity type. For example, if you want to import application, location, and
workstream entities, youmust create three spreadsheets, one for each entity type.

l A row of column headings. Although this can be any row, it should be a row that contains a brief
description or name for the type of information the column contains. You will map the column
headings to entity fields later.

l Your spreadsheet must include a column that contains a unique identifier for each entity you are
importing. When you configure the DataMigrator to import the data from the spreadsheet, you
designate a column as the column that contains the unique ID or name for each entity. For example,
if all of your entities have unique names, you can designate the column that contains the entity
names as the identifier column.

l (Optional)When the DataMigrator creates an entity, it assigns the entity a unique PPMCenter
request number. If you include a column that contains only a column heading, the DataMigrator
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enters the request number in this columnwhen the entity is created—this columnmust be blank
except for the column heading. Make note of the name you give this column. You will map it later to
the field identified in "Table 3-2. Field, by entity type, to bemapped to the request number column"
on page 35.

Note: Although the request number column is optional, consider including it in your
spreadsheet. The request numbers that the DataMigrator adds to this column are required if
you update the entities later using the DataMigrator.

l (Optional) A row that contains tokens that correspond to each of the column headings. (Tokens are
unique identifiers assigned by PPMCenter to each of the fields in an HP APM entity.) If you include
a row of PPM Center tokens in your spreadsheet, the DataMigrator automatically maps the
spreadsheet columns that have tokens to the fields in the HP APM entity during themapping
process. If you create your spreadsheet using a template that you download from the DataMigrator,
the token row is populated for you. (For instructions, see "Creating an Import Spreadsheet from a
Template" on page 24.)

Connecting to the PPM Server using the Data Migrator
Wizard (for Entity-Related Tasks)
You select the options you use to create new entities, update existing entities, and download entity
data from the Select an Action to Perform dialog box. This dialog box opens after you connect to the
PPM Server using the DataMigrator wizard.

To open the DataMigrator wizard, connect to the PPM Server, and access the Select an Action to
Perform dialog box for entity-related tasks:

1. In Microsoft Excel, do one of the following:

n If you are creating or updating entity data, open the spreadsheet containing the entity data. (For
instructions for creating the spreadsheet, see "Creating an Import Spreadsheet" on page 24.)

Caution: If the spreadsheet you are using to create entities contains entities that already
have request numbers assigned to them, the entities with request numbers are skipped.
(See "Table 3-2. Field, by entity type, to bemapped to the request number column" on
page 35.) If the spreadsheet contains identifiers that match identifiers used for existing
entities in the PPM Server, the entities are skipped.

n If you are downloading data, open a blank spreadsheet or the spreadsheet you prepared for the
download. (For instructions, see "Downloading Entity Data to a Spreadsheet" on page 42.)

2. On theAdd-Ins tab, select Entities > Request from thePPM Data Migrator group.
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The DataMigrator wizard opens.

3. From theSelect Server drop-down list, select the name of the PPM Server on which you want to
create, update, or download entity data, and click Connect. If the list is empty, see "Configuring
the Connection to a PPM Server" on page 22.

Note: TheSelect Server drop-down list contains the names of the last ten PPM Servers that
you accessed and for which you saved the connection information.

When you are connected to the PPM Server, themessage Get request type list... Done is
displayed at the bottom of the dialog box, and the Select Entity Type drop-down list becomes
available.

4. From theSelect Entity Type drop-down list, select the type of entity you want to create, update,
or download, and click Next.

Tip: In this list, HP APM entity names start withAPM.

The Select an Action to Perform dialog box opens.
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Note: Users with additional access privileges also see theMigrate Records option. For
information about using theMigrate Records option, see "Creating New Entities with the
Migrate Option" on page 47.

5. For instructions for performing the tasks you can perform from the options in this dialog box, see
one of the following sections:

n "Creating New Entities" on the next page (the Create Records option)

n "Updating Entity Data" on page 38 (the Update Existing Records option)

n "Downloading Entity Data to a Spreadsheet" on page 42 (the Download Records option)

n "Creating New Entities with theMigrate Option" on page 47 (theMigrate Records option
available only to users with additional access privileges)

Creating, Updating, and Downloading Entity Data
You can create, update, and download entity data using the DataMigrator. This section contains the
steps you need to follow to perform these tasks.
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Caution:When you are creating entities, import the different entity types in the order of their
dependencies. That is, if entity type A has a dependency on entity type B, import entity type B
first. For example, server entities might have dependencies on location entities. Therefore, import
location entities before importing server entities.

The recommended order for importing the different entity types is: location, server, process,
application, application set, transformation proposal, workstream, and survey registration.

You cannot use the DataMigrator to delete entity data that you import into HP APM using the Data
Migrator.

Creating New Entities
To create new entities:

1. Access the Select an Action to Perform dialog box. For instructions, see "Connecting to the
PPM Server using the DataMigratorWizard (for Entity-Related Tasks)" on page 29.

2. Click theCreate Records icon to create entities of the type you selected when you connected to
the PPM Server.

TheMap Attributes to Columns dialog box opens.

Note: In this context, attributes are the entity fields.

3. Do one of the following:

n If you are working with a spreadsheet that was created from aDataMigrator template, review
the preconfigured entries in theMap Attributes to Columns dialog box. If you need tomake
changes, go to the next step. If the default settings are correct, go to step 10.

n If you are working with a spreadsheet that you created, go to the next step.

4. To the right of theColumn Header Row field, click the selection icon ( ).

The Select a Row dialog box opens.

5. In the spreadsheet, click a cell in the row that contains the column headings.

The identifier for the cell you clicked is entered in thePlease select the row for field headers
field in the Select a Row dialog box.

6. Click OK.

The Select a Row dialog box closes, and the number of the selected row is displayed in the
ColumnHeader Row field in theMap Attributes to Columns dialog box. The headings from the row
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you selected—with the letter identifying the column they are in as the prefix—are added to the
options available in theUnique record identifier drop-down list. The headings are also displayed
in theSpreadsheet list.

7. If the spreadsheet contains a row of tokens, do the following:

a. Select the (Optional) Token Row checkbox.

b. To the right of the (Optional) Token Row field, click the selection icon ( ).

The Select a Row dialog box opens.

c. In the spreadsheet, click a cell in the row that contains the tokens.

The identifier for the cell you clicked is entered in thePlease select the row for field tokens
field in the Select a Row dialog box.

d. Click OK.

The Select a Row dialog box closes, and the number of the selected row is displayed in the
(Optional) Token Row field. The DataMigrator automatically attempts tomap the spreadsheet
columns to the fields in the Entity Type list. Successfully mapped columns and fields are
displayed in blue text.

"Figure 3-2. Map Attributes to Columns dialog box after the Token Row is selected" on the
next page shows theMap Attributes to Columns dialog box after the token row is selected.
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Figure 3-2. Map Attributes to Columns dialog box after the Token Row is selected

8. From theUnique record identifier drop-down list, select the heading of the column that contains
a unique identifier for each entity listed in the spreadsheet. For example, select the column that
contains a unique identification number or name for each entity.

9. Manually map any unmapped columns in theSpreadsheet list to the fields in theEntity Type list
following the guidelines and instructions in this step. The list of fields is displayed in the same
order—and in the same sections—as the fields appear in the entity. For descriptions of entity
fields in the sections and order in which they appear, see "Entities" on page 101.

Note the following:

n The color of a column in the Spreadsheet list determines if it has beenmapped. Mapped
columns are displayed in blue text. Unmapped columns are displayed in gray text.

n To see additional information about a field such as its data type and token, scroll to the right in
the Entity Type list. If necessary, you can expand a column by dragging the column divider to
the right.

n Not all columns need to bemapped. Unmapped columns are ignored.

n To view amapped relationship, click a blue column heading or field to highlight its
corresponding column or field.
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n (Optional) If you created an empty column for the request number, youmust map it to the field
listed in "Table 3-2. Field, by entity type, to bemapped to the request number column" below for
the type of entity you are creating.

Note: A request number is the same as an entity number.

Entity Type Field

Application Application No.

Application Set Set No.

Business Survey Survey No.

General Survey Survey No.

Location Location No.

Process Process No.

Server Server No.

Survey Registration Request No.

Technical Survey Survey No.

Transformation Proposal Proposal No.

Workstream Workstream No.

Table 3-2. Field, by entity type, to be mapped to the request number column

Tomap the spreadsheet columns to entity fields:

a. Click a column in theSpreadsheet list, and then click its corresponding field in theEntity
Type list.

b. Click Map.

The column name is added to theColumn column in theEntity Type list and themapped
column and field are colored blue.

c. Repeat step a and step b until all the necessary columns aremapped.

10. Click Next.

The Create New Requests in PPM dialog box opens showing themapped fields and their
corresponding sections, tokens, and columns. The field containing the request number and fields
designated as being read-only by gray column headings in the template spreadsheet are not
included in this list.
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11. Select or clear the checkboxes as necessary so only the fields for which you want to include
values are selected. To clear all the selected checkboxes, click Uncheck All. To select the
checkboxes for all the fields, click Check All.

12. Click Advanced Options to configure additional settings. To cancel any changes youmake to the
AdvancedOptions dialog box, click Cancel.

n On theGeneral tab, configure the following settings:

o In theColoring box, select the colors from theHighlight Success andHighlight Failed
fields that the DataMigrator uses in the spreadsheet to show the status of the entities after
the import is completed. To change a color, click theColor button and select a new color.
To define custom colors, click Define Custom Colors in theColor dialog box.

By default, entities that are created successfully are highlighted in light green and entities
that were not created are highlighted in light red.

o In theConcurrency box, select themaximum number of concurrent threads—up to 20—
from theMaximum Threads drop-down list. When you configure this field, consider the
performance objectives for your environment. Setting this field to a higher number could
improve throughput but might also put more of a load on your  PPM Server. The default
value is 5.

Note: The Ignore attributes with empty values setting in thePre-processing box is
ignored when you create entities.

o In thePost-processing box, select theReload all attributes from server checkbox to
allow the DataMigrator to update fields in the original spreadsheet when the fields have a
new value after the entities are created.

Some of the field values in entities that are uploaded to the PPM Server could change
because of rules that run on the PPM Server. When this occurs, the results of the rules are
downloaded to the original spreadsheet if you selected the Reload all attributes from server
checkbox. For example, an application entity that contains ratings is uploaded to
the PPM Server. The PPM Server applies rules to the ratings and calculates a score.
Because you selected the Reload all attributes from server checkbox, the scores are then
downloaded to the spreadsheet.

Note: The columnmapped to the request number is always updated, whether or not
this checkbox is selected.

By default, the Reload all attributes from server checkbox is not selected.

n On theData tab, define the delimiters for fields that can havemore than one value. For
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example, if you havemore than one person listed as a subject matter expert (SME) and have
separated the users names with commas, you would select the checkbox forSMEs and enter
a comma (,) in theSet Delimiter field. The default delimiter is a semicolon (;).

i. In theSet Delimiter field, type the delimiter.

ii. Select the checkbox for each field in which this delimiter is used.

iii. Click Apply.

The delimiter is displayed in the Delimiter column for each of the selected fields.

iv. Clear the selected checkboxes and repeat step i through step iii to define delimiters for
additional fields.

n On theDependencies tab, specify one or more fields to be ignored during the first pass at
creating entities. Do this when one or more fields in the entities you are creating require other
entities or fields to be created before the fields can be populated successfully. When you select
a field on this tab, it is ignored during the first pass. The entity is created but the value of this
field is empty. After the first pass is complete, the DataMigrator automatically makes a second
pass at populating the selected fields.

To configure the Dependencies tab:

i. Select the Enable multi-pass to handle attribute dependencies between records
checkbox to run two passes at importing the data.

ii. Select the checkboxes for the fields that are to be left empty the first time the Data
Migrator imports the spreadsheet.

Note: If you specify dependencies on this tab and later cancel the create process while
the entities are being created, the second pass might not complete successfully. For more
information, see "Cancelling a Download, Create, or Update Process" on page 46.

When you are finished, click OK to save your changes and close the AdvancedOptions dialog
box.

13. Click Next.

Caution: If you click Cancel before the process is completed, only some of the entities might
be created. For more information, see "Cancelling a Download, Create, or Update Process"
on page 46.

The DataMigrator attempts to validate and create the selected entities. This could take several
minutes. When the process is complete, a summary of the results of the import is displayed.
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14. Review the summary information. Towards the top of the dialog box, <N> of <N> is displayed
(where <N> represents the number of entities). This indicates the number of entities—out of the
total number of entities in the spreadsheet—that were processed (successfully or not).

Statements such as the following could be included at the bottom of the dialog box.

n <N> requests pass pre-validation. <N> entities were validated.

n <N> requests do not pass pre-validation. <N> entities contained errors and were not validated.
You will need to fix these errors before attempting to create the entities again.

n <N> requests successfully created. <N> entities were created successfully.

n <N> requests failed to create. <N> entities were not created.

n <N> requests have been skipped. <N> entities were skipped because the entities with the
same identifier already existed in the PPM Server.

15. If the import was not successful, click View Log to view information about any errors that were
reported. For instructions for saving the Detail Log and for using the information in the log file to fix
the errors, see "Viewing the Detail Log and Fixing Logged Errors" on page 48.

16. When all of the entities are created successfully, click Finish.

The DataMigrator closes.

17. Save the spreadsheet.

Updating Entity Data
If you need to update entity data, you can use the DataMigrator to import the updates into HP APM
from a spreadsheet.

You can prepare the spreadsheet with your updates in several ways:

l Modify the data in your original import spreadsheet.

l Prepare a new spreadsheet.

l Download a spreadsheet populated with information about the entities, and make changes to the
entity data as necessary. (For instructions for downloading entity data, see "Downloading Entity
Data to a Spreadsheet" on page 42.)

Regardless of which type of spreadsheet you use, the spreadsheet must have at the very minimum, a
header row, a row for each entity you are updating, and two columns. One columnmust contain the
request number assigned by the DataMigrator to each of the entities for which you aremaking a
change, and the second column—and additional columns, if necessary—must contain the updated
values. The spreadsheet can also contain columns with data that does not need to be updated.

To update entity data:
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1. Access the Select an Action to Perform dialog box. For instructions, see "Connecting to the
PPM Server using the DataMigratorWizard (for Entity-Related Tasks)" on page 29.

2. Click the Update Existing Records icon to update entities of the type you selected when you
connected to the PPM Server.

TheMap Attributes to Columns dialog box opens.

3. Do one of the following:

n If you are working with a spreadsheet that was created from aDataMigrator template, review
the preconfigured entries in this dialog box. If you need tomake changes, go to the next step. If
the default settings are correct, go to step 10.

n If you are working with a spreadsheet that you created, go to step 4.

4. To the right of theColumn Header Row field, click the selection icon ( ).

The Select a Row dialog box opens.

5. In the spreadsheet, click a cell in the row that contains the column headings.

The identifier for the cell you clicked is entered in thePlease select the row for field headers
field in the Select a Row dialog box.

6. Click OK.

The Select a Row dialog box closes, and the number of the selected row is displayed in the
ColumnHeader Row field. The headings from the row you selected—with the letter identifying the
column they are in as the prefix—are added to the options available in the Unique record identifier
drop-down list. The headings are also displayed in the Spreadsheet list.

7. If the spreadsheet contains a row of tokens, do the following:

a. Select the (Optional) Token Row checkbox.

b. To the right of the (Optional) Token Row field, click the selection icon ( ).

The Select a Row dialog box opens.

c. In the spreadsheet, click a cell in the row that contains the tokens.

The identifier for the cell you clicked is entered in the Please select the row for field tokens
field in the Select a Row dialog box.

d. Click OK.

The Select a Row dialog box closes, and the number of the selected row is displayed in the
(Optional) Token Row field. The DataMigrator uses the tokens in this row to attempt to map
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the fields in the Spreadsheet list to the fields in the Entity Type list. Successfully mapped
columns and fields are displayed in blue text.

8. From theUnique record identifier drop-down list, select the column that contains the request
numbers that were assigned to the entities by the DataMigrator when they were created.

9. Manually map any unmapped columns in the Spreadsheet list to the fields in theEntity Type list.
The list of fields is displayed in the same order—and in the same sections—as the fields appear in
the entity. For descriptions of entity fields in the sections and order in which they appear, see
"Entities" on page 101.

Note the following:

n Youmust map the column that contains the request number to the field listed in "Table 3-2.
Field, by entity type, to bemapped to the request number column" on page 35 for the type of
entity you are updating.

n You are only required tomap the columns in which the values have changed.

For additional information about mapping columns to fields and instructions, see the notes and
instructions in step 9.

10. Click Next.

The Update Requests in PPM dialog box opens showing themapped fields and their
corresponding sections, tokens, and columns. The field containing the request number and fields
designated as being read-only by gray column headings in the template spreadsheet are not
included in this list.

11. Select or clear the checkboxes as necessary so only the fields you want to update are selected.
To clear the selected checkboxes, click Uncheck All. To select the checkboxes for all the fields,
click Check All. By default, all fields are selected.

12. Click Advanced Options to configure additional settings. To cancel any changes youmake to the
AdvancedOptions dialog box, click Cancel.

n On theGeneral tab, configure the following settings:

o In theColoring box, select the colors from theHighlight Success andHighlight Failed
fields that the DataMigrator uses in the spreadsheet to show the status of the entities after
the import is completed. To change a color, click theColor button and select a new color.
To define custom colors, click Define Custom Colors in the Color dialog box.

By default, entities that are updated successfully are highlighted in light green and entities
that were not updated are highlighted in light red.

o In theConcurrency box, select themaximum number of concurrent threads—up to 20—
from theMaximum Threads drop-down list. When you configure this field, consider the
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performance objectives for your environment. Setting this field to a higher number could
improve throughput but might also put more of a load on your  PPM Server. The default
value is 5.

o In thePre-processing box, select the Ignore attributes with empty values checkbox to
ignore fields in the spreadsheet that do not contain a value. For example, if a spreadsheet
field is empty and the corresponding field in the entity you are updating contains a value, the
empty field in the spreadsheet is ignored and the value of the field in the entity remains
unchanged. By default, this checkbox is not selected.

o In thePost-processing box, select theReload all attributes from server checkbox to
allow the update DataMigrator to update fields in the original spreadsheet when the fields
have a new value after the entities are updated.

Some of the field values in entities that are uploaded to the PPM Server could change
because of rules that run on the PPM Server. When this occurs, the results of the rules are
downloaded to the original spreadsheet if you selected theReload all attributes from
server checkbox. For example, updates to an application entity that contains ratings are
uploaded to the PPM Server. The PPM Server applies rules to the ratings and calculates
a score. Because you selected theReload all attributes from server checkbox, the
scores are then downloaded to the spreadsheet.

By default, this checkbox is not selected.

n On theData tab, define the delimiters for fields that havemore than one value. The default
delimiter is a semicolon (;).

i. In theSet Delimiter field, type the delimiter.

ii. Select the checkbox for each field in which this delimiter is used.

iii. Click Apply.

The delimiter is displayed in the Delimiter column for each of the selected fields.

iv. Clear the selected checkboxes and repeat step i through step iii to define delimiters for
additional fields.

Note: TheDependencies tab is not used when updating entities.

When you are finished, click OK to save your changes and close the dialog box.

13. Click Next.

Caution: If you click Cancel before the process is completed, only some of the datamight be
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updated. For more information, see "Cancelling a Download, Create, or Update Process" on
page 46.

The DataMigrator attempts to validate and update the selected entities. This could take several
minutes. When the process is complete, themessage Update Request... Done! and a
summary of the results of the import are displayed.

14. Review the summary information. Towards the top of the dialog box, <N> of <N> is displayed
(where <N> represents the number of entities). This indicates the number of entities—out of the
total number of entities in the spreadsheet—that were processed (successfully or not).

Statements such as the followingmight also be displayed:

n <N> requests pass pre-validation. <N> entities were validated.

n <N> requests do not pass pre-validation. <N> entities contained errors and were not validated.
You will need to fix these errors before attempting to update the entities again.

n <N> requests successfully updated. <N> entities were updated successfully.

n <N> requests failed to update. <N> entities were not updated.

15. If the update was not successful, click View Log to view information about any errors that were
reported. For instructions for using the information in the log file to fix the errors, see "Viewing the
Detail Log and Fixing Logged Errors" on page 48.

16. When all of the entities are updated successfully, click Finish.

The DataMigrator closes.

17. Save the spreadsheet.

Downloading Entity Data to a Spreadsheet
You can download entity data from HP APM to aMicrosoft Excel spreadsheet. This data can be all
data for all entities of a specific entity type or specific data such as data for only the types of entities, or
specific entities or fields you want.

Caution: If the spreadsheet you use for the download already contains data, some or all of the
datamight be overwritten during the download process. The data that might be overwritten is
located beneath the header or token row (whichever row is last). Any data in the rows or columns
that are needed to hold the downloaded data is overwritten with new entity data. If the spreadsheet
contains data in more rows or columns than are needed for new data, those rows or columns are
not overwritten.

Note the following:
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l To download all data for all entities of a specific entity type, you can start with a blank spreadsheet.

l To download data for specific fields or entities, you do one or more of the following:

n You can select the fields and entities for which you want to download data when you configure
the entity type you are going to download (this option is described later in this section).

n You can prepare a spreadsheet that contains, at theminimum, a header row with the names of
only the fields for which you want to download data.

n You can prepare a spreadsheet from a template you created with the DataMigrator.

To download entity data:

1. Access the Select an Action to Perform dialog box. For instructions, see "Connecting to the
PPM Server using the DataMigratorWizard (for Entity-Related Tasks)" on page 29.

2. Click theDownload Records icon to download entity data of the type you selected when you
connected to the PPM Server.

One of the following occurs:

n If the spreadsheet is blank, the DownloadOptions dialog box opens. Go to step 11.

n If the spreadsheet is not blank, theMap Attributes to Columns dialog box opens. Go to the next
step.

3. Do one of the following:

n If you are working with a spreadsheet that was created from aDataMigrator template, review
the preconfigured entries in this dialog box. If you need tomake changes, go to the next step. If
the default settings are correct, go to step 10.

n If you are working with a spreadsheet that you created, go to step 4.

4. To the right of theColumn Header Row field, click the selection icon ( ).

The Select a Row dialog box opens.

5. In the spreadsheet, click a cell in the row that contains the column headings.

The identifier for the cell you clicked is entered in thePlease select the row for field headers
field in the Select a Row dialog box.

6. Click OK.

The Select a Row dialog box closes, and the number of the selected row is displayed in the
ColumnHeader Row field. The headings from the row you selected—with the letter identifying the
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column they are in as the prefix—are added to the options available in the Unique record identifier
drop-down list. The headings are also displayed in the Spreadsheet list.

7. If the spreadsheet contains a row of tokens, do the following:

a. Select the (Optional) Token Row checkbox.

b. To the right of the (Optional) Token Row field, click the selection icon ( ).

The Select a Row dialog box opens.

c. In the spreadsheet, click a cell in the row that contains the tokens.

The identifier for the cell you clicked is entered in thePlease select the row for field tokens
field in the Select a Row dialog box.

d. Click OK.

The Select a Row dialog box closes, and the number of the selected row is displayed in the
(Optional) Token Row field. The DataMigrator automatically attempts tomap the spreadsheet
columns to the fields in the Entity Type list. Successfully mapped columns and fields are
displayed in blue text.

If you do not want to download data for all of the fields, select the checkboxes for each field
you do not want to include and click Unmap.

8. From theUnique record identifier drop-down list, select the column that contains the request
numbers that were assigned to the entities by the DataMigrator when they were created.

9. Manually map any unmapped columns to fields for which you want to download data. Map the
columns in the Spreadsheet list to the fields in theEntity Type list. The list of fields is displayed
in the same order—and in the same sections—as the fields appear in the entity. For descriptions
of entity fields in the sections and order they appear, see "Entities" on page 101.

Note: You are only required tomap the columns for the fields you want to download.

For additional information about mapping columns to fields and instructions, see the notes and
instructions in step 9.

10. Click Next.

The DownloadOptions dialog box opens.

11. In the Download Options dialog box, select or clear the checkboxes as necessary so only the
fields for which you want to download data are selected. The DownloadOptions dialog box shows
themapped fields and their corresponding sections, columns, headers, and data types. The field
containing the request number and fields designated as being read-only by gray column headings
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in the template spreadsheet are not included in this list.

To clear all of the selected checkboxes, click Uncheck All. To select all the checkboxes, click
Check All.

12. Click Advanced Options to configure download settings. To cancel any changes youmake to the
AdvancedOptions dialog box, click Cancel.

n On theGeneral tab, configure the following settings:

o In theHighlight Success field in theColoring box, select the color that the DataMigrator
uses in the spreadsheet to show the entities that were downloaded successfully. To
change the color, click theColor button and select a new color. To define custom colors,
click Define Custom Colors in theColor dialog box.

By default, entities that downloaded successfully are not highlighted.

o In theConcurrency box, select themaximum number of concurrent threads—up to 20—
from theMaximum Threads drop-down list. When you configure this field, consider the
performance objectives for your environment. Setting this field to a higher number could
improve throughput but might also put more of a load on your  PPM Server. The default
value is 5.

n On theData tab, define the delimiters for fields that havemore than one value. The default
delimiter is a semicolon (;).

i. In theSet Delimiter field, type the delimiter.

ii. Select the checkbox for each field in which this delimiter is used.

iii. Click Apply.

The delimiter is displayed in the Delimiter column for each of the selected fields.

iv. Clear the selected checkboxes and repeat step i through step iii to define delimiters for
additional fields.

n On the Filters tab, configure the filters that determine the entities to be downloaded.

i. If you want to limit the number of entities that are downloaded, select theEnable
filtering of records to be downloaded checkbox.

ii. To limit the entities that are downloaded to those containing a specific word in their
description, type the word by which the entities are to be filtered in the <Name> contains
field.

iii. To display a list from which you can select the entities to be downloaded, select the
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Manually pick requests to download checkbox. This is a filtered list if you entered a
word in the <Name> contains field.

When you are finished configuring the advanced options, click OK to save your changes and
close the dialog box.

13. Click Next.

Caution: If you click Cancel before the process is completed, only some of the datamight be
downloaded. For more information, see "Cancelling a Download, Create, or Update Process"
below.

n If you selected theManually pick requests to download checkbox on the Filters tab, the
Select Records dialog box opens.

i. Select or clear the checkboxes as necessary so only the entities you want to download
are selected. To clear all the selected checkboxes, click Uncheck All. To select all the
checkboxes, click Check All.

ii. Click Next.

The DataMigrator downloads the selected entities and fields.

n If you did not select theManually pick requests to download checkbox, the DataMigrator
immediately downloads the selected entities and fields.

The download could take several minutes. When the process is complete, themessage
<N> of <N> is displayed (where <N> represents the number of entities). This indicates the
number of entities—out of the total number of entities that you selected for downloading—that
were downloaded.

14. Click Finish.

The DataMigrator closes.

15. Save the spreadsheet.

Cancelling a Download, Create, or Update Process
If you click the Cancel button to stop a download, create, or update process, the DataMigrator
continues to run as it completes any active threads before aborting the process. What you need to do
next is determined by the process the DataMigrator was performing:

l Downloading entities or validations. View the spreadsheet to see which entities or validations (if
any) were downloaded. If you want to download all entities or validations, repeat the download.
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l Creating entities. Do one of the following:

n If you did not specify dependencies on the Dependencies tab, repeat the steps to create the
entities again. Entities that were created successfully before the process was stopped are
ignored when you repeat the create process.

Note: For entities that were created successfully, the spreadsheet shows the request
number assigned by the DataMigrator in the request number column.

n If you specified dependencies on the Dependencies tab, do one of the following:

o If the status message says Create Request... Abort!, repeat the steps to create the
entities again.

o If the status message says Create Request (2nd Pass)... Abort!, view the Detail Log
to learn if the second pass completed successfully for all entities. If it did not, follow the
instructions to update the entities in "Updating Entity Data" on page 38 to complete the
processing of the dependencies.

l Updating entities or validation values. If the status message says Update Request...
Abort!, click View Log to view the Detail Log file to learn the status of the update. If any of the
entities do not show they were updated successfully or if the details cell is empty for any entities,
repeat the update process. For information about the Detail Log file, see "Viewing the Detail Log and
Fixing Logged Errors" on the next page.

Creating New Entities with the Migrate Option
Users whose configuration includes the Sys Admin: Migrate PPMObjects access grant see an
additional option in the Select an Action to Perform dialog box—the option toMigrate Records. This
option is typically used by an HP APM administrator who administers multiple PPM Center instances
(for example, a development, test, and production system), and wants tomigrate HP APM entity data
from one instance to another without losing original information.

The Created By (token REQ.CREATED_BY) and Created On (token REQ.CREATION_DATE) fields
are normally read-only and populated automatically by HP APM. When theMigrate option is available
to you, you are able to provide data for these fields. This option is useful when you want your data to
include original information about who created the entity and when it was created.

To create entities that include original data in the Created By and Created On fields:

1. Prepare a spreadsheet that includes the values you want to appear in the Created By and Created
On fields. For instructions for creating a spreadsheet, see "Creating an Import Spreadsheet" on
page 24.

Note: If you do not provide values for these fields, they are populated with the default values.
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2. Access the Select an Action to Perform dialog box following the instructions for creating entities in
"Connecting to the PPM Server using the DataMigratorWizard (for Entity-Related Tasks)" on
page 29.

3. Follow the instructions in "Creating New Entities" on page 32 to create new entities with the
exception that, in step 2, click theMigrate Records icon instead of Create Records.

Viewing the Detail Log and Fixing Logged Errors
If all the entities were not created, updated, or downloaded successfully, see the Detail Log for
information about the errors that occurred and suggestions for correcting them.

To view the Detail Log and fix any errors it includes:

1. On the page that shows the upload summary, click View Log.

The Detail Log opens. The summary information from the previous page is copied to the top of the
log. Messages are identified by the row in the spreadsheet to which they apply. The icons used in
the log are described in "Table 3-3. Descriptions of icons used in the Detail Log" below. The
background of the selected cell is highlighted in blue.

Icon Description

The action failed.

The entity or validation was created or updated successfully.

The record was skipped during processing. This is informational only.

No icon The action was not processed. For example, the action was cancelled.

Table 3-3. Descriptions of icons used in the Detail Log

2. You can save the summary information and logmessages to the spreadsheet. Before you do this,
review the following notes, and then clickWrite Log Into Worksheet (last column).

Note the following before saving the error messages:

n When you clickWrite Log Into Worksheet (last column), the logmessages are added to the
first empty column at the end of the spreadsheet and highlighted in yellow.

n Youmust save the spreadsheet containing the logmessages if you want to be able to refer to
them again. When you close the Detail Log page, the information is no longer available.

n If the Detail Log page shows that entities that had errors during an earlier import were now
processed successfully, any error messages about these entities that you saved previously to
the spreadsheet are deleted if you again clickWrite Log Into Worksheet (last column).
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3. To attempt to fix a listed error, click a cell in the row with the error on the Detail Log page, and then
click Fix it.

Note: The cells you selected in the Detail Log are highlighted in blue.

The Log Details dialog box opens.

4. Click a cell in the spreadsheet to display information in the Log Details dialog box about the error or
errors the row in which the cell is located contains.

5. Modify the spreadsheet to fix the error, save the spreadsheet, and click Retry in the Log Details
dialog box. If the Retry button is not available, click another cell within the row that youmade the
change to enable it.

Note: Youmust retry the fix to each row individually. For example, if there are errors in four
rows, click in the first row in which you fixed an error and click Retry. Repeat for each of the
remaining rows that had errors you fixed.

The DataMigrator attempts to again process the entity data, and one of the following occurs:

n If the error was fixed, themessage in the Log Details dialog box shows the retry was
successful. The highlighting in the spreadsheet changes from yellow to green, although the log
message in the spreadsheet is still highlighted in yellow and still shows the error.

n If the error was not fixed, the error description remains in the Log Details dialog box. Do one of
the following:

o Try again to fix the error.

o Attempt to fix a different error.

o Go to the next step.

6. To return to the Detail Log to review the list of outstanding errors, confirm that all errors have been
fixed, or exit the DataMigrator wizard, click Cancel on the Log Details page.

The Detail Log reopens.

7. Do one or more of the following:

n Review the list of outstanding errors and continue to attempt to fix them.

n ClickWrite Log Into Worksheet (last column) to update the log entries in the spreadsheet.

n Click Finish to exit the DataMigrator wizard.

8. Save the spreadsheet if you want to save the changes.
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Downloading and Updating Validation Values
When a user is providing information for an entity, many of the fields the user must complete offer a
selection of values from which the user must choose. These values are validation values.

The analyst and administrator can use the DataMigrator to download and update the validation values
used by HP APM entities.

Tip: Validations are created by the HP APM instance administrator.

To download and update validation values, do the following:

1. Open the DataMigrator wizard and connect to the PPM Server. For instructions, see "Connecting
to the PPM Center Server using the DataMigratorWizard (for Validation-Related Tasks)" below.

2. Download all the validation values, a selection of validation values, or only the validation values
you need to update. For instructions, see "Downloading Validation Values" on page 52.

3. If necessary, use the DataMigrator to update the downloaded validation values. For instructions,
see "Updating Validation Values" on page 54.

Connecting to the PPM Center Server using the Data
Migrator Wizard (for Validation-Related Tasks)
You select the options you use to download and update validation values from the Select an Action to
Perform dialog box that opens after you have connected to the PPM Server using the DataMigrator
wizard.

To open the DataMigrator wizard, connect to the PPM Server, and access the Select an Action to
Perform dialog box for validation-related tasks:

1. In Microsoft Excel, do one of the following:

n If you are downloading validation values, open a blank spreadsheet or create your own
spreadsheet. To do this, you follow the instructions for creating a spreadsheet for downloading
entities in "Creating an Import Spreadsheet" on page 24 with the following exceptions:

o The spreadsheet template for validations has only one default row, the row of column
headings.

o Instead of selectingRequest from the Entities menu, you select Validation Value (see
step 2 in this section).

o Only a subset of the AdvancedOptions fields are available for validation values.
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n If you are updating validation values, open the spreadsheet containing the data you are
updating. (For information about this spreadsheet, see "Updating Validation Values" on
page 54.)

2. On theAdd-Ins tab, select Entities > Validation Value from thePPM Data Migrator group.

The DataMigrator wizard opens.

3. From the Select Server drop-down list, select the name of the PPM Server that contains the
validation data you want to download or update. If the list is empty, see "Configuring the
Connection to a PPM Server" on page 22.

Note: TheSelect Server drop-down list contains the names of the last ten PPM Servers that
you accessed and for which you saved the connection information.

4. Click Connect.

5. When the PPM Server is connected, themessage Connected is displayed at the bottom of the
dialog box, and the Next button becomes available.

6. Click Next.

The Select an Action to Perform dialog box opens.
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7. For instructions for performing the tasks you can perform from the options in this dialog box, see
one of the following sections:

n "Downloading Validation Values" below (the Download Records option)

n "Updating Validation Values" on page 54 (the Update Records option)

Downloading Validation Values
If you want a record of the validation values used by HP APM or if you want to create a spreadsheet of
validation values that you can update and import with the DataMigrator, you need to download the
validations and their values.

Note: If your PPM Center instance supports multiple languages, the validation values you
download will include a pair of Meaning and Description columns for each language supported by
your system. For example, columns for a PPM Center instance that supports English and Spanish
will include columns titledMeaning (English), Description (English), Meaning (Spanish), and
Description (Spanish). All other columns are language independent.

To download validation values:
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1. Connect to the PPM Server using the DataMigrator wizard. For instructions, see "Connecting
to the PPM Center Server using the DataMigratorWizard (for Validation-Related Tasks)" on
page 50.

The Select an Action to Perform dialog box opens.

2. In theSelect an Action to Perform dialog box, select Download Records.

The DownloadOptions dialog box opens.

3. In theDownload Options dialog box, click Advanced Options to configure the download
settings. To cancel any changes youmake to the AdvancedOptions dialog box, click Cancel.

n In theHighlight Success field in theColoring box, select the color that the DataMigrator
uses in the spreadsheet to highlight the validations that were downloaded successfully.

o To change the color, click theColor button and select a new color.

o To define custom colors, click Define Custom Colors in theColor dialog box.

By default, validations that downloaded successfully are not highlighted.

n In theConcurrency box, select themaximum number of concurrent threads—up to 20—from
theMaximum Threads drop-down list. When you configure this field, consider the
performance objectives for your environment. Setting this field to a higher number could
improve throughput but might also put more of a load on your PPM Server. The default value is
5.

n In theData Filtering box, you can limit the validations that are displayed in the Download
Options dialog box. To do so, type the word by which the validations are to be filtered in the
Show validations when name contains field. For example, typeAPM to display only the
validations that contain APM in their name.

When you are finished configuring the advanced options, click OK to save your changes and
close the dialog box.

4. In theDownload Options dialog box, select or clear the checkboxes as necessary so only the
validations you want to download are selected. The DownloadOptions dialog box lists all the
validations configured for your implementation of HP APM or a filtered list of validations, if you
configured the Data Filtering setting in the previous step.

To sort the list, click the heading of the column you want to sort by. To clear all the selected
checkboxes, click Uncheck All. To select all the checkboxes, click Check All.

5. Click Next.

Caution: If you click Cancel before the process is completed, only some of the datamight be
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downloaded. For more information, see "Cancelling a Download, Create, or Update Process"
on page 46.

The DataMigrator downloads the selected validations and their values. This could take several
minutes. When the process is complete, themessage <N> of <N> is displayed (where <N>
represents the number of validations). This indicates the number of validations—out of the total
number of validations that you selected for download—that were downloaded.

6. Click Finish.

The DataMigrator closes.

7. Save the spreadsheet.

Updating Validation Values
If you need to update validation values, you start by making your changes to a spreadsheet of
validation values that you download using the DataMigrator, and then you import the updates into HP
APMwith the DataMigrator. You can use the DataMigrator to update changes to validation values that
include the following:

l Changing the values in a validation

l Changing the sequence of values within a validation

l Adding values to a validation

l Disabling and enabling values

Caution:Whenmaking changes to validation values, do not change the values in the Validation
ID and Validation Name fields. These values are used by the DataMigrator to identify the
validation.

Tip: Validations are created by the HP APM instance administrator.

To update validation values:

1. Download the validations containing the values you want to update. For instructions for
downloading validation values, see "Downloading Validation Values" on page 52.

2. Make the necessary changes to the spreadsheet, save it, and leave it open.

3. Access the Select an Action to Perform dialog box. For instructions, see "Connecting to the PPM
Center Server using the DataMigratorWizard (for Validation-Related Tasks)" on page 50.
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4. Click theUpdate Records icon to update validation values.

TheMap Attributes to Columns dialog box opens.

5. Review the preconfigured entries in this dialog box. If you need tomake changes, go to the next
step. If the default settings are correct, go to step 12.

6. To the right of theColumn Header Row field, click the selection icon ( ).

The Select a Row dialog box opens.

7. In the spreadsheet, click a cell in the row that contains the column headings.

The identifier for the cell you clicked is entered in thePlease select the row for field headers
field in the Select a Row dialog box.

8. Click OK.

The Select a Row dialog box closes, and the number of the selected row is displayed in the
ColumnHeader Row field. The headings from the row you selected—with the letter identifying the
column they are in as the prefix—are added to the options available in the Validation ID list. The
headings are also displayed in the Validation Name list and the AttributeMapping Spreadsheet
list.

9. From theValidation ID list, select the column that contains the IDs that were assigned to the
validations by PPMCenter when they were created.

10. From theValidation Name list, select the column that contains the names of the validations.

11. Manually map any unmapped columns in the Attribute Mapping Spreadsheet list to the
attributes in theUser Data list.

You are only required tomap the columns in which the values have changed.

For additional information about mapping columns to attributes, see step 9.

12. Click Next.

The UploadOptions dialog box opens showing the first row number of each validation in the
spreadsheet, the validation name, validation ID, and whether or not the validation is valid.

13. Select or clear the checkboxes as necessary so only the validations that you want to update are
selected. To clear the selected checkboxes, click Uncheck All. To select the checkboxes for all
the fields, click Check All.

14. Click Advanced Options to configure additional settings. To cancel any changes youmake to the
AdvancedOptions dialog box, click Cancel.
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n In theColoring box, select the colors from theHighlight Success andHighlight Failed
fields that the DataMigrator uses in the spreadsheet to show the status of the entities after the
update is completed.

o To change a color, click theColor button and select a new color.

o To define custom colors, click Define Custom Colors in the Color dialog box.

By default, validations that are updated successfully are highlighted in light green and
validations that were not updated are highlighted in light red.

n In theConcurrency box, select themaximum number of concurrent threads—up to 20—from
theMaximum Threads drop-down list. When you configure this field, consider the
performance objectives for your environment. Setting this field to a higher number could
improve throughput but might also put more of a load on your PPM Server. The default value is
5.

Note: The settings in theData Handling box are ignored when you update validations.

When you are finished, click OK to save your changes and close the dialog box.

15. Click Next.

Caution: If you click Cancel before the process is completed, only some of the datamight be
updated. For more information, see "Cancelling a Download, Create, or Update Process" on
page 46.

The DataMigrator attempts to validate and update the selected validations. This could take
several minutes. When the process is complete, themessage Update Validations... Done!
and a summary of the results of the update are displayed.

16. Review the summary information. Towards the top of the dialog box, <N> of <N> is displayed
(where <N> represents the number of validations). This indicates the number of validations—out
of the total number of validations you selected for updating—that were processed (successfully or
not).

Statements such as the followingmight also be displayed:

n <N> records successfully updated. <N> validations were updated successfully.

n <N> records failed to update. <N> validations were not updated.

n <N> records pass pre-validation. <N> validations were validated.

n <N> records do not pass pre-validation. <N> validations contained errors and were not
validated.
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17. If the update was not successful, click View Log to view information about any errors that were
reported. For instructions for using the information in the log file to fix the errors, see "Viewing the
Detail Log and Fixing Logged Errors" on page 48.

18. When all of the validations are updated successfully, click Finish.

The DataMigrator closes.

19. Save the spreadsheet.

Viewing, Exporting, and Importing Mapping
Relationships
You can use the DataMigrator mapping tools to import column-to-field or attributemapping
relationships from one spreadsheet to another and to view themapping in a spreadsheet in XML code.

Viewing Mapping Relationships
You can view the column-to-field or attributemapping relationships configured for spreadsheets that
you downloaded using DataMigrator and spreadsheets you used to create or update entity data or
update validation values. Themapping relationships are displayed in XML format.

Tip: To save or print the XML, use the Export Mapping option to create an XML file. (See
"Exporting and ImportingMapping Relationships " on the next page.)

To view themapping relationships in a spreadsheet:

1. Start Microsoft Excel.

2. Open the spreadsheet for which you want to view themapping relationships.

3. On theAdd-Ins tab, select Tools > View Mapping from thePPM Data Migrator group.
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A window opens showing the XML.

The following figure shows the first page of XML for themapping of a spreadsheet created for
application entities.

Exporting and Importing Mapping Relationships
You can reuse column-to-field or attributemapping relationships from spreadsheets that you
downloaded using DataMigrator or spreadsheets that you used to create or update entity data or to
update validation values. You do this by exporting themapping relationships from a "used"
spreadsheet—a spreadsheet in which themapping relationships were already configured—into a new
spreadsheet.

To export mapping relationships and import them into a new spreadsheet:

1. Start Microsoft Excel.

2. Export themapping file:
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a. Open the spreadsheet that contains themappings you want to export.

b. On theAdd-Ins tab, select Tools > Export Mapping from thePPM Data Migrator group.

The Save current setting to file dialog box opens.

c. Configure the settings in theSave current setting to file dialog box:

i. Browse to the folder in which you want to save the exported data file.

ii. In the File name field, enter a name for the file into which the data is to be exported.

iii. Make note of the folder and file name.

iv. Click Save.

3. Create the new spreadsheet:

a. In Microsoft Excel, open a new spreadsheet.

b. From the original spreadsheet, copy the rows that contain the column headings (for entities
and validation values) and tokens (for entities only)—and any other rows you want to reuse—
and paste them into the new spreadsheet.

c. Save the new spreadsheet.

4. With the new spreadsheet still open, import the exportedmappings:
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a. On theAdd-Ins tab, select Tools > Import Mapping from thePPM Data Migrator group.

b. Click Yes to acknowledge themessage that is displayed.

c. In the Load setting from file dialog box, locate and select the file containing the exported
data.

d. Click Open.

A message confirming that themapping information was loaded successfully is displayed.

e. Click OK.

f. Save the new spreadsheet.

5. To see the importedmappings, view themappings following the instructions in "ViewingMapping
Relationships" on page 57.

Reinstalling the Data Migrator
If you attempt to install the DataMigrator and the installation fails or if you need to reinstall the Data
Migrator, follow the steps in the following sections sequentially:

1. "Uninstalling the DataMigrator" on the next page

2. "Reinstalling the DataMigrator" on the next page

3. "Clearing the Cache" on the next page

Note: If you are installing a new version of the DataMigrator, follow the instructions in "Installing
the DataMigrator" on page 21. You do not need to uninstall it first.
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Uninstalling the Data Migrator
To remove the current installation of the DataMigrator, use the remove programs option in the Control
Panel to uninstall PPMDataMigrator.

Reinstalling the Data Migrator
After uninstalling the DataMigrator, follow the instructions in "Installing the DataMigrator" on page 21
to reinstall it.

l If the installation is successful, return to earlier sections of this chapter to perform any necessary
tasks.

l If the installation fails, go to "Clearing the Cache" below.

Clearing the Cache
To clear the cache and reinstall the DataMigrator:

1. Launch the commandwindow (cmd.exe).

2. Change the directory in the command prompt to one of the following directories.

n C:\Program Files\Microsoft SDKs\Windows\v7.0A\bin

n C:\Program Files\Microsoft SDKs\Windows\v6.0A\bin

n C:\Program Files\Microsoft Visual Studio 8\SDK\v2.0\bin

Note: The SDK-related directory you have on your computer depends on your computer's
configuration. The version of the SDK softwaremight vary from the version noted here.

If you do not have any of these directories on your computer, download and install the .NET
Framework Software Development Kit (SDK) from theMicrosoft Download Center at
http://www.microsoft.com/download/.

3. At the command prompt for the bin directory noted in step 2, type the following command to clear
the cache:

mage -cc

A message telling you the cache was cleared is displayed.

4. Reinstall the DataMigrator following the instructions in "Installing the DataMigrator" on page 21.
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Chapter 4: Surveys and Additional Application
Data Collection

Overview of Surveys and Application Data Collection
After you have collected and entered your application information, youmight need to conduct a survey
for the application and collect ratings from its users—or youmight need to collect additional information
about the application itself.

Conducting Surveys
You can use surveys to collect ratings data about an application from one or more users. Rather than
entering arbitrary data, you can send a survey to an application's users and base the application ratings
on the survey responses.

Complete the following tasks to collect and enter ratings data for an application:

1. Generate the survey registration and send invitations to its respondents. For instructions, see
"Generating a Survey" below.

2. Monitor the individual survey responses. For instructions, see "Monitoring Individual Survey
Responses" on page 65.

3. View the Survey Results report to evaluate the cumulative survey responses. For instructions,
see "Viewing the Survey Results Report" on page 66.

4. Enter the results of the survey into the application entity. For instructions, see "Entering Survey
Response Data into the Application Entity" on page 66.

5. Identify the applications that require additional information. For instructions, see "Identifying the
Applications that Require Additional Information" on page 69.

6. Send requests whenmore information is needed. For instructions, see "Sending a Request for
More Information" on page 71.

Generating a Survey
Before you send out surveys, you create the survey registration entity and select the type of ratings for
which you want to collect data. You then send the survey to the designated respondents.
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Note: Each invitation sent from a survey registration is a survey with its own request number.

To create the survey registration:

1. From themenu bar, select Open > Application Portfolio > Create Entities.

2. In theActivities area, click Survey Registration.

The Create New APM - Survey Registration page opens.

3. In theSummary section, type a name for the survey in theSurvey Name field.

Tip: Make note of the name you assigned to the survey registration. You will need it later.

4. In theDetails section, type or select the type of survey that you want to send from theSurvey
Template list. The survey template determines the type of ratings data that is collected.

n Business Survey. Business-related ratings for the application, data, vendor, value, and risk.

n General Survey (Full). Application-related ratings for the application, data, vendor, value, and
risk.

n Technical Survey. Technical-related ratings for the application, data, vendor, and risk.

Tip: To view the specific fields for which data can be collected, select a survey template and
click (click here) in theView Preview field.

For descriptions of the fields in the templates, see the descriptions of the application entity
fields in "Application" on page 101.

5. In the Target Completion Date field, type or select the date by which the survey must be
completed.

6. In the List of Applications & Respondents table, click Edit.

The label on the Edit button changes to View and additional buttons are displayed.

7. Add the applications to be surveyed and the users you want to designate as respondents. Refer to
the following instructions and "Table 4-1. Table icons" on the next page for more information.
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Button or Icon Description

Click to view the completed table.

Click to export the table to aMicrosoft Excel spreadsheet.

Click to add a row to the table.

Click to delete the selected rows.

Click to copy the selected rows.

Click to paste the copied rows beneath the selected row.

Click to move the selected row up.

Click to move the selected row down.

Table 4-1. Table icons

Tip: To select a row, click a cell within the row. To select multiple rows, press and hold the
Shift key as you click in additional cells.

a. Click theAdd Row icon ( ).

A row with empty Application Name and Respondents cells is added to the table.

b. In the empty cell in theApplication Name column, type or select the name of the application
for which you are conducting the survey.

Tip: As you add each application, make note of the application's ID number. You will
need this information later.

c. In the empty cell in theRespondents column, type or select the name of one or more survey
respondents (HP APM users you want to complete the survey).

d. Repeat step a through step c as necessary.

8. To save the survey registration, click Submit.

The Request Creation Confirmed page opens, and the request number assigned to the survey
registration is displayed in the Request # field.
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Tip: Make note of the request number assigned to the survey registration. You will need it
later.

To send the survey invitation to the respondents:

1. In theRequest # field on the Request Creation Confirmed page, click the request number
assigned to the survey that you just created.

The APM - Survey Registration - <Request_Number> page opens.

2. From the toobar, click Send Surveys.

The List of Surveys section is generated from the List of Applications & Respondents section
and the surveys configured for this survey registration are listed.

An email is sent to each of the respondents inviting them to participate in the survey.

Note: By default, every three days an email is resent to remind the survey respondents to
complete the survey. If a Target Completion Date is set for the survey, the reminder is sent
every three days until that date is met.

Monitoring Individual Survey Responses
After you send the invitations to the survey respondents, you can view the status of the survey
registration and the completion percentage by respondent.

1. Open the survey registration entity.

a. From themenu bar, select Dashboard > Shared > APM Analyst > Front Page.

The Front Page PPMDashboard page opens.

b. In theMy Survey Requests portlet, click the name of the survey registration entity you want
to view.

The APM - Survey Registration - <Request_Number> page opens.

2. Open theReferences > Requests section towards the bottom of the page.

Each respondent from whom a response was requested is listed as a separate survey by the
survey request number (Req #). The list also includes the name of the survey respondent
(Assigned User), the name of the survey (Description), the type of survey (Request Type), the
status of the survey (Status), the percentage of the survey that has been completed (%
Complete), the relationship of the survey request to the survey registration (Relationship), and the
description of the survey registration with request numbers (Relationship Details).
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3. From the list of surveys in theRequests section, you can do the following:

n Click a request number to display a survey. If the respondent has saved answers to any of the
questions, you can view the responses. While you can view a summary of rating responses in
the Survey Results report (see "Viewing the Survey Results Report" below), you can see a
respondent's comments when you view the surveys individually.

n Change the relationship between a survey and the survey registration to which it is related.

Viewing the Survey Results Report
Tomonitor the overall response rate to the survey and to view a summary of the current responses,
generate the Survey Results report:

1. From themenu bar, select Open > Application Portfolio > Reports > Survey Results.

The Submit Report: APM Survey Results Report page opens.

2. In the Survey Request list, type or select the name of the survey registration entity for which you
want to view current responses.

3. Configure additional report parameters as necessary. For descriptions of the other report
parameters you can configure, see "Table C-3. Survey Results report filter fields" on page 192.

4. In the Scheduling and Output Options section, select Run Report Immediately.

5. Click Submit.

The Survey Results report is generated and opens.

6. Analyze the results of the report to determine if the number of responses is satisfactory or if you
need to wait for more responses.

For more information about the Survey Results report, see "Survey Results Report" on page 191.

Entering Survey Response Data into the Application Entity
If you are satisfied with the response rate to the survey based on individual survey completion
percentages or on the results shown in the Survey Results report, enter comments and notes from
each survey into theNotes section of the application entity and enter the ratings data into theRatings
section of the application entity. For instructions, see:

l "Collecting and Entering Comments and Notes" on the next page

l "Collecting and Entering Ratings Data" on page 68
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Collecting and Entering Comments and Notes

To collect and enter comments and notes:

1. Open an application entity for which you generated a survey:

a. From themenu bar, select Open > Application Portfolio > Search Entities.

The Search Entities page opens.

b. In theEntities area, click Application.

The Search: APM - Application page opens.

c. Do one of the following:

o In theView Details for Entity # field, type the entity number and click Go.

o In theSearch Information section, enter search criteria for the application and click
Search. The Request Search Results page opens.

In theApplication No column, click the number of the application for which you need
more data.

The APM - Application - <Entity Number> page opens.

d. On theRequest Search Results page, click the number assigned to the application entity to
open it.

The APM - Application - <Entity Number> page opens.

2. In a window separate from the application entity, open the survey registration from which you sent
the surveys:

a. From themenu bar, display the following path: Dashboard > Shared > APM Analyst >
Front Page.

b. In the displayed path, right click Front Page and select Open in New Window from the
menu that is displayed.

The Front Page PPMDashboard page opens in a new window.

c. In theMy Survey Requests portlet, click the name of the survey registration entity for which
you want to collect and enter comments.

The APM - Survey Registration -<Request_Number> page opens.

3. In theReferences section towards the bottom of the page, open the Requests section.
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4. Click the request number of a survey.

The survey opens in a new window.

5. Open theComments section (a subsection of the details section) and theNotes section.

6. Copy any comments and notes from the survey to theNotes section of the application.

Tip: Instead of copying the comments and notes directly into the application entity, you can
copy the comments and notes from one or all surveys to a file and attach the file as a
reference to the application.

7. Repeat step 4 through step 6 for each survey.

8. In the application entity, click Save.

Collecting and Entering Ratings Data

To collect and enter ratings data:

1. Open theSurvey Results report for the application for which you want to collect ratings data.

a. From themenu bar, select Open > Reports > View Reports.

b. Enter search criteria to filter the number of reports returned by the search and click Search.

c. In theReport # column in theSearch Results: Reports table, click the number of the report
to open.

The selected report opens.

2. From theSurvey Results report, determine how you want to calculate the aggregated values for
each rating field. For example, you could average the values for each field or use themedian value
of each field.

3. Open the application entity for which you generated the Survey Results report and enter values in
the rating fields.

a. From themenu bar, select Open > Application Portfolio > Search Entities.

b. In theEntities area, click Application.

c. Enter search criteria to filter the number of applications returned by the search and click
Search.

d. In theApplication No column in theRequest Search Results table, click the number of the
application entity for which you want to enter ratings data.
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e. In the application entity, go to theRating section, enter the calculated values from step 2.

f. Click Save.

Requesting Additional Application Information
If you need to collect additional information about an application, you can send a request to a different
user (called a respondent) to enter the information. Youmight want to do this if, for example, the owner
of the application went on vacation before responding to the survey invitation or the owner neededmore
time for investigation.

The following sections describe the tasks you perform to identify the applications that needmore data
and to send a request for the data:

l "Identifying the Applications that Require Additional Information" below

l "Sending a Request for More Information" on page 71

Identifying the Applications that Require Additional
Information
If you already know the applications for which you want to collect additional information, you can skip
this task.

To identify the applications that require additional information, you create an application set that
contains the applications you want to investigate, and then run two reports on those applications.

1. Identify the applications to include in the application set:

a. From themenu bar, select Open > Application Portfolio > Search Entities.

b. In the Entities area, click Application.

The Search: APM - Application page opens.

c. Enter the filter criteria. For example, in theContacts section, type or select the name of a user
from the Technical Owner list to find all applications for which the user has technical
authority.

d. Click Search.

The Request Search Results page opens.

e. Make note of the application numbers from the Application No column and names from the
Title column that matched the filter criteria or export the results to aMicrosoft Excel
spreadsheet.
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2. Create an application set that contains an application or group of applications you are
investigating. You use this application set later to view a report that shows how complete the data
entry is for the set of applications. For example, youmight want to view data entered for the
applications owned by a specific technical owner. You can create the application set using the
dynamic graphing feature or from themenu bar.

To create an application set using dynamic graphing, see "Dynamic Graphing" on page 76.

To create an application set from themenu bar:

a. From themenu bar, select Open > Application Portfolio > Create Entities.

The Create New Entity page opens.

b. In theGrouping area, click Application Set.

The Create New APM - Application Set page opens.

c. In theSet Name field in theSummary section, type a name for the application set.

d. In theScope section, open the List of Applications section and click Edit.

The label on the Edit button changes to View and additional buttons are displayed.

e. Add applications to the application set. For more information, refer to the following steps and
"Table 4-1. Table icons" on page 64 for descriptions of the icons.

i. Click theAdd Row icon ( ).

A row with an empty cell in the Name column is added to the table.

ii. In the empty cell, type or select the name of an application you want to add to the
application set.

iii. Repeat step i and step ii as necessary to add additional applications to the set.

f. Click Submit to save the application set.

3. Run theEntity Coverage Summary report for the application set you created in step 2. The
Entity Coverage Summary report shows a summary of attributes and how complete the data entry
is for the select applications or application set.

a. From themenu bar, select Open > Application Portfolio > Reports > Coverage
Summary.

The Submit Report: APM Entity Coverage Summary Report page opens.

b. From theEntity Type list, select Application.
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c. In theApplication Set list, type or select the application set you created in step 2.

d. Configure additional report parameters as necessary. For descriptions of the report
parameters, see "Table C-1. Entity Coverage Summary report filter fields" on page 188.

e. In theScheduling and Output Options section, select Run Report Immediately.

f. Click Submit.

The Entity Coverage Summary report is generated and opens.

4. Analyze the results in theEntity Coverage Summary report to determine if the set of
applications it covers require additional data. For example, view theCoverage % column for each
attribute and determine if the amount of data entered is satisfactory. If theCoverage % is too low,
run theEntity Detail report as described in step 5 to determine which applications aremissing
data.

5. If necessary, run theEntity Detail report on the applications in the application set (using the
application numbers you noted in step 1). The Entity Detail report shows selected information
about one or more applications.

a. From themenu bar, select Open > Application Portfolio > Reports > Entity Detail.

The Submit Report: APM Entity Detail Report dialog opens.

b. In theEntity Request Type list, type or select Application.

c. In theEntity Numbers list, type or select the application numbers you noted in step 1.

d. Configure additional report parameters as necessary. For descriptions of the report
parameters, see "Table C-1. Entity Coverage Summary report filter fields" on page 188.

Note: Youmight want to select No for theHide Prompts for Empty Fields option so
you can visually verify in the report that an attribute contains no data.

e. In theScheduling and Output Options section, select Run Report Immediately.

f. Click Submit.

The Entity Detail report is generated and opens.

6. Analyze the results in theEntity Detail report to identify the applications that aremissing data.

Sending a Request for More Information
After determining the applications for which additional data is necessary, send requests for more
information:
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1. Open an application entity for which additional data is needed. For instructions for opening an
application entity, see step 1 in "Collecting and Entering Comments and Notes" on page 67.

2. From the toobar, click Need More Info.

The APM - Application <Request_Number>: NeedMore Info page opens.

3. In theRespondent list, select or type the name of the user from whom you want to collect
additional data about the application.

Caution: By assigning a user as a respondent, you are giving that user the ability to view and
edit all sections of the application.

4. In theRespondent Note field, type amessage to be included in the email that is automatically
sent to the respondent. For example, youmight want to specify the fields in the application entity
that you need completed.

5. Click Continue Workflow Action.

The application entity opens, and an email that requests more information about the application is
sent to the respondent.

6. For each application that requires additional information, repeat step 1 through step 5.
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Chapter 5: Application Analysis

Application Analysis Overview
After data has been collected and entered for applications and other entities in your application portfolio,
you can analyze and assess your application portfolio using the following tools:

l "Application Sets" below. Group applications for comparative analysis in portlets, reports, dynamic
graphing, and the Request Browser.

l "PPM Dashboard and PPMDashboard Pages" below. Group and display portlets for a real-time
view of important information about your application portfolio.

l "Portlets" on page 75. Display and define standard and customizable real-time views of your
application portfolio data.

l "Reports" on page 76. Display status and statistics based on your application portfolio data.

l "Dynamic Graphing" on page 76. Displays graphical relationships between applications and
between processes.

l "Request Browser" on page 96. Hierarchically groups and displays information for a real-time view
of selected entity information.

Application Sets
When you want to compare a specific set of applications, you can first configure an application set
containing the necessary applications. You can use application sets in workstream entities, the Entity
Coverage report, the Request Browser, dynamic graphing, and in the following portlets: Application
Health Breakdown, Application Portfolio Size, Application Value Assessment, List of Applications
(Analyst), and TCOSummary. For more information about application sets, see "Application Set " on
page 130.

PPM Dashboard and PPM Dashboard Pages
The PPMDashboard, located on themenu bar, provides the core of the standard user interface. It is a
real-timeWeb page view into your application portfolio. By viewing pages on the PPMDashboard, you
can obtain accurate, up-to-the-minute status information about your applications and deliverables. With
the PPMDashboard, teams always know their current status. Managers gain real-time insight into the
applications they manage. Executives can view transformation proposals from an IT value perspective
at a high level, which helps to ensure alignment with the organization's overall strategic direction.
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PPMDashboard pages, accessed from the PPMDashboard, organize application data. You can
devote one PPMDashboard page to transformation proposal information and another to application-
related data. How you organize the data is entirely up to you.

The following sections provide information about the PPMDashboard and PPMDashboard pages:

l "Types of PPM Dashboard Pages" below

l "Personalizing andManaging the PPMDashboard and PPMDashboard Pages" on the next page

Types of PPM Dashboard Pages
The following PPMDashboard pages are available with HP Application Portfolio Management (HP
APM):

l Shared PPM Dashboard pages. Shared PPMDashboard pages are preconfigured PPM
Dashboard pages provided by HP APM or configured by the HP APM administrator. They aremade
available to one or many users. You cannot edit a shared PPMDashboard page or the portlets it
contains.

HP APM supplies several shared PPMDashboard pages for analysts: Front Page, Portfolio View,
and Applications. These pages contain portlets that provide the type of information that is typically
used by an analyst.

Note: Shared PPMDashboard pages are also known as HP-supplied PPM Dashboard pages.

l Private PPM Dashboard pages. You create and configure your private PPM Dashboard pages.
You can add configurable portlets to a private page, move the pages up or down in the list of pages,
and delete them. You can also configure the information displayed in the portlets that you add to
private pages.

The default PPM Dashboard page is the first PPM Dashboard page you see when you log on to HP
APM. For users who have personalized their PPM Dashboard, it is the first private page on the list; for
new users, it is the first shared page on the list.

For descriptions of the PPMDashboard pages and portlets provided for analysts and for descriptions of
the configurable portlets that you can add to a private PPM Dashboard page, see "PPM Dashboard
Pages and Portlets" on page 160.

If you are also assigned the user role, HP APM provides you with the shared PPMDashboard pages for
users. For descriptions of the shared PPMDashboard pages for users, see theHP Application Portfolio
Management User's Guide.
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Personalizing and Managing the PPM Dashboard and PPM
Dashboard Pages
You can personalize the PPMDashboard by adding PPMDashboard pages with configurable portlets
to it and then configuring the order in which the portlets are displayed and the types of information they
provide. For instructions for creating andmaintaining PPMDashboard pages, see theCreating Portlets
andModules guide. For information about personalizing the PPM Dashboard, see the Project and
Portfolio Management Center (PPM Center)Getting Started guide.

You can navigate between the different PPM Dashboard pages, export PPM Dashboard pages to PDF
files, and create a list of frequently visited   PPM Dashboard pages in theMy Links list. For
instructions, see the PPM CenterGetting Started guide.

Portlets
Portlets are displayed on PPMDashboard pages. They display real-time information relevant to your
role as an analyst.

Two types of portlets are available in HP APM: shared and configurable.

l Shared portlets. Shared portlets are preconfigured portlets provided by HP APM or configured by
an HP APM analyst or administrator. They are predefined versions of the configurable portlets.
Shared portlets are displayed on the shared PPMDashboard pages. You can edit shared portlets
only if you first add them to a private Dashboard page.

Shared portlets for analysts contain information related to application portfolio data, workstreams,
transformation proposals, and survey requests.

Note: Shared portlets are also known as HP-supplied portlets.

l Configurable portlets. HP APM provides several configurable portlets that you can add to your
private PPM Dashboard pages and personalize. Configurable portlets are highly customizable—by
setting filters, you can configure the data that is displayed.

Configurable portlets for analysts contain information related to application portfolio data,
applications, workstreams, transformation proposals, survey requests, and surveys to which the
analyst has been asked to respond.

For descriptions of the shared and configurable portlets provided for an analyst, see the online help and
"PPM Dashboard Pages and Portlets" on page 160.

If you are also assigned the user role, HP APM also provides you with the shared and configurable
portlets for users. For descriptions of the shared and configurable portlets for users, see theHP
Application Portfolio Management User's Guide.

For instructions for personalizing the configurable portlets, see the PPMCenterGetting Started guide.
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Portlet Definitions
HP APM analysts and administrators can create portlet definitions. Portlet definitions define the look
and feel of a portlet. Portlet definitions can include such information as the type of portlet, its data
source, display options such as which labels and columns to display, its layout, which users and
groups have access to the portlet, and definitions of the filter fields. You can createmultiple portlets
based on a single portlet definition.

Note:When you create a portlet definition, youmust assign it a data source. If you need a new
data source, request it from the HP APM administrator.

For instructions for creating andmaintaining portlet definitions and portlets, see theCreating Portlets
andModules guide.

Reports
HP APM provides several predefined reports that allow you to view the current status of your
application portfolio data in aWeb browser. After you select a report to view, you can set filters that
determine the data that is to be included in the report.

For a list of the HP APM reports and their descriptions, see "Reports" on page 187.

Tip: View the HP APM reports from theOpen > Application Portfolio > Reportsmenu.

For instructions for running andmanaging reports, see theReports Guide and Reference.

Dynamic Graphing
Dynamic graphing provides the ability to view graphical relationships between applications and
between processes. Dynamic graphing also allows you to transform a graph of processes into a graph
of applications that support the processes and to create an application set from a group of displayed
applications.

Installing Dynamic Graphing
The first time you start dynamic graphing, you are prompted to install theMicrosoft Silverlight add-on
for Microsoft Internet Explorer or the Silverlight Plug-In for Mozilla Firefox. Follow the prompts in the
dialog boxes that are displayed to complete the installation.
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Starting Dynamic Graphing
The way you start dynamic graphing depends on the entity relationships you want to view.

Do one of the following to start dynamic graphing:

l To view the graphical relationships between the applications in an application set or between related
processes:

a. From themenu bar, select Open > Application Portfolio > Analyze > Dynamic Graphing.

The dynamic graphing page opens.

b. Do one of the following:

o To view the relationships between the applications in an application set, see "Viewing
Application Relationships" on the next page.

o To view the relationships between related processes, see "Viewing Process Relationships"
on page 81.

o To use dynamic graphing to perform additional procedures, see the procedures described in
other "Dynamic Graphing" on the previous page sections.

l To start dynamic graphing so you can view graphical relationships between the entities you select
from the results of a search or between the entities you select from an entity group:

a. Do one of the following:

o Search for all application or process entities or only the specific application or process
entities you want to view. For information about searching for entities, see "Searching
Entities" on page 17.

o Create a group of application or process entities. For information about using the Request
Browser to create an entity group, see "Request Browser" on page 96.

b. From the results displayed on theRequest Search Results page or in theRequest Browse
Results section on the Browse <Entity_Type> Requests page, select one or more application
or process entities.

Note: If you select entities of more than one type, all entities are ignored unless one of the
entity types is application—then only the application entities are displayed. If you select
entities of a type other than application or process, nothing is displayed.

The Dynamic Graphing button is enabled.

HP Application Portfolio Management Analyst’s Guide
Chapter 5: Application Analysis

HP Project and Portfolio Management Center (9.30) Page 77 of 194



c. Click Dynamic Graphing.

The dynamic graphing page opens and the selected entities are displayed.

Tip: To quickly zoom in and out of a displayed graph, use the scroll wheel on themouse.

To reposition the graph, drag the cursor on the graph andmove it to the desired position.

Viewing Application Relationships
Use dynamic graphing to view application relationships. You can view the following relationships:

l The applications in an application set.

l The number of processes an application supports.

l The dependencies between applications.

l The dependencies an application set has between all applications, including applications not
included in the application set.

l A combination of the number of processes supported and application dependencies (either for the
applications in an application set or for all applications).

Opening an Application Set

To open an application set in dynamic graphing and view the applications it contains:

Note: The application set must be created before it can be opened in dynamic graphing.

1. Start dynamic graphing. For instructions, see "Starting Dynamic Graphing" on the previous page.

2. Click theOpen icon ( ).

3. Click Open Application Set.

The application set selectionmenu displays the eight most recently created application sets. If the
application set you want to open is not displayed, selectMore to view additional applications sets.

4. Select an application set and click OK.

Applications are represented by rounded blue rectangles in the graph.

Figure 5-1. View of applications in an application set
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Viewing the Number of Processes an Application Supports

To view the number of processes supported by an application:

1. Open an application set or one or more applications in dynamic graphing. For instructions, see
"Starting Dynamic Graphing" on page 77.

2. Click theGraph Options icon ( ).

3. Select Load Supported Processes.

The size of the rounded rectangles change proportionally, based on the number of processes
supported. The number of processes supported is displayed in the lower right corner of the rounded
rectangle.

Figure 5-2. View of an application set with dependent processes

HP Application Portfolio Management Analyst’s Guide
Chapter 5: Application Analysis

HP Project and Portfolio Management Center (9.30) Page 79 of 194



Viewing Application Dependencies

You can view application dependencies between the displayed applications or you can view all directly
related application dependencies of an application set (this includes dependencies to applications that
are not part of the application set).

Viewing Dependencies Between Applications

To view dependencies between applications:

1. Open an application set or more than one application in dynamic graphing. For instructions, see
"Starting Dynamic Graphing" on page 77.

2. Click theGraph Options icon ( ).

3. Select Show Upstream/Downstream.

Figure 5-3. Hierarchical view of an application set with upstream/downstream dependencies

Viewing Dependencies Between Directly Related Applications

You can view dependencies that applications have between directly related applications in the
application portfolio. For example, if an application set contains application A, application A depends on
application B, and application B depends on application C, showing the direct dependencies of the
application set displays application A and B; application C is not directly related to application A.

To view dependencies that applications have between directly related applications in the application
portfolio:

1. Open an application set or more than one application. For instructions, see "Starting Dynamic
Graphing" on page 77.
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2. Click theGraph Options icon ( ).

3. Select Show Direct Dependencies.

The original applications are represented by rounded blue rectangles. Applications that have a direct
dependency on one or more of the original applications—andwere not part of the applications that were
displayed originally—are represented by teal green rectangles.

Caution: In dynamic graphing, all applications displayed are considered part of an application set.
If you open an application set and view its direct application dependencies, all applications
displayed in the graph are considered part of the application set. If you then save your application
set, all applications, including the direct dependent applications, are saved to the application set.

For example, in "Figure 5-4. Hierarchical view of an application set with direct dependencies"
below, applications that are both blue (original applications in the application set) and teal green
(applications that have a direct dependency on the original applications in the application set) are
considered part of the application set and, when saved, are saved as part of the application set.
When this saved application set is reopened, all applications are represented by rounded blue
rectangles.

For instructions for saving an application set in dynamic graphing, see "Saving Displayed
Applications in an Application Set" on page 95.

Figure 5-4. Hierarchical view of an application set with direct dependencies

Viewing Process Relationships
Use dynamic graphing to view process relationships. You can view the following relationships:
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l The selected process and its child processes, if any.

l The number of applications supporting the process.

l The applications that support the process.

Opening a Process

To open a process and view its child processes:

1. Start dynamic graphing. For instructions, see "Starting Dynamic Graphing" on page 77.

2. Click theOpen icon ( ).

3. Select Open Process Tree.

Note: If no processes have been created, theOpen Process Treemenu item is not
selectable.

The process selectionmenu displays the eight most recently created top-level processes
(processes with no parent). If the process you want to open is not displayed, selectMore to view
additional processes.

4. Select the process from the process hierarchy or type the name of the process in theProcess field
and click OK.

Processes are represented by rounded bright green rectangles in the graph.

Figure 5-5. Hierarchical view of process tree
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Viewing the Number of Applications that Support a Process

To view the number of applications supporting a process:

1. Open a process.

2. Click theGraph Options icon ( ).

3. Select Load Related Applications.

The size of the rounded rectangles change proportionally, based on the number of applications that
support the process. The number of applications supporting the process is displayed in the lower right
corner of the rounded rectangle.

Figure 5-6. Hierarchical view of process tree with application dependencies

Viewing the Applications that Support a Process

You can transform the process graph into a graph showing the applications that support the process
and its child processes:

1. Open a process.

2. Click theGraph Options icon ( ).

3. Select Load Related Applications. (Youmust load related applications before you can transform
it into an application graph).
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4. Click theGraph Options icon ( ).

5. Select Transform to Application Graph.

All applications that support the processes are represented by rounded rectangles. Use the graph
options to view the number of processes each application supports and to show the dependencies
between applications. You can also save this set of applications as an application set. (For
instructions, see "Saving Displayed Applications in an Application Set" on page 95.)

Viewing Application and Process Details
You can view detailed information about an application or process shown in a graph. Click on the
application or process and the information is displayed in the Details table. The information is
structured by sections and fields based on the entity type (application or process). For example, "Figure
5-7. Details table" below shows the Identity section for an application entity and some of its fields.

Figure 5-7. Details table

If you have loaded the supported processes of the displayed applications, an additional table is
displayed in the Details table. The second table displays a list of the dependent processes (processes
that are supported by the applications in the application set).

If you have loaded the related applications of a process, a Virtual Attributes section and an additional
table are added to the original table displayed in the Details table.
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l The Virtual Attributes section contains the Supporting Applications virtual attribute, which contains
a list of the dependent applications. You can filter the graph using this virtual attribute.

l The additional table lists the dependent applications (applications that support the process).

Filtering Applications and Processes
You can filter the graph to highlight only those applications or processes that meet a certain criteria:

1. In dynamic graphing, open an application set or one or more applications or processes. For
instructions, see "Starting Dynamic Graphing" on page 77.

2. Transform the graph as necessary. For instructions, see "Viewing the Applications that Support a
Process" on page 83.

3. Click the Filter Graph icon ( ).

The Filters table opens.

4. Select the attribute on which you want to filter and type the value in theCriteria column. You can
use wildcards or operators. For descriptions and examples of the wildcards and operators you can
use, see "Table 5-1. Wildcard/Operator descriptions and examples" on the next page. Filter criteria
are not case-sensitive.

Note: To configure attributes (fields) that had selectable "yes" or "no" values when the entity
was created (such as the Compliant attribute of a process entity, the Under Maintenance
attribute of an application entity, and the Disaster Recovery Plan in Place attribute of an
application entity), type y or n (not yes or no) as the filter criteria value.

5. Click Apply.

Applications or processes that do notmeet the filter criteria are changed to rounded gray
rectangles in the graph.

Youmight need tomove the graph or zoom out to view the entire graph.
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Data
Type Wildcard/Operator Description/Examples

Text * (Asterisk) Matches zero or more characters.

m* Match values that starts with "m" or
"M" such as "Michael" and
"Michele"

*e Match values that ends with "e" or
"E" such as "Michele" or
"Frederiche"

? (QuestionMark) Matches any one character.

?ich Match four-letter values that end
with "ich" such as "Rich"

?ich* Match values that have "ich" as
their second, third, and fourth letters
such as "Michelle" and "Rich"
("Frederiche" would NOTmatch)

= (Equals Sign) Explicit match.

=m* Match values that starts with "m" or
"M" such as "Michael" and
"Michele"

, (Comma) Acts as the OR boolean operator.

m*, *e Match values that starts with "m" or
"M" and ends with "e" or "E" such
as "Michael" or "Michele" or
"Frederiche"

"" (QuotationMarks) Match all characters inside the quotation
marks literally and exactly. Wildcards or operators inside of the
quotationmarks are not interpreted as wildcards or operators.

"rich" Exactly match the value of "rich"
(not case-sensitive) such as "Rich
("Frederiche" would NOTmatch)

"*ich*" Exactly match the value of "*ich""
(not case-sensitive) such as "*IcH*"
("Michele" and "Rich" and
"Frederiche" would NOTmatch)

Table 5-1. Wildcard/Operator descriptions and examples
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Data
Type Wildcard/Operator Description/Examples

Number > (Greater Than) Match all values greater than the given value.

>25 Match values that are greater than
25 such as "26" or ""27"

>= (Greater Than or Equal) Match all values that are greater than
or equal to the given value.

>=25 Match values that are greater than
or equal to 25 such as "25" or "26" or
"27"

< (Less Than) Match all values less than the given value.

<25 Match all values that are less than
25 such as "24" or "23"

<= (Less Than or Equal) Match all values less than or equal to the
given value.

<=25 Match all values that are less than
or equal to 25 such as "25" or "24" or
"23"

= (Equals Sign) Explicit match.

=25 Match the value of 25

, (Comma) Acts as the OR boolean operator.

24, 25 Match values of "24" or "25"

- (Dash) Match any value in the given range of numbers.

23-25 Match values of "23" or "24" or "25"

Table 5-1. Wildcard/Operator descriptions and examples, continued

"Figure 5-8. Hierarchical view of an application set" below shows an application set that shows
upstream/downstream relationships, direct dependencies, and dependent processes.

Figure 5-8. Hierarchical view of an application set
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"Figure 5-9. Hierarchical view of a filtered application set" below shows the same application set in
"Figure 5-8. Hierarchical view of an application set" on the previous page after a filter was applied to
highlight all applications with a Title that starts with "sharepoint."

Figure 5-9. Hierarchical view of a filtered application set

Changing the Dynamic Graphing Display of Applications
The graph of applications can be varied by changing the color or size of the nodes using the graph's
visual options. The color or size of the nodes represents the number or value of a selected application
attribute.

Color-coding displays up to four colors, with up to three colors based on specified percentiles:
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l Red. The application falls into the high percentile range.

l Orange. The application falls into themiddle or medium percentile range.

l Light Blue. The application falls into the low percentile range.

l Gray. The application does not have a number or value specified for the selected attribute.

Color percentiles are used with color-coding to specify the range of quantities or values a color
represents.

Note: Percentiles are based on the highest configured value or number of the selected attribute (in
theColor Nodes By field) for the applications in the graph. For example, an application score can
range from 0 (zero) to 5. However, if the highest application score of all applications in the graph is
4, the percentiles are based on the value of 4 (not 5).

"Table 5-2. Examples of percentiles based on highest attribute value" below shows an example of
percentile values for application scores. The highest attribute value is the highest application score of
all applications in the graph (each row represents a separate graph) and the high percentile is set
to 80% and the low percentile is set to 20%.

Highest Attribute Value

Values for Percentile Ranges of 80% and 20%

100% >= Red >= 80% 80% > Orange >= 20% 20% > Light Blue

5 5 >= Red >= 4 4 > Orange >= 1 1 > Light Blue

4 4 >= Red >= 3.2 3.2 > Orange >= .8 .8 > Light Blue

3.5 3.5 >= Red >= 2.8 2.8 > Orange >= .7 .7 > Light Blue

Table 5-2. Examples of percentiles based on highest attribute value

Sizing displays nodes of different sizes based on the number or value. The larger the node, the larger
the number or value.

The examples in this section show how to color-code the nodes by application score and size the
nodes by the number of processes supported by an application (the larger the node, themore
processes that are supported)

"Figure 5-10. Hierarchical view of application set" below shows an application set with upstream and
downstream relationships. No visual options have been set.

Figure 5-10. Hierarchical view of application set

HP Application Portfolio Management Analyst’s Guide
Chapter 5: Application Analysis

HP Project and Portfolio Management Center (9.30) Page 89 of 194



Color-coding Nodes by Application Score Values

To color-code the nodes by application score values:

1. Click the Graph Options icon ( ).

2. Select Visual Options.

3. From the Color Nodes By drop-down list, select Score: Application Score (Value).

4. Adjust theColor Percentiles by typing in the percentile ranges or using the slidebars. If you want
to represent only high and low quantities or values, set percentile ranges to successive numbers
(such as 51 and 50). In this example, the default values are used.

5. Click OK.

"Figure 5-11. Hierarchical view of application set that is color-coded" below shows the same
application set that is shown in "Figure 5-10. Hierarchical view of application set" on the previous page,
but the graph is color-coded to differentiate the applications by application score percentiles. In this
example, the highest application score for any node is 4, therefore red nodes represent applications that
have application scores in the 3.2–4 range, orange nodes represent applications that have application
scores in the .8–3.2 range, and light blue nodes represent applications that have application scores less
than .8.

Figure 5-11. Hierarchical view of application set that is color-coded
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Changing the Size of Nodes to Represent the Number of Supported
Processes

To change the size of nodes to represent the number of processes supported by an application,

1. Click theGraph Options icon ( ).

2. Select Visual Options.

3. From theSize Nodes By drop-down list, select Business Environment: Supported Processes
(Count).

4. Click OK.

"Figure 5-12. Hierarchical view of application set that is adjusted by size" below shows the application
set in "Figure 5-10. Hierarchical view of application set" on page 89, but the graph's node size
represents the number of processes that are supported by the application. The larger the node, the
more processes that are supported

Figure 5-12. Hierarchical view of application set that is adjusted by size
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"Figure 5-13. Hierarchical view of application set that is color-coded and adjusted by size" below shows
the application set that has both the color-coding and sizing visual options applied where color
represents the application score and node size represents the number of processes that are supported
by the application.

Figure 5-13. Hierarchical view of application set that is color-coded and adjusted by size

Changing the Dynamic Graphing Layout of Applications and
Processes
You can vary the graphs of applications and processes by changing the layout of the nodes. Choose
from the following layouts:
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l Circular. Shows interconnected rings and star topologies.

l Hierarchical. Default. Shows a top-to-bottom directed graph.

l Organic. Shows symmetrical or balanced distribution.
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l Orthogonal.Minimizes the number of overlapping and bends in connectors.
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To change the layout of the graph,

1. Click theGraph Options icon ( ).

2. Select Layout Options.

3. Select one of the layouts.

Saving Displayed Applications in an Application Set
Note the following behavior in dynamic graphing when you save the displayed applications as an
application set:

l All applications displayed are considered part of an application set. If you open an application set
and view its direct application dependencies, all applications displayed in the graph are considered
part of the application set. If you then save your application set, all applications, including the direct
dependent applications, are saved to the application set.

For example, in "Figure 5-4. Hierarchical view of an application set with direct dependencies" on
page 81, applications that are both blue (original applications in the application set) and teal green
(applications that have a direct dependency on the original applications in the application set) are
considered part of the application set and, when saved, are saved as part of the application set.
When this saved application set is reopened, all applications are represented by rounded blue
rectangles.

l Using theSave As Application Set option to save an application set as an existing application set
does not replace the existing application set. Instead, an application set with the same name is
created, but this newly created application set is not active.

For example, if you have two existing application sets (AppSet1 and AppSet2), open AppSet1 in
dynamic graphing, select Save As Application Set, type in AppSet2 as theName, and click
Submit. A Progress dialog opens and does not close unless you click Cancel.

When you view a list of your applications sets, you have two application sets named AppSet2. The
status of the original application set is Active. The status of the newly created application set is
Change Pending. You cannot activate the newly created application set unless its name is changed
to a unique name (the name is case-sensitive).

To save the applications displayed in dynamic graphing in an application set:

1. Click theSave icon ( ).

2. Select Save As Application Set.

3. Type a name and optional description and click OK.
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Saving an Image of a Dynamic Graph
You can save a dynamic graph as a JPEG (.jpg) or Portable Network Graphics (.png) file.

Caution: Only the portion of the graph that is visible in yourWeb browser is saved (along with the
legend and graph title). Youmay need to adjust the size of yourWeb browser or minimize the size
of the graph in order to save the complete graph.

To save an image of the graph:

1. Click the Save icon ( ).

2. Select Save Image SnapShot.

3. Select the directory in which you want to save the image, type a filename, and select a format of
the file.

4. Click Save.

Request Browser
You can use the Request Browser to display and track entity information that is hierarchically grouped
by specified entity fields. This information includes the total number of entities in each hierarchical
entity group. With the Request Browser, you can create hierarchical entity groups of up to five levels
deep, and you can break down the totals into a selected set of subtotals. You can also save the
hierarchical entity group and selected entity information, allowing you to track the information over a
period of time.

When you create an entity group with the Request Browser, you can use dynamic graphing to view the
graphical relationships between applications or between processes in the group. (For instructions, see
"Dynamic Graphing" on page 76.)

"Figure 5-14. Example of hierarchical grouping of applications and application totals and subtotals in the
Request Browser" below shows a hierarchical grouping of applications, broken down by location,
disposition, application health, and ITO contact. The total number of applications in each group is
broken into subtotals by selected Status values.

Figure 5-14. Example of hierarchical grouping of applications and application totals and
subtotals in the Request Browser
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For instructions for using the Request Browser to search entities (requests), see theHP Demand
Management User’s Guide. While you follow the instructions in theHP DemandManagement User’s
Guide, refer to the following example for the options you need to select from the HP APMmenus to get
to the Browse Entities and Request Browser pages.

Example: Using the Request Browser to Display Grouped
Entities
The following example displays the Application Health by Customer Visibility of an organization's
applications and, specifically, allows the organization's analyst to track the applications that are red for
customer-facing applications in Beijing, Bangalore, and Los Angeles:

1. From themenu bar, select Open > Application Portfolio > Analyze > Groups > Group
Entities.

The Browse Entities page opens.

2. In the Entities area, click Application.

The Request Browser: APM - Application page opens.

3. In theRequest Browser Tree Configuration section towards the bottom of the page, do the
following:

a. In theAdditional Column list, select or type Location.

The Column Values list is displayed to the right of the Additional Column field.

b. In theColumn Values list, select Nanjing, Shanghai, andUkraine and click OK.

4. In theChoose Fields to Group by in Request Browser Tree section, select Customer
Visibility andApplication Health from theAvailable Fields list. Click the right arrow tomove
them to theSelected Fields list.
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Note: The order in which you list the fields in this section determines the results that are
displayed.

5. In theChoose Columns for Request List section (above the Request Browser Tree
Configuration section), select the fields of the application that are to be tracked from theAvailable
Columns list: Title, Status, Business Owner, Active Users, Total Score, and Location. Click
the right arrow tomove them to theSelected Columns list.

6. Click Browse.

The Browse APM - Application Requests page opens.
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7. In the list of entities, expand the 3 - Customer facing group to show the totals by Application
Health.

There are two applications that are customer-facing and whose health is red. There is one
application of this type in Ukraine and no applications of this type in Nanjing and Shanghai.

8. Click on the number 1 that represents the number of customer-facing applications located in
Ukrainewhose health is Red.

The application that belongs to this group is displayed in the Request Browse Results section at
the bottom of the page.

Tip: You can use dynamic graphing to view the graphical relationships between the
applications or processes listed in the Request Browse Results section. For instructions, see
"Dynamic Graphing" on page 76.

9. To save the results as aMicrosoft Excel file, click Export to Excel.
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Saving an Entity Group
You can save an entity group to reuse later.

To save an entity group:

1. Create an entity group. For instructions, see "Request Browser" on page 96.

2. On the Browse <Entity_Type> Requests page, click Modify Preference Set.

The Request Browser: <Entity_Type> page opens.

3. Type a name for this entity group in theSave this Preference Set as field at the bottom of the
page.

4. Click Save.

The window that opens displays the results of the save operation.

5. Click Return to Browse Requests.

The Request Browser: <Entity_Type> page opens.

To view this group at a later time, from themenu bar, select Open > Application  Portfolio >
Analyze > Groups > Saved Group Criteria  > <Name_of_Saved_Group>.
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Appendix A: Entities

Entities Overview
This appendix provides descriptions and screenshots of the entities that HP Application Portfolio
Management (HP APM) provides for the analyst.

Refer to this appendix and the online help for field-level information when you are creating, searching
for, or updating an entity. For additional information about entities, see "Managing HP APM Entities" on
page 15.

Note: Most entities also have Notes, Status, and References sections. For descriptions of these
sections, see the description of the request details page in theHP DemandManagement User’s
Guide.

The HP APM administrator might choose to remove or add entities to your organization's
implementation of HP APM. Any entities added by your HP APM administrator are not
documented in this guide.

HP APM provides the following entities for analysts:

l "Application" below

l "Application Set " on page 130

l "Location" on page 132

l "Process" on page 134

l "Roadmap" on page 137

l "Server" on page 142

l "Survey Registration" on page 143

l "Transformation Proposal" on page 146

l "Workstream" on page 155

Application
An application entity is a software application or program that implements a business process or
function in your organization. An application entity can bemade up of one or more distinct services.

HP Project and Portfolio Management Center (9.30) Page 101 of 194



When creating, searching for, or editing an application entity, enter or update information in the
following sections:

l "Identity" below. The fundamental information that identifies the application.

l "Contacts" on page 105. The key contacts and stakeholders of the application.

l "Business Environment" on page 107. The critical business properties of the application.

l "Technical Environment" on page 109. The technologies used in the construction of the application,
connectivity to other systems, and planned disposition.

l "Budget & Resources" on page 112. The nominal return, total cost of ownership, direct and indirect
annual revenue, and average headcount supporting the application.

l "Service & Support" on page 113. The supporting environment and quality issues.

l "Usage & Scale" on page 115. The usage-based sizemeasurements.

l "Rating" on page 116. The subjectivemeasurements that reflect the business view of the
application. Thesemeasurements are relative to the overall enterprise application portfolio.

l "Score" on page 129. The computed scores and adjustment factor for the total score.

Identity
In the Identity section, enter the fundamental information that identifies the application.

Note: The Identity section is a subsection of the header section.

All users can view the data in this section. Users assigned one or more of the following roles can edit
the data in this section: Business Owner, Technical Owner, or Respondent (whenmore information is
requested).

Figure A-1. Application Identity section
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Field (*Required) Description

Title Read-only. The Title is automatically set to the application Name.

Application No. Read-only. A unique numeric identifier of the application.

Table A-1. Application Identity fields
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Field (*Required) Description

Status Read-only. The status of the application.

l New - The application is being defined but has not been submitted.

l In Review - The application details are currently under review as part of
an assessment or data collection process.

l Need More Info - Additional information has been requested from the
named respondent for the application.

l Active - The application is active and currently beingmanaged by its
owners.

l Snapshot - This is a static copy of the application information captured
on a specific date.

l Retired - The application is no longer active. It has been
decommissioned or has reached end-of-life and assessment is no longer
needed.

l Cancelled - The application entity has been cancelled and its
information is no longer valid.

*Name A name given to the application that distinguishes it from other applications.
The namemust be unique in order to transition the application from In
Review to Active status.

Version The version information associated with the application.

Acronym The acronym assigned to the application. Typically, this is defined by the
organizationmost involved with the application.

Alias An additional name assigned to the application.

Local ID A unique identifier for the application from a client-operated inventory
system, if applicable.

Class The high-level purpose of the application.

l Infrastructure - An application that is used to support a system, such as
a database, scheduler, or security monitor.

l Informational - An application that is used to store, communicate, or
manipulate data, such as data storage or reporting.

l Transactional - An application that requires an act or process to be
completed, such as order entry and payments.

Table A-1. Application Identity fields, continued
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Field (*Required) Description

Type The high-level origin of the application.

l ASP - Application Service Provider. An application that is hosted and
supported by an external organization and accessed over a network.

l Custom - An application that has been designed specifically for the
organization.

l COTS - Commercial, Off-the-Shelf. An application that is developed by
an ISV and customized for the organization.

l Composite - COTS and Custom. An application that consists of
heterogeneous systems (COTS and/or custom) that are integrated
together.

Importance The importance of the application to the enterprise.

l Low - The application is rarely used and does not affect the performance
and functioning of the organization.

l Normal - The application is used averagely andmay or may not affect
the performance and functioning of the organization.

l High - The application is widely used andmay affect the performance
and functioning of the organization.

l Critical - The application is required for the performance and functioning
of the organization.

Purpose The business or technical objective or function of the application.

Location The physical location of the production application.

Created By Read-only. The full name of the user who created the application entity.

Created On Read-only. The date on which the application entity was created.

Table A-1. Application Identity fields, continued

Contacts
In the Contacts section, enter the key contacts and stakeholders of the application.

Note: The Contacts section is a subsection of the header section.

All users can view the data in this section. Users assigned one or more of the following roles can edit
the data in this section: Business Owner, Technical Owner, or Respondent (whenmore information is
requested).
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Note: The application entity fields that users can view and edit are based on the roles to which the
users are assigned in this section. For additional information about roles, see "The Role of the
Analyst" on page 9.

Figure A-2. Application Contacts section

Field Description

Business Owner The full name of the primary person with business authority for the application.
If the user does not already have this ability, the Business Owner can view and
edit application information in all sections.

Technical Owner The full name of the primary person with technical authority for the application.
If the user does not already have this ability, the Technical Owner can view and
edit application information in the header, Business Environment, Technical
Environment, Service & Support, Usage & Scale, Rating, and Score sections.

ITOContact The full name of the primary person to contact regarding the infrastructure
supporting the application. No additional abilities are added for this role. (All
users, regardless of whether they are assigned a role, can view application
information in the header, Business Environment, Technical Environment, and
Usage & Scale sections.)

Budget Manager The full name of the person who is authorized to record the forecasted and
actual costs for the application. If the user does not already have this ability,
the Budget Manager can view application information in the header, Business
Environment, Technical Environment, Budget & Resources, and Usage &
Scale sections. The Budget Manager can also view and edit budget information
that is accessed from the Financial Summary link in the Budget & Resources
section.

Table A-2. Application Contacts fields
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Field Description

Benefits Manager The full name of the person who is authorized to record the financial benefits of
the application. If the user does not already have this ability, the Benefits
Manager can view application information in the header, Business
Environment, Technical Environment, Budget & Resources, and Usage &
Scale sections. The Benefits Manager can also view and edit benefits
information that is accessed from the Financial Summary link in the Budget &
Resources section.

Respondent The full name of the user asked to supply additional information about this
application. If the user does not already have this ability, the Respondent can
view and edit application information in all sections. This field is required when
more information is requested for an entity.

This field is displayed after a request for more information is sent.

Respondent Note Comments sent by email to the respondent when additional information about
the application is requested.

This field is displayed after a request for more information is sent.

SMEs Zero, one, or more full names of the subject matter experts (SMEs)—or
acknowledged specialists—for the application. If the user does not already
have this ability, the SME can view application information in the header,
Business Environment, Technical Environment, Usage & Scale, Rating, and
Score sections.

Table A-2. Application Contacts fields, continued

Business Environment
In the Business Environment section, enter the critical business properties of the application.

All users can view the data in this section. Users assigned one or more of the following roles can edit
the data in this section: Business Owner, Technical Owner, or Respondent (whenmore information is
requested).

Figure A-3. Application Business Environment section
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Field Description

Supported Processes Zero, one, or more business processes that are supported by the
application.

Owning Organization The name of the organization unit with business ownership of the
application. Organization units are created in Project and Portfolio
Management Center (PPM Center). (For instructions for creating
organization units, see the HP ResourceManagement User’s Guide.)

Regulatory Requirement Zero, one, or more compliance requirements for the application.

l SOX - Sarbanes-Oxley Act. United States regulations for corporate
financial accounting.

l FERC - Federal Energy Regulatory Commission. United States
regulations for energy transmission.

l NERC - North American Electric Reliability Corporation. North
American regulations for energy transmission.

l CPCU - Chartered Property Casualty Underwriter. Professional
designation in the insurance industry.

l CAISO - California Independent System Operator. Regulations for
California's power grid.

l HIPAA - Health Insurance Portability and Accountability Act.
Regulations for privacy of personal information.

l PCI - Payment Card Industry Data Security Standard. Standards for
the payment card industry.

Table A-3. Application Business Environment fields
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Field Description

Security Classification The highest security level designated for the components of this
application. That is, if the components of this application have different
security classifications, select the highest classification.

l Open - Contains information with no access constraints. Unusual in
a business context unless providing support for open source
development.

l Internal - Contains information for which access is restricted to
users within an organization.

l Limited - Contains information for which access is restricted to a
defined set of users.

l Confidential - Contains sensitive corporate information.

l SECRET - Contains information for which improper releasemay
damage the organization.

l Top Secret - In amilitary or government context, contains
information for which access is strictly controlled.

l Above Top Secret - Contains extremely sensitive information.

Table A-3. Application Business Environment fields, continued

Technical Environment
In the Technical Environment section, enter the technologies used in the construction of the
application, connectivity to other systems, and planned disposition.

All users can view the data in this section. Users assigned one or more of the following roles can edit
the data in this section: Business Owner, Technical Owner, or Respondent (whenmore information is
requested).

Figure A-4. Application Technical Environment section
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Field Description

Architecture The type of system onwhich the application is deployed.

l Mainframe

l Distributed

l Desktop

l Other

Downstream Applicationsa Zero, one, or more applications that depend on this application's
output or updates.

Upstream Applicationsa Zero, one, or more applications that produce output or updates on
which this application depends.

Servers The names of the servers on which the application is deployed.

Databases The names of the databases that the application uses.

Programming Technologies Zero, one, or more programming, scripting, or descriptive
languages or technologies that are used to construct the
application.

Table A-4. Application Technical Environment fields
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Field Description

Disposition The next planned step in the lifecycle of the application.

l Invest - Keep and enhance.

l Sustain - Keep andmaintain.

l Sunset - Keep but plan for replacement.

l Decommission - Retire.

Disposition Status The progress of the selected disposition.

l Proposed - The disposition of the application needs review.

l Assigned - The disposition of the application has been
assigned an owner.

l In-Progress - The disposition of the application is currently
ongoing.

l Complete - The disposition of the application has been
concluded.

Disposition Complete Date The date on which the disposition of the application is planned to
be completed.

SizingMethod Methodology used to compute the size of the application.

l IFPUG Counting - International Function Point Users Group
function point counting.

l Backfired - Function point counting based on lines of code.

l Use Case Point Counting - Function point counting based on
use cases.

l Logical LOC Counting - Lines of code.

l Custom Method - Other method to compute the size of the
application.

Size Themeasurement based on the sizingmethod.

Table A-4. Application Technical Environment fields, continued

HP Application Portfolio Management Analyst’s Guide
Appendix A: Entities

HP Project and Portfolio Management Center (9.30) Page 111 of 194



Field Description

Unit of Measurement The unit of measurement for the sizingmethod.

l Number of Pages

l Kilo Lines of Code

l Unadjusted Function Points

l ABAP Feature Points

l Siebel Function Points

l Adjusted Use Case Point

l Number of Test Cases

# of Annual Changes The number of change requests submitted per year.

a.    When you configure an upstream or downstream relationship in an entity, you cannot see the
relationship between the entities when you view the second entity. Make sure you also configure the
relationship in the second entity so the relationship is visible in both entities. For example, if you
configure entity B as a downstream entity in entity A, also configure entity A as an upstream entity in
entity B. (This is not necessary for viewing relationships in dynamic graphing. Both relationships are
visible when you view them in dynamic graphing regardless of whether they are configured in both
entities.)

Table A-4. Application Technical Environment fields, continued

Budget & Resources
In the Budget & Resources section, enter the nominal return, total cost of ownership, direct and indirect
annual revenue, and the average headcount supporting the application.

The owner of the entity and users assigned one or more of the following roles can view the data in this
section: Business Owner, Budget Manager, Benefits Manager, and Respondent (whenmore
information is requested). Users assigned one or more of the following roles can edit the data in this
section: Business Owner and Respondent (whenmore information is requested).

Authorized users can access and edit the application's financial summary by clicking the link in the
Financial Summary field. For additional information about the financial summary, see the description of
the Financial Summary field in "Table A-5. Application Budget & Resources fields" on the next page.

Figure A-5. Application Budget & Resources section
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Field Description

Financial Summary A link to the financial summary of the application. The financial
summary captures monthly forecast and actual costs and benefits.

This link is available only to users designated as the application
entity's Business Owner, Budget Manager, Benefits Manager,
Respondent (whenmore information is requested), or owner.

Only application entities and transformation proposals have financial
summaries. Each application entity and transformation proposals has
its own financial summary.

For more information about financial summaries, see theHP Financial
Management User’s Guide.

Nominal Return (ROI) The difference between total planned benefits (revenue) and total
planned costs.

Nominal Return = Total Planned Benefits – Total Planned Costs

Total Cost of Ownership The total cost to own and operate the application, including direct and
indirect costs.

Direct Annual Revenue The amount of annual revenue the application contributes to the
enterprise.

Indirect Annual Revenue The amount of annual revenue that can be attributed to the application
through a sharing function.

Resource Count (#) The average number of resources supporting the application at any
one time.

Table A-5. Application Budget & Resources fields

Service & Support
In the Service & Support section, enter the supporting environment and quality issues.

Users assigned one or more of the following roles can view and edit the data in this section: Business
Owner, Technical Owner, or Respondent (whenmore information is requested).
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Figure A-6. Application Service & Support section

Field Description

Application Health A color-coded indicator of the application's health.

l Red - Risks identified that may have adverse impact

l Yellow - Issues identified, but beingmanaged

l Green - No issues exist

Vendor Name The vendor of the application.

Product Name The product name of the application.

Under Maintenance? Indicates if the application has a current maintenance contract.

Placed in Service Date The deployment date of the application to production.

Expected End of Life Date The expected retirement date of the application. Typically this does not
apply to a specific version of the application but to the application itself.

Support Type The type of support contract.

l In-House - Maintenance is provided by the organization.

l Vendor - Maintenance is provided by the vendor of the application.

l 3rd Party - Maintenance is provided by another source that is not in-
house nor the vendor (for example, a contractor).

l None - Nomaintenance is provide.

# of Annual Incidents The number of incidents for the application tracked in a year.

Table A-6. Application Service & Support fields
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Field Description

Disaster Recovery Plan in
Place?

Indicates if the application has a disaster recovery plan.

Service Level Agreement The service level specified in the application's service contract. For
example, guaranteed uptime, performance periods (24 hours for five
days a week), or percentage of dropped calls.

Table A-6. Application Service & Support fields, continued

Usage & Scale
In the Usage & Scale section, enter the usage-based sizemeasurements.

All users can view the data in this section. Users assigned one or more of the following roles can edit
the data in this section: Business Owner, Technical Owner, or Respondent (whenmore information is
requested).

Figure A-7. Application Usage & Scale section

Field Description

EndUser Type The class of the user that operates the application.

l Internal - Employees

l External - Clients

l All - Both employees and clients

User Location The geographical or organizational distribution of users. For example,
North America or Marketing.

Total Users The size of the user community of the application.

Active Users The average number of active users during standard operation of the
application.

Table A-7. Application Usage & Scale fields
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Field Description

Frequency of Execution How often the application is run or is accessible.

l Online - Application is online 24x7, andmay be accessed at
anytime.

l Asynchronous - Application is run or accessed based on an
asynchronous event or activity.

l On-Demand - Application is run and accessed only when needed.

l Nightly - Application is run on a nightly basis, generally as a batch
process.

l Weekly - Application is run on a weekly basis.

l Monthly - Application is run on amonthly basis.

l Quarterly - Application is run once a quarter.

l Yearly - Application is run once a year.

Table A-7. Application Usage & Scale fields, continued

Rating
In the Rating section, enter subjectivemeasurements that reflect the business view of the application.
Thesemeasurements are relative to the overall enterprise application portfolio.

Users assigned one or more of the following roles can view the data in this section: Business Owner,
Technical Owner, Respondent (whenmore information is requested), or SME. Users assigned one or
more of the following roles can edit the data in this section: Business Owner, Technical Owner, or
Respondent (whenmore information is requested).

Figure A-8. Application Rating section
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Field Description

Relative Cost The total cost of the application compared to other applications in the
portfolio (including licenses, underlying hardware costs, minor
enhancements, and support).

l 0 - Least expensive

l 1 - Inexpensive

l 2 - Less than average

l 3 - More than average

l 4 - Expensive

l 5 - Most expensive

Relative Size The size of the application compared to the size of the typical application in
the portfolio.

l 0 - Extra small

l 1 - Small

l 2 - Smaller than average

l 3 - Larger than average

l 4 - Large

l 5 - Extra large

Operational Stability The reliability and dependability of the application during required
operational hours at required locations.

l 0 - Most unstable

l 1 - Very unstable

l 2 - Slightly unstable

l 3 - Fairly stable

l 4 - Very stable

l 5 - Always stable

Table A-8. Application Rating fields
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Field Description

Maintainability The upkeep of the application compared to other applications in the
portfolio.

l 0 - Impossible to maintain

l 1 - Very difficult

l 2 - Some difficulty

l 3 - Occasional difficulties

l 4 - Easy tomaintain

l 5 - Simple tomaintain

Complexity The complicatedness and intricacy of the application compared to other
applications in the portfolio. Complexity may be related to objective
measurements such as the size of the application or the number of
connections to other applications.

l 0 - Extra simple

l 1 - Simple

l 2 - Simpler than average

l 3 - More complex than average

l 4 - Complex

l 5 - Extra complex

Change Frequency The number of times the system changes relative to the amount of change
requests and incidents.

l 0 - Very rarely

l 1 - Infrequently

l 2 - Less than average

l 3 - More than average

l 4 - Frequently

l 5 - Excessively

Table A-8. Application Rating fields, continued
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Field Description

Functional
Completeness

The satisfaction of business requirements.

l 0 - Needs themost work

l 1 - Needs somework

l 2 - Needs a little work

l 3 - Has many features

l 4 - Has most needed features

l 5 - Has all needed features

Flexibility The ability to modify the application when requirements change (for
example, changes to standards, compliance, or regulations).

l 0 - Rigid

l 1 - Great effort to adapt to changes

l 2 - Significant effort to adapt to changes

l 3 - Some effort to adapt to changes

l 4 - Little effort to adapt to changes

l 5 - Adapts to changes through configuration

Interface Complexity The changes needed to integrate the application with other applications.

l 0 - Self contained (standalone)

l 1 - Few and simple

l 2 - Somewith average complexity

l 3 - Somemore complex

l 4 - Many

l 5 - Many or most complex

Table A-8. Application Rating fields, continued
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Field Description

Documentation The completeness of the user documentation.

l 0 - None

l 1 - Little

l 2 - Some features

l 3 - More features

l 4 - Most features

l 5 - Complete

Scalability The ability of the application to support fluctuations in demand.

l 0 - Cannot scale to expected needs

l 1 - Great effort to scale to expected needs

l 2 - Some effort to scale to expected needs

l 3 - Little effort to scale to expected needs

l 4 - Scales to expected needs

l 5 - Meets expected needs

Performance The ability of the application tomeet performance goals (for example,
response time under maximum load or time to completion).

l 0 - Never meets goals

l 1 - Seldommeets

l 2 - Meets less than average

l 3 - Meets more than average

l 4 - Usually meets

l 5 - Always meets goals

Table A-8. Application Rating fields, continued
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Field Description

Availability User accessibility of the application during required operational hours.

l 0 - Not available when needed

l 1 - Not available whenmany need it

l 2 - Not available when some need it

l 3 - Available when some need it

l 4 - Available whenmany need it

l 5 - Available when needed

Meets SLAs The ability to meet service level agreements or implicit expectations and
needs.

l 0 - Never meets

l 1 - Seldommeets

l 2 - Meets less than average

l 3 - Meets more than average

l 4 - Usually meets

l 5 - Always meets

Size of User Base The number of users compared to the number of applications in the
enterprise.

l 0 - Extra small

l 1 - Small

l 2 - Smaller than average

l 3 - Larger than average

l 4 - Large

l 5 - Extra large

Table A-8. Application Rating fields, continued
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Field Description

Data Consistency The alignment of the application's datamodel with enterprise and industry
standards.

l 0 - Uses custom data formats and definitions

l 1 - Mostly custom

l 2 - Some custom

l 3 - Some standard

l 4 - Mostly standard

l 5 - Uses enterprise standard data formats and definitions

Data Integrity The validity and consistency of data contained in the application. For
example, are all dates entered in amm/dd/yy format and does each date
include all attributes?

l 0 - Data errors and inconsistencies permeate the system

l 1 - Many data errors enter the system

l 2 - More than average data errors

l 3 - Few data errors enter the system

l 4 - Seldom data errors enter the system

l 5 - edits and validations ensure consistent data values throughout

Data Redundancy The profusion of the same data in multiple data sources distributed across
the enterprise.

l 0 - Highly redundant with other data sources

l 1 - Many redundant elements

l 2 - Some redundancy

l 3 - Few redundant elements

l 4 - Minimal redundancy

l 5 - No redundancy with other data sources

Table A-8. Application Rating fields, continued
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Field Description

Vendor Financial
Health

The financial soundness of the vendor.

l 0 - Bankrupt

l 1 - Questionable

l 2 - Below average

l 3 - Above average

l 4 - Strong

l 5 - Rock solid

Vendor Competition Thematurity of the competitive landscape and the availability of alternate
vendors.

l 0 - No competitors

l 1 - Emerging competitors

l 2 - Some competition

l 3 - Growing competition

l 4 - Alternatives widely available

l 5 - Commodity

Vendor Product Plans Thematurity of the application and if the enterprise affects the design
process.

l 0 - Off maintenance

l 1 - Maintenance only

l 2 - Occasionally updating

l 3 - Actively updating

l 4 - Plans aligned to needs

l 5 - Design partner

Table A-8. Application Rating fields, continued

HP Application Portfolio Management Analyst’s Guide
Appendix A: Entities

HP Project and Portfolio Management Center (9.30) Page 124 of 194



Field Description

Business Criticality The importance of the application to the success and survivability of the
business.

l 0 - Least critical

l 1 - Slightly critical

l 2 - Less than average

l 3 - More than average

l 4 - Critical

l 5 - Highly critical

Revenue Impact The effect of the application, either directly or indirectly, on revenue.

l 0 - None

l 1 - Little

l 2 - Some impact

l 3 - More impact

l 4 - Great impact

l 5 - Highest impact

Competitive
Advantage

The gain this application provides compared to other vendor's similar
applications.

l 0 - None

l 1 - Little

l 2 - Some advantage

l 3 - More advantage

l 4 - Great advantage

l 5 - Dominance

Table A-8. Application Rating fields, continued
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Field Description

Customer Visibility The accessibility of the application to the customer.

l 0 - Internal facing

l 1 - Some customer impact

l 2 - Some customer interaction

l 3 - Customer facing

l 4 - Primary customer channel

l 5 - Global customer dependence

Expense Reduction The decrease in costs when the application is used.

l 0 - No impact on expense

l 1 - Little impact on expense

l 2 - Some impact on expense

l 3 - More impact on expense

l 4 - Expense containment

l 5 - Major expense reduction

Manual Workarounds
Available

The availability of manual processes to accomplish the same business
function.

l 0 - No

l 1 - Few features

l 2 - Some features

l 3 - Many features

l 4 - Yes

l 5 - Yes and tested

Table A-8. Application Rating fields, continued
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Field Description

Security Risk The liability of the application in regards to access and security.

l 0 - Conforms to security best practices

l 1 - Implements standard security practices

l 2 - Provides some degree of access and data security

l 3 - Provides some degree of access or data security

l 4 - Provides little security protections

l 5 - No security protections

Architecture Risk The liability of the application in regards to the architecture defined by the
organization.

l 0 - Conforms to architecture best practices

l 1 - Adheres to enterprise standard practices

l 2 - Partially adheres to enterprise standard practices

l 3 - Minimally adheres to enterprise standard practices

l 4 - Does not adhere to enterprise standard practices

l 5 - No architecture standards defined

Technology Risk The liability of the application based on the technology it utilizes.

l 0 - Runs onmodern, proven, standard technology

l 1 - Runs on standard technology

l 2 - Runs primarily onmodern, proven technology

l 3 - Utilizes some non-standard technology

l 4 - Utilizes some obsolete, non-standard technology

l 5 - Runs entirely on obsolete technology

Table A-8. Application Rating fields, continued
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Field Description

Skills Risk The liability of the application in regards to the availability of users with the
ability to run the application.

l 0 - Skills exist in-house

l 1 - Skills are readily available in themarket

l 2 - Skills are specialized but available in-house

l 3 - Specialized skills are somewhat available in themarket

l 4 - Specialized skills are in limited supply

l 5 - Highly specialized skills are scarcely available in themarket

Compliance Risk The liability of the application based on regulatory requirements and
compliance validation.

l 0 - No requirements or independently audited compliance with all
requirements

l 1 - Conforms to all compliance requirements

l 2 - Non-compliance identified and correction plans in place

l 3 - Non-compliance identified but no correction plans in place

l 4 - Unknown compliance requirements

l 5 -Non-compliance identified that cannot be corrected

Business Continuity
Risk

The liability of the application based on data backups and the availability of
a business continuity plan (BCP). The liability may be affected by the
criticality of the application to the enterprise.

l 0 - BCP defined, tested, and operational

l 1 - BCP defined

l 2 - Data securely backed up andmanual workarounds in place

l 3 - Data backed up regularly

l 4 - Data backed up irregularly

l 5 - No BCP ormanual workarounds defined

Table A-8. Application Rating fields, continued
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Score
In the Score section, view the computed scores and enter an adjustment factor for the total score.

Users assigned one or more of the following roles can view the data in this section: Business Owner,
Technical Owner, Respondent (whenmore information is requested), or SME. Users assigned one or
more of the following roles can edit the data in this section: Business Owner, Technical Owner, or
Respondent (whenmore information is requested).

Figure A-9. Application Score section

Field Description

Application Score Read-only. The rating of the application, from zero to five (zero being the
worst and five being the best).

By default, the application score is calculated from non-empty individual
ratings defined in the Application Rating Section. The formula for the
application scoremay be customized.

Application Score = [(5 – Relative Cost) + (5 – Relative Size) +
Operational Stability + Maintainability + (5 – Change Frequency) +
Functional Completeness + Flexibility + (5 – Interface Complexity) +
Documentation + Performance + Availability + Meets SLAs + Size of
User Base] / (number of non-empty ratings)

Data Score Read-only. The rating of the data provided by the application, from zero
to five (zero being the worst and five being the best).

By default, the data score is the average of non-empty individual ratings
in the Data Rating Section. The formula for the data scoremay be
customized.

Data Score = (Data Consistency + Data Integrity + Data Redundancy) /
(number of non-empty ratings)

Table A-9. Application Score fields
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Field Description

Vendor Score Read-only. The rating of the vendor of the application, from zero to five
(zero being the worst and five being the best).

By default, the vendor score is the average of non-empty individual
ratings in the Vendor Rating Section. The formula for vendor scoremay
be customized.

Vendor Score = (Vendor Financial Health + Vendor Competition +
Vendor Product Plans) / (number of non-empty ratings)

Value Rating Read-only. The qualitativemeasure of the business value of the
application, from zero to five (zero being the worst and five being the
best).

By default, the value rating is the average of non-empty individual ratings
in the Value Rating Section. The formula for value ratingmay be
customized.

Value Rating = (Business Criticality + Revenue Impact + Competitive
Advantage + Customer Visibility + Expense Reduction + Manual
Workarounds Available) / (number of non-empty ratings)

Risk Rating Read-only. The qualitativemeasure of the technical debt of the
application, from zero to five (zero being the worst and five being the
best). The risk rating is calculated from values defined in the Risk Rating
Section of the Rating section.

By default, the risk rating is the average of non-empty individual ratings
in the Risk Rating Section. The formula for risk ratingmay be
customized.

Risk Rating = (Security Risk + Architecture Risk + Technology Risk +
Skills Risk + Compliance Risk + Business Continuity Risk) / (number of
non-empty ratings)

Score Adjustment (%) Percentage adjustment (positive or negative) made to the total score.

Total Score Read-only. The sum of all ratings and scores with the Score Adjustment
applied.

Total Score = [Application Score + Data Score + Vendor Score + Value
Rating + (5 – Risk Rating)] * [1 + (Score Adjustment / 100)]

Table A-9. Application Score fields, continued

Application Set
An application set entity is a user-defined grouping of applications.

When creating, searching for, or editing an application set, enter or update information in the following
sections:
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l "Summary" below. The fundamental information about the application set.

l "Scope" below. The applications in the application set.

Summary
In the Summary section, enter the fundamental information about the application set.

Figure A-10. Application set Summary section

Field (*Required) Description

Set No. Read-only. A unique numeric identifier of the application set.

Status Read-only. The status of the application set.

l New - The application set is being defined but has not been submitted.

l Active - The application set is active.

l Change Pending - The application set is beingmodified.

l Cancelled - The application set has been cancelled and its information
is no longer valid.

*Set Name A descriptive, distinct, and unambiguous name for the application set.

Description Information that describes the need and function of the application set.

Created By Read-only. The full name of the user who created the application set.

Created On Read-only. The date on which the application set was created.

Table A-10. Application set Summary fields

Scope
In the Scope section, enter the applications that are part of the application set.

Figure A-11. Application set Scope section
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Field (*Required) Description

Seq The sequence number of the application.

*Name The name of the application in the application set. This field is required
when you add a row to the table.

Table A-11. Application set Scope fields

Location
A location entity is a distinct and unambiguous location of an application, server, or a grouping of
locations.

When creating, searching for, or editing a location, enter or update information in the following sections:

l "Summary" below. The fundamental information about the location.

l "Address" on the next page. Information about the address and other geographical attributes.

Summary
In the Summary section, enter the fundamental information about the location.

Figure A-12. Location Summary section
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Field (*Required) Description

Location No. Read-only. A unique numeric identifier of the location.

Status Read-only. The status of the location.

l New - The location is being defined but has not been submitted.

l Active - The location is active and currently beingmanaged by its
owner.

l Change Pending - The location is beingmodified.

l Cancelled - The location has been cancelled and its information is no
longer valid.

*Location Name A distinct and unambiguous name for the location.

Description Information that describes the important attributes of the location from a
business or IT point of view.

Parent Location The Location Name of the location of which this location, hierarchically, is a
child.

Owner The full name of the person in the organization responsible for ensuring that
this location is up-to-date. The owner is allowed to edit information about
this location.

Created By Read-only. The full name of the user who created the location entity.

Created On Read-only. The date on which the location entity was created.

Table A-12. Location Summary fields

Address
In the Address section, enter information about the location address and other geographical attributes.

Figure A-13. Location Address section
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Field Description

Address Street number and street name of the location.

City City name of the location.

State/Province State name (U.S.) or province name (Canada).

Postal Code Postal code, postcode, ZIP code, or PIN code of the location.

Country Country name of the location.

Region Geographic area of the location.

l Americas

l EMEA (Europe, Middle East, Africa)

l Asia Pacific

Longitude Longitudinal geographic coordinate of the location.

Latitude Latitudinal geographic coordinate of the location.

Table A-13. Location Address fields

Process
A process entity is a standard set of actions or operations that moves the organization towards
achieving a business objective.

When creating, searching for, or editing a process, enter or update information in the following sections:

l "Summary" on the next page. The fundamental information about the process.

l "Compliance" on page 136. The information about compliance requirements and if they aremet.
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Summary
In the Summary section, enter the fundamental information about the process.

Figure A-14. Process Summary section

Field (*Required) Description

Process No. Read-only. A unique numeric identifier of the process.

Status Read-only. The status of the process.

l New - The process is being defined but has not been submitted.

l Active - The process is active and currently beingmanaged by its owner.

l Change Pending - The process is beingmodified.

l Cancelled - The process has been cancelled and its information is no
longer valid.

*Process Name A distinct and unambiguous name for the process that corresponds to
standard industry usage.

Description Information that describes the need and function of the process.

Parent Process The Process Name of the process of which this process, hierarchically, is a
child.

Table A-14. Process Summary fields
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Field (*Required) Description

*Process Type A definition of where the process is completed. Each process must be
associated with a process type on creation.

l Direct - A process completed explicitly by the organization.

l Indirect - A process completed by a client or third party.

Owner The full name of the person in the organization responsible for ensuring that
this process is carried out. The owner is allowed to edit information about
this process.

Created By Read-only. The full name of the user who created the process entity.

Created On Read-only. The date on which the process entity was created.

Table A-14. Process Summary fields, continued

Compliance
In the Compliance section, enter information about compliance requirements and if they aremet.

Figure A-15. Process Compliance section
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Field Description

Compliance
Requirements

Zero, one, or more compliance requirements for the process.

l SOX - Sarbanes-Oxley Act. United States regulations for corporate
financial accounting.

l FERC - Federal Energy Regulatory Commission. United States regulations
for energy transmission.

l NERC - North American Electric Reliability Corporation. North American
regulations for energy transmission.

l CPCU - Chartered Property Casualty Underwriter. Professional designation
in the insurance industry.

l CAISO - California Independent System Operator. Regulations for
California's power grid.

l HIPAA - Health Insurance Portability and Accountability Act. Regulations
for privacy of personal information.

l PCI - Payment Card Industry Data Security Standard. Standards for the
payment card industry.

Compliant Indicates if the process conforms with the selected Compliance Requirements.

Table A-15. Process Compliance fields

Roadmap
A Roadmap entity is a roadmap for an individual application/service, or a group of
applications/services, including lifecycle statuses (roadmap phases) andmilestones. You can create a
roadmap entity for any other existing APM entity.

When creating, searching for, or editing a location, enter or update information in the following sections:

l "Identity" below

l "Phases" on the next page

l "Milestones" on page 140

Identity
In the Identity section, enter the fundamental information that identifies the roadmap.
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Note: The Identity section is a subsection of the header section.

The table below describes the Identity fields.

Field
(*Required) Description

Roadmap
ID

ID of the roadmap

Roadmap
Status

Read-only. Available roadmap statuses include:

l New - The roadmap is created but not submitted.
l Draft - The roadmap is submitted but not finalized.
l Proposed - The roadmap is finalized but not activated.
l Active - The roadmap is activated but not archived.
l Cancelled - The roadmap is cancelled.
l Archived - The roadmap is archived.

Roadmap
Type*

Available roadmap types include:

l Application
l Portfolio

Note: These two types are available by default. Customized roadmap types can be
created in the PPMWorkbench by the APM administrator to meet your organization's
business needs and requirements.

Created On Read-only. The date on which the roadmapwas created

Created By Read-only. The full name of the user who created the roadmap

Entity* The entity for which the roadmap is created

Note: If an entity has a roadmap that is in "Active" status, you are not able to create
another roadmap for this entity.

Phases
In the Phases section, enter the information of the phases the roadmapwould go through.
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The table below describes the Roadmap Phases fields.

Field (*Required) Description

Seq Sequence of the roadmap phase

Name Name of the roadmap phase

Type Type of the roadmap phase. Available values include:

l Evaluation
l Planned
l Operational
l Archived
l Planned Decommissioned

Note: These five types are available by default. APM administrator can
create customized types of roadmap phases in the PPMWorkbench to
meet your organization's business needs and requirements.

Link URL or any other kind of link of the roadmap phase

Start Date Start date of the roadmap phase

End Date End date of the roadmap phase

Active Indicates whether or not the roadmap phase is active

Edit Roadmap Phases

To edit Roadmap Phases, click Edit. The Roadmap Phases section changes into the Edit view.

HP Application Portfolio Management Analyst’s Guide
Appendix A: Entities

HP Project and Portfolio Management Center (9.30) Page 139 of 194



Under the Edit view, you can do the followings to edit the phases:

l Edit the existing phases information

l Add a new phase by clickingAdd Row

l Delete a phase by clickingDelete Row after selecting the phase you want to delete

l Create a phase based on an existing phase by selecting the existing phase and then clickingCopy
andPaste

l Adjust the phases sequence by clickingMove Up orMove Down after selecting the desired phase

Milestones
In theMilestones section, enter the information of themilestones you set for the roadmap.

The table below describes the RoadmapMilestone fields.

Field (*Required) Description

Seq Sequence of the roadmapmilestone

Code Code of the roadmapmilestone

Name Name of the roadmapmilestone
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Type Type of the roadmapmilestone. Available values include:

l Major Decision Point
l Minor Decision Point
l Release
l De-Investment
l Business Function/Business Capability
l Technology Capability

Note: These six types are available by default. Customized types of
roadmapmilestones can be created in the PPMWorkbench by the APM
administrator to meet your organization's business needs and requirements.

Date Date of the roadmapmilestone

Decision Decision that has beenmade in this milestone

URL URL of themilestone information

Edit Roadmap Milestones

To edit RoadmapMilestones, click Edit. The RoadmapMilestones section changes into the Edit view.

Under the Edit view, you can do the followings to edit themilestones:

l Edit the existingmilestones information

l Add a new milestone by clickingAdd Row

l Delete amilestone by clickingDelete Row after selecting themilestone you want to delete

l Create amilestone based on an existingmilestone by selecting the existingmilestone and then
clickingCopy andPaste

l Adjust themilestones sequence by clickingMove Up orMove Down after selecting the desired
milestone

Note: If you want to edit the URL field of amilestone, youmay have to click Edit at the end of the
milestone line to open the Link Properties window.

HP Application Portfolio Management Analyst’s Guide
Appendix A: Entities

HP Project and Portfolio Management Center (9.30) Page 141 of 194



Server
A server entity is a physical or virtual machine.

When creating, searching for, or editing a server, enter or update information in the following section:

l "Summary" below. The fundamental information about the server.

Summary
In the Summary section, enter the fundamental information about the server.

Figure A-16. Server Summary section

Field (*Required) Description

Server No. Read-only. A unique numeric identifier of the server.

Table A-16. Server Summary fields
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Field (*Required) Description

Status Read-only. The status of the server.

l New - The server is being defined but has not been submitted.

l Active - The server is active.

l Change Pending - The server is beingmodified.

l Cancelled - The server has been cancelled and its information is no
longer valid.

*Server Name A distinct and unambiguous name for the server.

Description Information that describes the important attributes of the server, from a
business or IT point of view.

IP Address Internet Protocol address of the server.

Type Function of the server.

l Development

l Testing

l Production

OS The operating system onwhich the server is running.

Running Software List of major software packages or applications running on the server. The
list is comma-delimited. Do not include operating system utilities.

Location Physical location of the server.

Created By Read-only. The full name of the user who created the server entity.

Created On Read-only. The date on which the server entity was created.

Table A-16. Server Summary fields, continued

Survey Registration
A survey registration entity is a query to collect data about an application to help with its analysis.

When creating, searching for, or editing a survey, enter or update information in the following sections:

l "Summary" on the next page. The fundamental information about the survey.

l "Details" on the next page. The information about the type of survey and the expected completion
date.
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Summary
In the Summary section, enter the fundamental information about the survey.

Figure A-17. Survey registration Summary section

Field (*Required) Description

Request No. Read-only. A unique numeric identifier of the survey.

Status Read-only. The status of the survey.

l New - The survey is being defined but has not been submitted.

l In Design - The survey is being scoped and has not been sent.

l Active - Surveys have been sent to the target audience for responses.

l Closed - The survey is not active and is no longer accepting responses.

l Cancelled - The survey has been cancelled and its information is no
longer valid.

*Survey Name A distinct, unambiguous, and descriptive name for the survey.

Created By Read-only. The full name of the user who created the survey registration
entity.

Created On Read-only. The date on which the survey registration entity was created.

Table A-17. Survey registration Summary fields

Details
In the Details section, enter information about the type of survey, the expected completion date, the
applications it includes, and the respondents needed for the applications.

Figure A-18. Survey registration Details section
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Field (*Required) Description

*Survey Template The type of survey to send.

l Business Survey. Business-related ratings for the application, data,
vendor, value, and risk.

l General Survey (Full). Application-related ratings for the
application, data, vendor, value, and risk.

l Technical Survey. Technical-related ratings for the application,
data, vendor, and risk.

View Preview A link to view the survey.

Target Completion Date The date on which the survey closes. By default, every three days an
email is sent to remind the survey respondent to complete the survey
until this date is met.

*List of Applications &
Respondents

A table containing the list of applications and respondents for the survey.
After the survey registration entity is created, the fields in this table must
be completed before the survey can be submitted. For descriptions of the
icons in this table, see "Table 4-1. Table icons" on page 64.

This table is named List of Surveys after the survey registration is
submitted.

List of Surveys Read-only. A table containing the list of surveys that were sent. Includes
the survey number, and name of the application, and the respondent for
each survey sent.

This table is named List of Applications & Respondents before the
survey registration is submitted.

Table A-18. Survey registration Details fields
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Transformation Proposal
A transformation proposal entity is a consolidation of information used tomake a decision about a
proposed project. Transformation proposals may be imported as proposals into PPM Center for
additional analysis.

When creating, searching for, or editing a transformation proposal, enter or update information in the
following sections:

l " Summary" below. The fundamental information about the transformation proposal.

l "Proposal Details" on the next page. The information about the basic effort implication for the
transformation proposal.

l "Business Case Details" on page 149. The information used to understand the transformation
proposal and its expectations.

l "Value & Risk Assessment" on page 150. The information about the initial evaluation of risks and
rewards.

Summary
In the Summary section, enter the fundamental information about the transformation proposal.

Figure A-19. Transformation proposal Summary section
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Field (*Required) Description

Title Read-only. The description assigned to the transformation proposal when the
transformation proposal is created.

Proposal No. Read-only. A unique numeric identifier of the transformation proposal.

Status Read-only. The status of the transformation proposal.

l New - The transformation proposal is being defined but has not been
submitted.

l In Review - The transformation proposal is currently under review.

l Approved - The transformation proposal has been approved for execution.

l Rejected - The transformation proposal has been rejected.

l Cancelled - The transformation proposal entity has been cancelled and its
information is no longer valid.

*Proposal Name A name given to the transformation proposal that distinguishes it from other
transformation proposals. Although the name is not validated for uniqueness
during initial creation, it must be unique in order to transition the transformation
proposal from In Review to Active status.

Owner The full name of the user who is proposing the transformation proposal. The
owner is allowed to edit information about this transformation proposal.

Description Information that describes the business value and applications affected by the
transformation proposal.

Proposal
Dependencies

Existing transformation proposals that must be completed successfully before
this transformation proposal can be executed.

Created By Read-only. The full name of the user who created the transformation proposal
entity.

Created On Read-only. The date on which the transformation proposal entity was created.

Table A-19. Transformation proposal Summary fields

Proposal Details
In the Proposal Details section, enter information about the basic effort implication for the
transformation proposal.

Figure A-20. Transformation proposal Proposal Details section
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Field Description

Project Class The fundamental type of the project, used to determine business rules
or policies that help manage the project.

l Innovation

l Growth

l Efficiency

l Core (Keep the Lights On)

Asset Class The type of asset that is affected by the transformation proposal.

l Infrastructure - Investments that provide a shared and
standardized base of capability for the enterprise.

l Informational - Systems that provide information for managing an
organization.

l Transactional - Transformation proposals that process and
automate the basic transactions of an organization.

Business Objective The result that the enterprise intends to achieve by completing the
transformation proposal.

Executive Sponsor The full name of the executive sponsor of the transformation proposal.

IT Sponsor The full name of the IT leader of the group that is responsible for
executing the transformation proposal.

Table A-20. Transformation proposal Proposal Details fields
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Field Description

Expected Start Period Themonth and year in which the project is expected to start.

Expected Finish Period Themonth and year in which the project is expected to finish.

Associated Applications The applications impacted by the transformation proposal.

Vendors Involved The vendors of the associated applications whomay be involved with
the transformation proposal.

Table A-20. Transformation proposal Proposal Details fields, continued

Business Case Details
In the Business Case Details section, enter information used to understand the transformation proposal
and its expectations.

Authorized users can access and edit a transformation proposal's financial summary by clicking the
link in the Financial Summary field. For additional information about the financial summary, see the
description of the Financial Summary field in "Table A-21. Transformation proposal Business Case
Details fields" below.

Figure A-21. Transformation proposal Business Case Details section

Field Description

Business Case Doc An attachment that explains the business case of the transformation
proposal.

Requirements Doc An attachment that explains the requirements of the transformation
proposal.

Budget Manager The full name of the person who is authorized to record the forecasted and
actual costs for the application.

Benefits Manager The full name of the person who is authorized to record the financial
benefits of the application.

Table A-21. Transformation proposal Business Case Details fields
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Field Description

Financial Summary A link to the financial summary of the transformation proposal. The financial
summary captures monthly forecast and actual costs and benefits.

This link is available only to the owner of the transformation proposal and to
users designated as the transformation proposal's Budget Manager or
Benefits Manager.

Only application entities and transformation proposals have financial
summaries. Each application entity and transformation proposal has its
own financial summary.

For more information about financial summaries, see the  HP Financial
Management User’s Guide.

Nominal Return The difference between total planned benefits (revenue) and total planned
costs.

Nominal Return = Total Planned Benefits – Total Planned Costs

Table A-21. Transformation proposal Business Case Details fields, continued

Value & Risk Assessment
In the Value & Risk Assessment section, enter information about the initial evaluation of risks and
rewards.

Figure A-22. Transformation proposal Value & Risk Assessment section
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In the Description column of "Table A-22. Transformation proposal Value & Risk Assessment fields"
below, the numbers in parentheses are the values that are assigned to the list items when they are
selected.

Field Description

Internal Rate of Return The profitability of the transformation proposal.

l Zero or less (0)

l 1 - 5.99% (10)

l 6 - 9.99% (20)

l 10 - 14.99% (30)

l 15% and above (40)

Table A-22. Transformation proposal Value & Risk Assessment fields
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Field Description

Strategic Match How the transformation proposal affects the business objectives.

l No impacted business goals. (0)

l No impacted goal. Increases operational efficiency. (5)

l No direct impact of goal, but prerequisite. (10)

l Direct impact on a portion of a goal. (15)

l Direct achievement of a goal. (20)

l Direct achievement of multiple goals. (25)

Competitive Advantage The impact the transformation proposal has on competitive
positioning.

l No client or market impact. (0)

l Improves operating efficiencies that affect competitive position.
(5)

l Improves operating efficiencies in strategic area. (10)

l Provides some degree of outside access. (15)

l Provides moderate degree of outside access. (20)

l Provides high level of outside access. (25)

Competitive Response The urgency of the transformation proposal relative to competitive
positioning.

l Can be postponed for 12months with no effect to competitive
positioning. (0)

l Can be postponed for 12months with minimal effect to
competitive positioning. (2)

l Can be postponed for 12months with significant effect to
competitive positioning. (4)

l Postponement will result in loss of competitive positioning. (6)

l Postponement will result in complete loss of competitive
positioning. (10)

Table A-22. Transformation proposal Value & Risk Assessment fields, continued
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Field Description

Productivity The expected increase or decrease of productivity when the
transformation proposal is completed.

l Decreased productivity (0)

l Less than 10% increase (2)

l 11 - 30% increase (4)

l 30 - 50% increase (6)

l 51% ormore increase (10)

Value Rating Read-only. The qualitativemeasure of the business value of the
transformation proposal.

By default, the value rating is the sum of non-empty individual ratings
listed above the Value Rating field. The formula for value ratingmay
be customized.

Value Rating = Internal Rate of Return + Strategic Match +
Competitive Advantage + Competitive Response + Productivity

Organization Risk The liability of the transformation proposal based on its impact to the
organization.

l No risk (0)

l Low risk (1)

l Medium low risk (2)

l Medium risk (3)

l High risk (4)

l Extreme risk (5)

Table A-22. Transformation proposal Value & Risk Assessment fields, continued
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Field Description

Technical Risk The liability of the transformation proposal based on the technology it
utilizes and the skills required to use the technology.

l No uncertainty (0)

l Very low uncertainty (3)

l Low uncertainty (6)

l Medium uncertainty (9)

l High uncertainty (12)

l Unknown (15)

Architecture Risk The liability of the transformation proposal in regards to the
architecture defined by the organization.

l Utilizes standard architecture (0)

l Minor change to standard architecture (2)

l Medium change to standard architecture (4)

l Major change to standard architecture (6)

l No leverage of standard architecture (10)

Definition Risk How well the requirements are defined for the transformation
proposal.

l Requirements are firm. No changes. (0)

l Requirements aremoderately firm. Low probability of changes.
(2)

l Requirements aremoderately firm. Medium probability of
changes. (4)

l Requirements aremoderately firm. High probability of changes.
(6)

l Requirements are not firm (8)

Table A-22. Transformation proposal Value & Risk Assessment fields, continued
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Field Description

Infrastructure Risk The liability of the transformation proposal in regards to the
infrastructure of the organization.

l Uses existing systems and services (0)

l Small changes to existing infrastructure (1)

l Small changes and additions are expected (2)

l Moderate changes are expected (3)

l Moderate changes tomultiple systems are expected (4)

l Substantial change to infrastructure are expected (5)

Risk Rating Read-only. The qualitativemeasure of the risk of the transformation
proposal to successfully complete. The risk rating is calculated from
values defined in the Risk Rating Section of the Rating section.

By default, the risk rating is the sum of non-empty individual ratings
for all risks in the Value & Risk Assessment section. The formula for
risk ratingmay be customized.

Risk Rating = Organization Risk + Technical Risk + Architecture
Risk + Definition Risk + Infrastructure Risk

Score Adjustment Adjustment (positive or negative) made to the total score.

Total Score Read-only. The difference between the Value Rating and Risk Rating
with the Score Adjustment applied.

Total Score = Value Rating – Risk Rating + Score Adjustment

Table A-22. Transformation proposal Value & Risk Assessment fields, continued

Workstream
A workstream entity is a collection of resources working towards a common goal on a portion of the
application or process portfolio.

When creating, searching for, or editing a workstream, enter or update information in the following
sections:

l "Summary" on the next page. The fundamental information about the workstream.

l "Schedule" on page 157. The planned and actual start dates, finish dates, duration, and effort.

l "Staffing" on page 158. The users assigned to the workstream.

l "Scope" on page 158. The processes and applications impacted by the workstream.
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Summary
In the Summary section, enter the fundamental information about the workstream.

Figure A-23. Workstream Summary section

Field (*Required) Description

Workstream No. Read-only. A unique numeric identifier of the workstream.

Status Read-only. The status of the workstream.

l New - The workstream is being defined but has not been submitted.

l Active - The workstream is active and currently beingmanaged by its
owner.

l In Review - The workstream is currently under review.

l Closed - The workstream is completed.

l Cancelled - The workstream has been cancelled and its information is no
longer valid.

*Name A distinct and unambiguous name for the workstream that reflects its
intention.

Table A-23. Workstream Summary fields
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Field (*Required) Description

Priority The importance of the workstream to the enterprise relative to other
workstreams.

l Low - The workstream does not affect the performance and functioning of
the enterprise and is of less importance compared to other workstreams
within the enterprise.

l Normal - The workstreammay ormay not affect the performance and
functioning of the enterprise and is of average importance compared to
other workstreams within the enterprise.

l High - The workstreammay affect the performance and functioning of the
enterprise and is of more importance compared to other workstreams
within the enterprise.

l Critical - The workstream is required for the performance and functioning
of the enterprise.

Description Information that describes the scope, effort, and timeline of the workstream.

Owner The full name of the person who is responsible for executing the workstream.
The owner is allowed to edit information about this workstream.

Reviewer The full name of the person who is responsible for reviewing the workstream
and verifying that the deliverables aremet.

Created By Read-only. The full name of the user who created the workstream entity.

Created On Read-only. The date on which the workstream entity was created.

Table A-23. Workstream Summary fields, continued

Schedule
In the Schedule section, enter the planned and actual start dates, finish dates, duration, and effort.

Figure A-24. Workstream Schedule section
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Field Description

Scheduled Start Date The day on which the workstream is planned to start.

Actual Start Date The day on which the workstream actually started.

Scheduled Finish Date The day on which the workstream is planned to finish.

Actual Finish Date The day on which the workstream actually finished.

Scheduled Duration The planned number of work days needed to complete the workstream.

Actual Duration The actual number of work days needed to complete the workstream.

Scheduled Effort The planned number of working hours needed to complete the
workstream.

Actual Effort The actual number of working hours needed to complete the
workstream.

Table A-24. Workstream Schedule fields

Staffing
In the Staffing section, enter the users assigned to the workstream.

Figure A-25. Workstream Staffing section

Field Description

Resource(s) List of users, by full name, assigned to the workstream.

Table A-25. Workstream Staffing fields

Scope
In the Scope section, enter the processes and applications impacted by the workstream.

Figure A-26. Workstream Scope section
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Field Description

Process(es) Zero, one, or more processes impacted by the workstream.

Application(s) Zero, one, or more applications impacted by the workstream.

Application Set The set of applications impacted by the workstream.

Table A-26. Workstream Scope fields
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Appendix B: PPM Dashboard Pages and Portlets

Overview
The shared PPMDashboard pages and shared and configurable portlets that HP Application Portfolio
Management (HP APM) provides for HP APM analysts are described in the following sections:

l "Shared PPMDashboard Pages and Portlets" below

l "Configurable Portlets" on page 166

Note: The PPMDashboard pages and portlets available to youmight be different from the PPM
Dashboard pages and portlets described in this appendix. This could be because of your
configuration or the roles that you are assigned or because of your organization's implementation
of HP APM. Any PPMDashboard pages and portlets added by an analyst or administrator are not
documented in this guide.

Because HP APM is a part of Project and Portfolio Management Center (PPM Center), PPM
Dashboard pages and portlets unrelated to HP APMmight also be available to you. This guide
addresses only the HP APM pages and portlets

For additional information about PPM Dashboard pages and portlets, see "PPM Dashboard and PPM
Dashboard Pages" on page 73 and "Portlets" on page 75.

For descriptions of additional PPM Dashboard pages and portlets that might be available to you, see
the HP Application Portfolio Management User's Guide for descriptions of the PPMDashboard pages
and portlets provided for HP APM users.

Shared PPM Dashboard Pages and Portlets
HP APM provides several shared PPMDashboard pages and portlets for HP APM analysts. You
cannot edit or delete shared PPMDashboard pages and portlets.

This section provides a screenshot and description of each of the portlets included on the following
shared PPMDashboard pages:

l "Front Page " on the next page

l "Portfolio View" on page 162

l "Applications" on page 164
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Formore information about shared portlets, see the online help. For information about how to use the
PPMDashboard pages, see "PPM Dashboard and PPMDashboard Pages" on page 73.

Front Page
The Front Page shared PPMDashboard page for HP APM analysts displays portlets that contain
information that youmight want to track regularly. These portlets include information about the
applications in the portfolio, workstreams youmanage, transformation proposals you have defined,
surveys being conducted, and applications that are not mapped to processes.

Figure B-1. Example of the Front Page page

Portlet Name Description

Applications This portlet displays a list of all applications in your organization's
portfolio. Use this portlet to track basic information about an application.
The following columns are displayed: Name, Business Owner,
Disposition, Disposition Status, Total Score, Last Update Date, and
Status.

By default, applications are listed by the date they were last updated, with
themost recently updated applications shown first.

Table B-1. Shared portlets on Front Page page
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Portlet Name Description

Applications Not
Mapped to Process

This portlet displays a list of all applications in your organization's portfolio
that are not assigned to a business process. Use this portlet to view all
applications that do not contribute to any business process. The following
columns are displayed: Name, Business Owner, Disposition, Total Score,
and Status.

By default, applications are listed alphabetically by name.

My Workstreams This portlet displays a list of all the workstreams you created, own, have
been asked to review, or for which you are a resource. Use this portlet to
view the workstreams that youmanage. The following columns are
displayed: Name, Owner, Reviewer, and Status.

By default, workstreams are listed alphabetically by name.

My Transformation
Proposals

This portlets displays all active and approved transformation proposals
that you created or own. Use this portlet to view transformation proposals
that can be developed as projects. The following columns are displayed:
Name, Owner, Total Score, and Status.

By default, transformation proposals are listed alphabetically by name.

My Survey Requests This portlet displays all active survey requests crated by you or other HP
APM users. Use this portlet to keep track of the surveys conducted by HP
APM users. The following columns are displayed: Name, End Date, and
Status.

By default, survey requests are listed alphabetically by name.

Table B-1. Shared portlets on Front Page page, continued

Portfolio View
The Portfolio View shared PPMDashboard page for HP APM analysts displays portlets that provide
application portfolio information youmight want to track regularly. This includes an assessment of an
application's value, transformation proposal ratings, the number of applications in the portfolio, and an
application's total cost of ownership.

Figure B-2. Example of shared portlets on the Portfolio View PPM Dashboard page
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Portlet Name Description

Application Value
Assessment

This portlet displays an application's quality, health, value rating, and total
cost of ownership. This portlet can be displayed as a bubble chart (default) or
list. Use the information to determine if an application needs to be assessed
(for example, for modernization).

Table B-2. Shared portlets on Portfolio View PPM Dashboard page
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Portlet Name Description

Application
Transformation
Proposal Ratings

This portlet displays the total score, value rating, and risk rating by
transformation proposal. This portlet can be displayed as a clustered bar chart
(default), stacked bar chart, or list. Use this portlet to view how
transformation proposals are ranked based on their total score.

In the clustered bar chart and stacked bar chart, by default, applications are
listed numerically (highest to lowest) by total score.

Application Portfolio
Size over Time

This portlet displays the number of applications in the portfolio over a period of
time. This portlet can be displayed as a line chart (default), XY chart, radar
chart, or list. Use this portlet to track how many applications are in the
portfolio over a specified period of time.

By default, Period Type is set to Quarter.

Total Cost of
Ownership (TCO)
Summary

This portlet displays the total cost of ownership by applications in the
portfolio. This portlet can be displayed as a bar chart (default), pie chart, or
list. Use this portlet to determine the total cost to own and operate an
application.

In the bar chart and pie chart, by default, applications are listed numerically
(highest to lowest) by cost.

Table B-2. Shared portlets on Portfolio View PPM Dashboard page, continued

Applications
The Applications shared PPMDashboard page for HP APM analysts displays portlets with application
information that the youmight want to track regularly. This includes an application's health by owner,
the number of applications that support a process, and a list of all applications in the portfolio.

Figure B-3. Example of the shared Applications page
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Portlet Name Description

Application Health
Breakdown by
Owner

This portlet displays the number of applications by health for each business
owner. This portlet can be displayed as a stacked bar chart (default), clustered
bar chart, or list. Use this portlet to track how many applications are owned by
each business owner and the health of each application.

From this portlet, you can drill down to display, for the selected application, the
application's health, name, business owner, technical owner, disposition,
disposition status, total score, and status.

Application to
Process Coverage
Summary

This portlet displays the number of applications that support each business
process and the health of the applications. Use this portlet to determine how
many applications support a business process and the health of each
application. The following columns are displayed: Business Process,
Applications (#), and Health Breakdown.

Application List This portlet displays a list of all applications in your organization's portfolio.
Use this portlet to view basic information about an application. The following
columns are displayed: Name, Business Owner, Technical Owner,
Disposition, Disposition Status, Total Score, and Status.

By default, applications are listed alphabetically by name.

Table B-3. Shared portlets on Applications page

Configurable Portlets
You can add configurable portlets to your PPM Dashboard pages, and then customize the portlets to
suit your information needs.

This section provides a screenshot and description of each of the following configurable portlets
provided for HP APM analysts:

l "Application Health Breakdown" on the next page

l "Application Portfolio Size" on page 169

l "Application to Process Coverage" on page 170

l "Application Value Assessment" on page 172

l "List of Applications (Analyst)" on page 173

l "My Applications" on page 176

l "My Survey Requests" on page 177

l "My Transformation Proposals" on page 178
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l "My Workstreams" on page 180

l "Rating of Transformation Proposals " on page 181

l "TCOSummary" on page 183

Note: You can find these portlets in theApplication Portfolio category when you add portlets to
a private PPM Dashboard page.

For more information about each portlet, see the online help. For additional information about portlets,
see "Portlets" on page 75.

Application Health Breakdown
The Application Health Breakdown portlet displays the number of applications by health for each
business owner. This portlet can be displayed as a stacked bar chart (default), clustered bar chart, or
list. Use this portlet to track how many applications are owned by each business owner and the health
of each application.

From this portlet, you can drill down to display, for the selected application, the application's health,
name, business owner, technical owner, disposition, disposition status, total score, and status.

Figure B-4. Example of the Application Health Breakdown portlet
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To select the type of data that is displayed in this portlet and how the data is displayed, set the
preference settings and filters.

Field Description

Application Set Select an application set to display in the portlet. The portlet displays the
number and health of applications from the application set for each business
owner who owns an application in the application set. By default, the number
and health of all applications for all business owners are displayed.

Display preferences
summary on portlet

Display the preferences you have selected at the top of the portlet.

Table B-4. Preference settings and filters for Application Health Breakdown portlet
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Application Portfolio Size
The Application Portfolio Size portlet displays the number of applications in the portfolio over a period of
time. This portlet can be displayed as a line chart (default), XY chart, radar chart, or list. Use this portlet
to track how many applications were in the portfolio over a specified period of time.

Youmust specify the start and end period before data is displayed in this portlet. By default, Period
Type is set to Quarter.

Figure B-5. Example of the Application Portfolio Size portlet

To select the type of data that is displayed in this portlet and how the data is displayed, set the
preference settings and filters.

Field (*Required) Description

Application Set Select an application set to display in the portlet. The portlet displays the
number of applications from the application set for the specified time period.
By default, all applications in the application portfolio are counted.

Table B-5. Preference settings and filters for Application Portfolio Size portlet
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Field (*Required) Description

*Period Type Default: Quarter

The time period by which the number of applications is displayed.

l Month

l Quarter

l Half Year

l Year

*Period Start Select the starting time period from which you want to display the number of
applications.

*Period Finish Select the ending time period to which you want to display the number of
applications.

Display preferences
summary on portlet

Display the preferences you have selected at the top of the portlet.

Table B-5. Preference settings and filters for Application Portfolio Size portlet, continued

Application to Process Coverage
The Application to Process Coverage portlet displays the number of applications that support a
business process and the health of the applications. This portlet is displayed as a list. Use this portlet
to determine how many applications support a business process and the health of the applications.

Figure B-6. Example of the Application to Process Coverage portlet
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To select the type of data that is displayed in this portlet and how the data is displayed, set the
preference settings and filters.

Field (*Required) Description

Applications Specify one or more applications for which you want to display the
business processes supported by application health. If no applications are
specified, all applications for which data is available are counted.

Application Set Select an application set to display in the portlet. The portlet displays the
business processes supported by application health. By default, all
applications in the application portfolio are displayed.

Business Processes Specify a business process to display the number of applications that
support it by application health. If you do not specify a business process,
all business processes for which data is available are displayed.

Sort By Select the column used to sort the data.

Ascending/Descending Indicate the sorting sequence.

*Rows Displayed Default: 10

Specify the number of applications displayed in the normal portlet view.

Type any integer greater than zero.

Table B-6. Preference settings and filters for Application to Process Coverage portlet
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Field (*Required) Description

*Rows Displayed in
Maximized View

Default: 50

Specify the number of applications displayed in amaximized portlet.

Type any integer greater than zero.

Available Columns The names of columns that can be displayed in the portlet but are currently
not displayed. See the online portlet help for a description of each column.

Displayed Columns Select the names of the columns to display in the portlet and the order in
which they are displayed.

Additional Columns
Displayed in
Maximized View

Select the names of the columns to display in amaximized portlet and the
order in which they are displayed.

Table B-6. Preference settings and filters for Application to Process Coverage portlet, con-
tinued

Application Value Assessment
The Application Value Assessment portlet displays an application's quality, health, value rating, and
total cost of ownership. This portlet can be displayed as a bubble chart (default) or list. Use the
information in this portlet to determine how or if an application needs to be assessed. For example, an
application that scores low on quality but high on value ratingmight need to be assessed for
improvement opportunities.

Figure B-7. Example of the Application Value Assessment portlet
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To select the type of data that is displayed in this portlet and how the data is displayed, set the
preference settings and filters.

Field Description

Application Select zero, one, or more applications to display the quality, health, value
rating, and total cost of ownership. If no applications are specified, all
applications for which data is available are displayed.

Application Set Select an application set to display in the portlet. The portlet displays the
quality, health, value rating, and total cost of ownership of applications from
the application set. By default, the quality, health, value rating, and total cost
of ownership of all applications for all business owners are displayed.

Contact Select a person who is the primary contact regarding the infrastructure
supporting the application. Only applications that have this person listed as
its contact are displayed.

Business Owner Select a person who has the primary business authority for the application.
Only applications that have this person listed as its business owner are
displayed.

Status Select a status of the applications to display. Only applications that have this
status are displayed.

Health Select zero, one, or more color-coded indicators of the application's health to
display. Only applications that have this health are displayed. If no health is
specified, all applications for which data is available are displayed.

Process Select a business process supported by the application. Only applications
that support this business process are displayed. If no business process is
specified, all applications for which data is available are displayed.

Is Orphan? Select applications that do or do not support a business process.

l No - Select applications that support a business process

l Yes - Select applications that do not support a business process

l Blank - Select all applications

Display preferences
summary on portlet

Display the preferences you have selected at the top of the portlet.

Table B-7. Preference settings and filters for Application Value Assessment portlet

List of Applications (Analyst)
The List of Applications (Analyst) portlet displays a list of all applications in your organization's
portfolio. By default, this portlet displays an application's name, business owner, technical owner,
disposition, disposition status, total score, and status. Use this portlet to view basic information about
an application. Create a customized version of the portlet to track and assess data meaningful to you.
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By default, applications are listed alphabetically by name.

Figure B-8. Example of the List of Applications (Analyst) portlet

To select the type of data that is displayed in this portlet and how the data is displayed, set the
preference settings and filters.

Field (*Required) Description

Application Select zero, one, or more applications to display the quality, health, value
rating, and total cost of ownership. If no applications are specified, all
applications for which data is available are displayed.

Application Set Select an application set to display in the portlet. The portlet displays the
quality, health, value rating, and total cost of ownership of applications
from the application set. By default, the quality, health, value rating, and
total cost of ownership of all applications for all business owners are
displayed.

Contact Select a person who is the primary contact regarding the infrastructure
supporting the application. Only applications that have this person listed as
its contact are displayed.

Business Owner Select a person who has the primary business authority for the application.
Only applications that have this person listed as its business owner are
displayed.

Table B-8. Preference settings and filters for List of Applications (Analyst) portlet
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Field (*Required) Description

Health Select zero, one, or more color-coded indicators of the application's health
to display. Only applications that have this health are displayed. If no
health is specified, all applications for which data is available are
displayed.

Status Select a status of the applications to display. Only applications that have
this status are displayed.

Process Select a business process supported by the application. Only applications
that support this business process are displayed. If no business process is
specified, all applications for which data is available are displayed.

Is Orphan? Select applications that do or do not support a business process.

l No - Select applications that support a business process

l Yes - Select applications that do not support a business process

l Blank - Select all applications

Delegate Select a person who is asked to supply additional information about the
application. Only applications that have this person listed as its delegate
are displayed.

Display preferences
summary on portlet

Display the preferences you have selected at the top of the portlet.

Sort By Select the column used to sort the data.

Ascending/Descending Indicate the sorting sequence.

*Rows Displayed Default: 10

Specify the number of applications displayed in the normal portlet view.

Type any integer greater than zero.

*Rows Displayed in
Maximized View

Default: 50

Specify the number of applications displayed in amaximized portlet.

Type any integer greater than zero.

Available Columns The names of columns that can be displayed in the portlet but are currently
not displayed. See the online portlet help for a description of each column.

Displayed Columns Select the names of the columns to display in the portlet and the order in
which they are displayed.

Table B-8. Preference settings and filters for List of Applications (Analyst) portlet, continued
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Field (*Required) Description

Additional Columns
Displayed in
Maximized View

Select the names of the columns to display in amaximized portlet and the
order in which they are displayed.

Table B-8. Preference settings and filters for List of Applications (Analyst) portlet, continued

My Applications
TheMy Applications portlet displays a list of applications that you created or own. You can create a
customized version of the portlet to track and assess datameaningful to you.

By default, applications are listed alphabetically by name.

Figure B-9. Example of the My Applications portlet

To select the type of data that is displayed in this portlet and how the data is displayed, set the
preference settings and filters.

Field (*Required) Description

Application(s) Select zero, one, or more applications that you own to display. If no
applications are specified, all applications you own are displayed.

Health Select zero, one, or more color-coded indicators of the application's health
to display. Only applications that have this health are displayed. If no
health is specified, all applications for which data is available are
displayed.

Status Select a status of the applications to display. Only applications that have
this status are displayed.

Supported Process Select a business process supported by the application. Only applications
that support this business process are displayed. If no business process is
specified, all applications for which data is available are displayed.

Table B-9. Preference settings and filters for My Applications portlet
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Field (*Required) Description

Is Orphan? Select applications that do or do not support a business process.

l No - Select applications that support a business process

l Yes - Select applications that do not support a business process

l Blank - Select all applications

Display preferences
summary on portlet

Display the preferences you have selected at the top of the portlet.

Sort By Select the column used to sort the data.

Ascending/Descending Indicate the sorting sequence.

*Rows Displayed Default: 5

Specify the number of applications displayed in the normal portlet view.

Type any integer greater than zero.

*Rows Displayed in
Maximized View

Default: 50

Specify the number of applications displayed in amaximized portlet.

Type any integer greater than zero.

Available Columns The names of columns that can be displayed in the portlet but are currently
not displayed. See the online portlet help for a description of each column.

Displayed Columns Select the names of the columns to display in the portlet and the order in
which they are displayed.

Additional Columns
Displayed in
Maximized View

Select the names of the columns to display in amaximized portlet and the
order in which they are displayed.

Table B-9. Preference settings and filters for My Applications portlet, continued

My Survey Requests
TheMy Survey Requests portlet displays all active survey requests created by you and other HP APM
users.

By default, survey requests are listed alphabetically by name.

Figure B-10. Example of the My Survey Requests portlet
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To select the type of data that is displayed in this portlet and how the data is displayed, set the
preference settings and filters.

Field (*Required) Description

Include Closed? Include or do not include surveys that are not active.

l Yes - Include surveys that are not active

l No - Include active surveys only

Sort By Select the column used to sort the data.

Ascending/Descending Indicate the sorting sequence.

*Rows Displayed Default: 5

Specify the number of surveys displayed in the normal portlet view.

Type any integer greater than zero.

*Rows Displayed in
Maximized View

Default: 50

Specify the number of surveys displayed in amaximized portlet.

Type any integer greater than zero.

Available Columns The names of columns that can be displayed in the portlet but are
currently not displayed. See the online portlet help for a description of
each column.

Displayed Columns Select the names of the columns to display in the portlet and the order in
which they are displayed.

Additional Columns
Displayed inMaximized
View

Select the names of the columns to display in amaximized portlet and the
order in which they are displayed.

Table B-10. Preference settings and filters for My Survey Requests portlet

My Transformation Proposals
TheMy Transformation Proposals portlet displays all active and approved transformation proposals
that you created or own. Use this portlet to view transformation proposals that can be developed as
projects.
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By default, transformation proposals are listed alphabetically by name.

Figure B-11. Example of the My Transformations Proposals portlet

To select the type of data that is displayed in this portlet and how the data is displayed, set the
preference settings and filters.

Field (*Required) Description

Include Closed? Include or do not include transformation proposals that are completed.

l Yes - Include transformation proposals that are closed

l No - Do not include transformation proposals that are closed

Sort By Select the column used to sort the data.

Ascending/Descending Indicate the sorting sequence.

*Rows Displayed Default: 5

Specify the number of transformation proposals displayed in the normal
portlet view.

Type any integer greater than zero.

*Rows Displayed in
Maximized View

Default: 50

Specify the number of transformation proposals displayed in amaximized
portlet.

Type any integer greater than zero.

Available Columns The names of columns that can be displayed in the portlet but are
currently not displayed. See the online portlet help for a description of
each column.

Displayed Columns Select the names of the columns to display in the portlet and the order in
which they are displayed.

Additional Columns
Displayed inMaximized
View

Select the names of the columns to display in amaximized portlet and the
order in which they are displayed.

Table B-11. Preference settings and filters for My Transformation Proposals portlet
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My Workstreams
TheMy Workstreams portlet displays a list of all workstreams you created, own, or have reviewed.
Use this portlet to view the workstreams that youmanage.

By default, workstreams are listed numerically (lowest to highest) by ID.

Figure B-12. Example of the My Workstreams portlet

To select the type of data that is displayed in this portlet and how the data is displayed, set the
preference settings and filters.

Field (*Required) Description

Include Closed? Include or do not include workstreams that are completed.

l Yes - Include workstreams that are closed

l No - Do not include workstreams that are closed

Sort By Select the column used to sort the data.

Ascending/Descending Indicate the sorting sequence.

*Rows Displayed Default: 5

Specify the number of workstreams displayed in the normal portlet view.

Type any integer greater than zero.

*Rows Displayed in
Maximized View

Default: 50

Specify the number of workstreams displayed in amaximized portlet.

Type any integer greater than zero.

Available Columns The names of columns that can be displayed in the portlet but are
currently not displayed. See the online portlet help for a description of
each column.

Displayed Columns Select the names of the columns to display in the portlet and the order in
which they are displayed.

Table B-12. Preference settings and filters for My Workstreams portlet
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Field (*Required) Description

Additional Columns
Displayed inMaximized
View

Select the names of the columns to display in amaximized portlet and the
order in which they are displayed.

Table B-12. Preference settings and filters for My Workstreams portlet, continued

Rating of Transformation Proposals
The Rating of Transformation Proposals portlet displays the total score, value rating, and risk rating by
transformation proposal. This portlet can be displayed as a clustered bar chart (default), stacked bar
chart, or list. Use this portlet to view how transformation proposals are ranked based on their total
score.

In the clustered bar chart and stacked bar chart, by default, applications are listed numerically (highest
to lowest) by total score.

Figure B-13. Example of the Rating of Transformation Proposals portlet
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Rating Type Description

Total Score The difference between the Value Rating and Risk Rating with the Score
Adjustment applied.

Total Score = Value Rating – Risk Rating + Score Adjustment

Value Rating The business value of the transformation proposal.

By default, the value rating is the sum of non-empty individual ratings listed
above the Value Rating field Value & Risk Assessment section of the
transformation proposal.

Value Rating = Internal Rate of Return + Strategic Match + Competitive
Advantage + Competitive Response + Productivity

Risk Rating The risk of the transformation proposal to successfully complete. The risk
rating is calculated from values defined in the Value & Risk Assessment
section of the transformation proposal.

By default, the risk rating is the sum of non-empty individual ratings for all risks
in the Value & Risk Assessment section of the transformation proposal.

Risk Rating = Organization Risk + Technical Risk + Architecture Risk +
Definition Risk + Infrastructure Risk

Table B-13. Rating of Transformation Proposals portlet rating types

To select the type of data that is displayed in this portlet and how the data is displayed, set the
preference settings and filters.

Field Description

Transformation
Proposals

Select zero, one, or more transformation proposals to display the total score, value
rating, and risk rating. If no transformation proposals are specified, all
transformation proposals for which data is available are displayed.

Business
Objective

Select a business objective. Only transformation proposals that support this
business objective are displayed. If no business objective is specified, all
transformation proposals for which data is available are displayed.

Owner Select a person who has proposed a transformation proposal. Only transformation
proposals that have been proposed by this person are displayed. If no owner is
specified, all transformation proposals for which data is available are displayed.

Executive
Sponsor

Select a person who is an executive sponsor. Only transformation proposals that
have this person listed as its executive sponsor are displayed. If no executive
sponsor is specified, all transformation proposals for which data is available are
displayed.

Table B-14. Preference settings and filters for Rating of Transformation Proposals portlet
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TCO Summary
The TCOSummary portlet displays the total cost of ownership by application. This portlet can be
displayed as a bar chart (default), pie chart, or list. Use this portlet to determine the total cost to own
and operate an application.

In the bar chart and pie chart, by default, applications are listed numerically (highest to lowest) by cost.
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Figure B-14. Example of the TCO Summary portlet
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To select the type of data that is displayed in this portlet and how the data is displayed, set the
preference settings and filters.

Field Description

Application Set Select an application set to display in the portlet. The portlet displays the
cost of ownership by applications in the application set. By default, the cost
of ownership of all applications are displayed.

Display preferences
summary on portlet

Display the preferences you have selected at the top of the portlet.

Table B-15. Preference settings and filters for TCO Summary portlet
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Appendix C: Reports

Reports Overview
HP Application Portfolio Management (HP APM) provides several predefined reports that allow you to
view the current status of your application portfolio data in aWeb browser:

l "Entity Coverage Summary Report" below. Shows a summary of attributes and completeness of
data entry for an entity.

l "Entity Detail Report" on the next page. Shows selected information about one or more entities.
Use the filters to display only the entities and fields you want to view in the report. By default, the
report includes non-empty header and detail information, notes, status, and references for each
entity.

l "Survey Results Report" on page 191. Shows survey results from survey requests.

This appendix provides descriptions of the fields in each of the HP APM reports.

Note: View the HP APM reports from theOpen > Application Portfolio > Reports menu.

For instructions for running andmanaging reports, see theReports Guide and Reference.

Entity Coverage Summary Report
The Entity Coverage Summary report provides a summary of attributes and completeness of data entry
provided for an entity.

Report Parameters
Use the filter fields in the Report Parameters section to define the results of your report. You can
choose to display a report for a selected entity type or for an application set. The threshold filters color-
code how often a field is completed by the data coverage percentage (for example, for applications, the
Version field may be completed 80% of the time). Use the color coding to visually distinguish the
acceptable, borderline, and unacceptable completeness of data coverage.

HP Project and Portfolio Management Center (9.30) Page 187 of 194



Filter Field (*Required) Description

*Entity Type Select the type of entity for which to generate a report. If you want to limit
the report to applications in a specific application set, select Application
and enter the name of the application set in theApplication Set field.

Application Set Enter the name of the application set for which to generate a report. This
field is available only when you select Application as the Entity Type.

*High Threshold Default: 80%. Denotes the fields that have themost complete data
coverage. That is, the percentage of data entered for this field is at or
above the threshold. In addition to displaying the percentage completed,
the cell is color-coded in green.

*Medium Threshold Default: 50%. Denotes the fields that have fairly complete data
coverage. That is, the percentage of data entered for this field is at or
above the threshold but below the high threshold. In addition to displaying
the percentage completed, the cell is color-coded in yellow.

*Low Threshold Default: 0%. Denotes the fields that have the least complete data
coverage. That is, the percentage of data entered for this field is at or
above the threshold but below themedium threshold. In addition to
displaying the percentage completed, the cell is color-coded in red.

Table C-1. Entity Coverage Summary report filter fields

Analyzing the Entity Coverage Summary Report
The Entity Coverage Summary report provides a snapshot of the completeness of information provided
for an entity. It shows the fields in the selected entity type, the number of times the fields were
completed (Count), the percentage of times the field was filled in, and, when field data is measurable,
the lowest value, highest value, and the average value for the field.

Use the Entity Coverage Summary report to:

l Determine if enough data is provided for the entity. At the bottom of the report, the grand total
summarizes the total number of fields and the percentage of fields that were filled in.

l Determine the information that is providedmost often for the entity. Where information is lacking,
you could send an email to the entity owner asking the owner to providemore data.

l Determine threshold values for fields where statistical information is available.

Entity Detail Report
The Entity Detail report provides selected information about one or more entities. Use the filters to
display only the entities and fields you want to view in the report. By default, the report includes non-
empty header and detail information, notes, status, and references for each entity.
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Report Parameters
Use the filter fields in the Report Parameters section to define the results of your report.

Filter Field (*Required) Description

*Entity Request Type Select the type of entity for which you want to run the report. The entity
type determines the selectable values in certain filter fields.

*Include Closed Requests Select Yes to include entities whose status is Closed. Select No to
exclude entities whose status is Closed. Only survey and workstream
entities can have the status of Closed.

Entity Numbers Select zero, one, or more entity numbers for which you want to create a
report. All entities with the selected number(s) are included in the report.
Leave this field blank if you want to display all entities of the selected
type.

Status Select zero, one, or more statuses for which you want to create a
report. All entities of the selected status(es) are included in the report.
Leave this field blank if you do not want to filter by status. Status
selections are determined by the entity type you selected in the Entity
Request Type field.

Owner Select zero, one, or more owners for which you want to create a report.
All entities owned by the named persons are included in the report.
Leave this field blank if you do not want to filter by entity owner.

Created By Select zero, one, or more creators for which you want to create a report.
All entities created by the named persons are included in the report.
Leave this field blank if you do not want to filter by an entity's creator.

Creation Date From Select a date after which the creation of the entity falls. All entities
created after the selected date are included in the report. Leave this
field blank if you do not want to filter by creation date.

Creation Date To Select a date before which the creation of the entity falls. All entities
created before the selected date are included in the report. Leave this
field blank if you do not want to filter by creation date.

Last Update Date From Select a date after which the last modification of the entity falls. All
entities modified after the selected date are included in the report.
Leave this field blank if you do not want to filter by modification date.

Last Update Date To Select a date before which the last modification of the entity falls. All
entities modified before the selected date are included in the report.
Leave this field blank if you do not want to filter by modification date.

Table C-2. Entity Detail report filter fields

HP Application Portfolio Management Analyst’s Guide
Appendix C: Reports

HP Project and Portfolio Management Center (9.30) Page 189 of 194



Filter Field (*Required) Description

Description Contains Enter alphanumeric words or phrases that are part of the entity's
description. All entities that include the word or phrase in the description
are included in the report. Leave this field blank if you do not want to
filter by description.

Field Prompt 1–4 Select an attribute of the entity type on which to filter. The value of the
attribute is determined by the Field Value field. Leave this field blank if
you do not want to filter by a specific entity attribute. Field attribute
selections are determined by the entity type you selected in the Entity
Request Type field. Up to four field prompts may be specified.

Field Value 1–4 Enter a value for the attribute of the entity type on which to filter. The
attribute is determined by the Field Prompt field. Leave this field blank if
you do not want to filter by a specific entity attribute.

Report Title Enter a name for this report.

*Order By Order of the results within the report. Results are ordered by request
number (entity number). This field cannot bemodified.

*Show Header Fields Select Yes to include all information in an entity's header section in the
report. Select No to exclude information from an entity's header section
from the report.

*Show Detail Fields Select Yes to include all information from an entity's details section in
the report. Select No to exclude information from an entity's details
section from the report.

*Hide Prompts for Empty
Fields

Select Yes to exclude attribute fields with no values from the report.
Select No to include attribute fields with no values in the report.

*Show Contents of Table
Fields

Select Yes to include all information from an entity's table fields in the
report. Select No to exclude information from an entity's table fields
from the report.

*Show Field Audit History Select Yes to include all information from an entity's audit history in the
report. Select No to exclude information from an entity's audit history
from the report.

*Show Notes Select Yes to include all information from an entity's Notes section in
the report. Select No to exclude information from an entity's Notes
section from the report.

Table C-2. Entity Detail report filter fields, continued
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Filter Field (*Required) Description

*Filter Notes Select the types of notes to include in the report, if notes are included in
the report.

l Show all notes - Include all notes entered by administrators,
analysts, and users.

l Show only user notes - Include notes only entered by users.

*Show Status Select Yes to include all information from an entity's Status section in
the report. Select No to exclude information from an entity's Status
section from the report.

*Show References Select Yes to include all information from an entity's References
section in the report. Select No to exclude information from an entity's
Reference section from the report.

Table C-2. Entity Detail report filter fields, continued

Analyzing the Entity Detail Report
The Entity Detail report provides a snapshot of selected information for the selected entity type. It
shows selected sections of information and selected fields (up to four) for a filtered set of the selected
entity type.

Use the Entity Detail report to:

l Track information between the same type of entities. For example, you could create a report for an
application set that displays the owners of each application.

l Compare information between entities of the same type.

l Create a list of entities with similar attributes.

l Keep a log of selected information.

Survey Results Report
The Survey Results report shows the results from a specified survey request.

Report Parameters
Use the filter fields in the Report Parameters section to define the results of the report. The threshold
filters color-code the number of responses by the response rate percentage. Use the color coding to
visually distinguish the number of acceptable, borderline, and unacceptable responses.
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Filter Field (*Required) Description

*Survey Request Select the survey for which to generate the report.

Applications Select one or more applications that are part of the selected survey on
which to report. If you want to view a report for all applications in the
survey, leave this field blank.

High Threshold Default: 80%. Denotes the fields that have themost complete data
coverage. That is, the percentage of data entered for this field is at or
above the threshold. In addition to displaying the percentage completed,
the cell is color-coded in green.

Medium Threshold Default: 50%. Denotes the fields that have fairly complete data
coverage. That is, the percentage of data entered for this field is at or
above the threshold but below the high threshold. In addition to
displaying the percentage completed, the cell is color-coded in yellow.

Low Threshold Default: 0%. Denotes the fields that have the least complete data
coverage. That is, the percentage of data entered for this field is at or
above the threshold but below themedium threshold. In addition to
displaying the percentage completed, the cell is color-coded in red.

Show Blanks in
Distribution?

Distribution shows the number of responses in a given rating category. If
Yes is selected, the distribution includes the number of non-responses.
If No is selected, only the distribution of actual responses is shown.

Table C-3. Survey Results report filter fields

Analyzing the Survey Results Report
When you send out a survey, you ask the respondents to rate specific areas of one or more
applications. The Survey Results report is a snapshot of the current responses to the survey.

The Survey Results report shows the areas that were rated, the number of responses for the areas, the
percentage of responses for the areas, and the distribution of the responses among the ratings. If you
selected Yes for theShow Blanks in Distribution? field, the number of non-responses are included
in the distribution.

Use the Survey Results report to:

l Determine the overall response rate to the survey. At the bottom of the report is a summary of the
total number of responses and percentage of completed responses. If you have enough responses,
youmay choose to close the survey.

l Determine if you are satisfied with the number of responses you have received for any given area by
looking at the number of responses, number of non-responses, and the response rate percentage. If
the number of responses is low for a specific area, youmay choose to send an email to the
respondents asking them for more information in the specific area.

l Analyze the current ratings for a given area. You can see what areas of the application your
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respondents liked or disliked themost. You can determine the strengths and weaknesses of the
application based on the responses.
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Send Documentation Feedback
If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:

Feedback on HP Application Portfolio Management Analyst’s Guide (Project and Portfolio
Management Center 9.30)

Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a webmail client, and
send your feedback to HPSW-BTO-PPM-SHIE@hp.com.

We appreciate your feedback!
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